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PanelView Plus 7 Performance Terminals User Manual

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before 
you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to 
requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably 
trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this 
equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with 
any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

These labels may also be on or inside the equipment to provide specific precautions.

The following icon may appear in the text of this document.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

Identifies information that is useful and can help to make a process easier to do or easier to understand.
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Preface

About This Publication This manual describes how to install, configure, operate, and troubleshoot the PanelView™ 
Plus 7 Performance terminals. It does not provide procedures on how to create applications 
that run on the terminals or ladder logic that runs in the controller.

Other tasks that you must do include:
• Create a human machine interface (HMI) application for the terminal by using 

FactoryTalk® View Machine Edition (ME) software, version 8.x or later.
• Create ladder logic for the controller by using the Studio 5000 Logix Designer® 

application.

Download Firmware, AOP, 
EDS, and Other Files 

Download firmware, associated files (such as AOP, EDS, and DTM), and access product release 
notes from the Product Compatibility and Download Center at rok.auto/pcdc.

Summary of Changes This publication contains the following new or updated information. This list includes 
substantive updates only and is not intended to reflect all changes.

Package Contents This publication is shipped with these items:
• PanelView Plus 7 Performance terminal

- Series A (and Stainless Steel Series A and B): With FactoryTalk View ME Station 
runtime software installed and activated

- Series B (and Stainless Steel Series C): With factory default firmware (must be 
updated with FactoryTalk View ME Station runtime software prior to deploying to 
production network)

• Removable power terminal block
• Product information
• Cutout template
• Quick start guide (Series B only)
• Mounting levers for panel installation (for aluminum terminals)
• Mounting clamps for panel installation (for stainless-steel terminals)
• Backing plate (for stainless-steel terminals)
• Hygienic gasket, blue (for stainless-steel terminals)

For information on what is shipped with the ArmorView Plus 7 terminal, see the ArmorView 
Plus 7 Installation Instructions, publication 2711P-IN013.

IMPORTANT This document does not provide instructions on how to install and 
configure components of the ArmorView™ Plus 7 product. For 
instructions on how to do that, see the ArmorView Plus 7 Installation 
Instructions, publication 2711P-IN013.

Topic Page
Summarized catalog numbers on the front cover. -
Added the 10-in. and 15-in. Stainless Steel catalog numbers to a new Catalog Number table. 10
Updated the bulleted list of terminal features. 11
Updated the Product Selection table. 17
Updated the Hygienic Gasket Replacement Kits for Stainless Steel Terminals table. 19
Added information about enabling server access on the Services Screen. 151
Added the Remote Client Access (VNC) section. 152
Added the 10-in. and 15-in. terminals to the torque sequence diagrams. 168
Added information about where to Download Firmware Files (Series A Terminals Only). 170
Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024 9

https://rok.auto/pcdc
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf


Preface          
Catalog Numbers This publication is applicable to these currently available PanelView Plus 7 Performance 
terminals.

This publication is also applicable to these discontinued PanelView Plus 7 Performance 
terminals.

Additional Resources These documents contain additional information concerning related products from Rockwell 
Automation. You can view or download publications at rok.auto/literature.

PanelView Plus 7 Performance 2711P-T7C22D9P, 2711P-B7C22D9P, 2711P-T9W22D9P, 2711P-T10C22D9P, 2711P-B10C22D9P, 2711P-T12W22D9P, 
2711P-T15C22D9P, 2711P-B15C22D9P, 2711P-T19C22D9P

PanelView Plus 7 Performance Conformal Coated 2711P-T7C22D9PK, 2711P-T9W22D9PK, 2711P-T10C22D9PK, 2711P-T12W22D9PK, 2711P-T15C22D9PK, 2711P-T19C22D9PK, 
2711P-B15C22D9PK

PanelView Plus 7 Performance Brandless 2711P-T7C22D9P-B, 2711P-B7C22D9P-B, 2711P-T9W22D9P-B, 2711P-T10C22D9P-B, 2711P-B10C22D9P-B, 
2711P-T12W22D9P-B, 2711P-T15C22D9P-B, 2711P-B15C22D9P-B, 2711P-T19C22D9P-B

PanelView Plus 7 Performance Stainless Steel 2711P-T9W22D9P-BSHK, 2711P-T10C22D9P-BSHK, 2711P-T12W22D9P-BSHK, 2711P-T15C22D9P-BSHK

ArmorView Plus 7 
2711P-T12W22D9P-BM001, 2711P-T12W22D9P-BM002, 2711P-T12W22D9P-BM003, 2711P-T12W22D9P-BM004, 
2711P-T12W22D9P-BM005, 2711P-T12W22D9P-BM006, 2711P-T12W22D9P-BM007, 2711P-T12W22D9P-BM008, 
2711P-T12W22D9P-BM009, 2711P-T12W22D9P-BM010, 2711P-T12W22D9P-BM011, 2711P-T12W22D9P-BM012, 
2711P-T12W22D9P-BM013, 2711P-T12W22D9P-BM014, 2711P-T12W22D9P-BM015, 2711P-T12W22D9P-BM016

PanelView Plus 7 Performance 2711P-T7C22A9P, 2711P B7C22A9P, 2711P-T9W22A9P, 2711P-T10C22A9P, 2711P-B10C22A9P, 2711P-T12W22A9P, 
2711P-T15C22A9P, 2711P-B15C22A9P, 2711P-T19C22A9P

PanelView Plus 7 Performance Brandless 2711P-T7C22A9P-B, 2711P-B7C22A9P-B, 2711P-T9W22A9P-B, 2711P-T10C22A9P-B, 2711P-B10C22A9P-B, 
2711P-T12W22A9P-B, 2711P-T15C22A9P-B, 2711P-B15C22A9P-B, 2711P-T19C22A9P-B

Resource Description

PanelView Plus 7 Performance Specifications, publication 2711P-TD009 
Provides technical specifications, environmental specifications, and 
certifications for the performance models of the PanelView Plus 7 Performance 
terminals.

PanelView Plus 7 Performance Series B Terminals Quick Start, publication 2711P-QS002
Provides instructions on how to configure and install the PanelView Plus 7 
Performance Series B terminals. Also describes how to update the firmware for 
these terminals.

PanelView Plus 7 Performance Series B Terminals
Important Information, publication 2711P-RN005

Lists the functions of the PanelView Plus 7 Performance Series A terminals that 
are not included in the initial version of the PanelView Plus 7 Performance Series 
B terminals. Also indicates which of these functions will be available in a future 
release.

2711P PanelView Plus 7 Performance 12.101 Release Notes, publication 2711P-RN006 Describes the new features, feature enhancements, and anomalies fixed in 
firmware release 12.101 for the PanelView Plus 7 Performance Series B terminals.

EtherNet/IP Device Level Ring Application Technique, publication ENET-AT007
Provides information on how to install, configure, and maintain linear and Device 
Level Ring (DLR) networks using Rockwell Automation® EtherNet/IP™ devices 
with embedded switch technology.

ArmorView Plus 7 Installation Instructions, publication 2711P-IN013 Provides instructions on how to install, configure, troubleshoot, and maintain the 
ArmorView Plus 7 terminal.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 Provides general guidelines for installing a Rockwell Automation industrial 
system.

Guidelines for Handling Lithium Batteries Technical Data, publication AG-5.4 Provides guidelines for how to store handle, install, and dispose of lithium 
batteries.

Product Certifications website: rok.auto/certifications Provides declarations of conformity, certificates, and other certification details.
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Chapter 1

Overview
About the PanelView Plus 7 
Performance Terminals

The PanelView™ Plus 7 Performance terminals are operator interface devices. They monitor 
and control devices that are attached to ControlLogix® and CompactLogix™ controllers on an 
EtherNet/IP™ network. Animated graphic and text displays provide operators a view into the 
operating state of a machine or process. Operators interact with the control system by using 
touch screen or keypad input.

Features include the following:
• FactoryTalk® View Machine Edition software provides a familiar environment for 

creating HMI applications.
• Microsoft Windows® operating system:

- Series A (and Stainless Steel Series A and B): Windows® CE 6.0
- Series B (and Stainless Steel Series C): Windows 10 IoT Core

• Ethernet communication that can support Device Level Ring (DLR), linear, or star 
network topologies.

• Web browser, PDF viewer, remote connection capabilities.
• Conformal coating available for all DC power, touch-only terminals and the 15-inch DC 

power, touch and keypad terminal.
• Stainless-steel, hygienic, brandless, DC-power, and conformal coating are available for 

the touch-only units in the 9-in. wide-screen, 10-in., 12-in. wide-screen, and 15-in. 
terminal sizes

• On-machine mounting available for the 12-in. terminal. For information on the options 
available, see the ArmorView™ Plus 7 Installation Instructions, publication 2711P-IN013.
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Chapter 1          Overview
Hardware Features The PanelView Plus 7 Performance terminals feature fixed hardware configurations with a 
range of display sizes and operator input options.
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Stainless Steel terminals use mounting clips and a backing 
ring. All other hardware features are the same as the 
aluminum terminals.

8

Table 1 - Hardware Features(1) 

Item Feature Description

1 Display/Keypad

TFT color graphic displays with a touch screen and navigation button in a range of sizes. Some models also have a 
keypad and function keys providing additional operator input options:
• 6.5-in. touch, or touch with keypad 
• 9-in. widescreen touch 
• 10.4-in. touch, or touch with keypad 
• 12.1-in. widescreen touch
• 15-in. touch, or touch with keypad
• 19-in. touch

2 Power
AC or DC(2) power input:
• 18…30V DC (isolated), aluminum and stainless-steel terminals
• 100…240V AC (nom), only aluminum terminals (Series A terminals only)

3
Mounting slot (aluminum terminals) Slots on top, bottom, and sides of the terminal are for mounting levers to mount the device to a panel or enclosure. The 

number of slots varies by terminal size.

Mounting slot (stainless-steel terminals) Slots on top, bottom, and sides of the terminal are for mounting clips to mount the device to a panel or enclosure by 
using a backing ring. The number of slots varies by terminal size.

4 Ethernet ports Two 10/100Base-T, Auto MDI/MDIX, Ethernet ports for controller communication supporting Device Level Ring (DLR) 
network topology.

5 USB host ports Series A (and Stainless Steel Series A and B): Two 2.0 USB ports
Series B (and Stainless Steel Series C): One 2.0 USB port and one 3.0 USB port

6 USB device port IMPORTANT: The device port is not functional. Do not use this port.

7 Audio out(3) One audio out port supports connection to a 4 Ω or 8 Ω speaker or amplifier (not initially supported on Series B (Series C 
for Stainless Steel terminals), however USB audio is supported).

8 Maintenance Mode button 
Only available on Series B terminals (Series C for Stainless Steel terminals), this button allows you to enter maintenance 
menu mode, which is used to restore factory defaults, backup and restore terminal settings, and calibrate the touch 
screen, and so on.

9 Status indicators Light-emitting diodes on the back of the terminals provide status and fault conditions.
10 Secure Digital (SD) card slot One SD card slot supports catalog number 1784-SDx and 1784-SDHCx, hot-swappable, SD card for external storage.

(1) For information about the hardware features of the ArmorView Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.
(2) Series A terminals are available with AC or DC power. Series B terminals (Series C for Stainless Steel terminals) are available only with DC power.
(3) Series A: The speaker works in the Windows CE operating system (Windows Media Player). FactoryTalk View ME Station software does not support the speaker. Series B (Series C for 

Stainless Steel terminals): The USB audio works in the Windows 10 IoT operating system through the Edge web browser.
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Chapter 1          Overview
Operator Control All terminals have a color display with a touch screen, or touch screen and keypad, for 
operator control.

• Analog resistive touch screens provide accurate and durable touch control for 
industrial applications.

• Keypad models are similar except for the number of function keys to the left and right 
of the display. Larger models have more keys.

Touch Gestures

The touch screen supports touch gestures to interact with screen elements during runtime. 
Standard touch gestures include:

• Tap – Briefly touch the target on the screen with your fingertip.
• Double-tap – Touch the target on the screen twice quickly with your fingertip.
• Drag – Touch the target and move your fingertip across the screen without losing 

contact. 
• Long press – Touch and hold the target on the screen for several seconds. 

ATTENTION: The keypad and touch screen accept input from a finger, stylus, 
and gloved-hand for operation in dry or wet environments. The plastic stylus 
must have a minimum tip radius of 1.3 mm (0.051 in.). Any other object or tool 
can damage the keypad or touch screen.

ATTENTION: To help prevent unintended operation, do not conduct multiple 
operations simultaneously.
• Touch one operating element on the touch screen with one finger at a time.
• Press only one key on the terminal at one time.

F1

Esc

7 98

4 5 6

1 2 3

0 .–

F2

F3

F6

F4

F5

F9

F7

F8

F10

F12

F11

F14

F13

F16

F15

1

2

33

Table 2 - Terminal Keypad

Item Feature Description

1 Numeric keypad

Contains numeric, decimal, minus, and the following keys:
• Backspace - deletes the character to the left of the insertion point.
• Enter - inputs the currently highlighted key or enters a blank line if the insertion point is in the text box of the virtual keyboard.
• Tab-left, Tab-right - selects the previous or next control or input element.
• Esc - cancels or dismisses a dialog.

2 Navigation keys

Provides navigation control.
• Arrow keys - selects a key on the virtual keyboard that is above, below, left, or right of the selected key. Moves the cursor in the selected 

direction if in the text box.
• Home/End - moves the insertion point to the beginning or end of a text or numeric entry field.
• Page up/Page down - goes to the next or previous pages of a list.

3

Function keys

6.5-in. terminal
10-in. terminal
15-in. terminal

Performs specific commands if events are configured for a screen or any of its graphic elements. For example, F1 can be configured to 
navigate to another screen.
• F1…F6 and F7…F12 
• F1…F8 and F9…F16
• F1…F10 and F11…F20
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Software Support

Windows Operating System Series A terminals run the Windows CE 6.0 operating system, and Series B (Stainless Steel 
Series C) terminals run the Windows 10 IoT Core operating system. These terminals both run 
the same FactoryTalk View Machine Edition applications.

IMPORTANT It is the responsibility of the customer to be sure that any third-party 
software, updates, patches, or firmware that is installed is free of 
malicious programs, spyware, and so on.

Table 3 - PanelView Plus 7 Performance Software Support

Software Description Version

FactoryTalk View Machine Edition (ME) Station

Runtime environment of terminal:
• Runs FactoryTalk View ME applications.
• Provides options to view and configure terminal 

settings.
Machine Edition Station is pre-loaded on each 
terminal and does not require activation.

8.x or later

FactoryTalk View Studio for Machine Edition
Software for developing HMI applications that run on 
a terminal. RSLinx® software is included with 
FactoryTalk View Studio software and loaded during 
installation. 

8.x or later

FactoryTalk ViewPoint

A web server application that lets remote users 
access and control the HMI application running on a 
terminal by using an internet browser. 
One license is embedded with each terminal to 
support one client connection to a terminal. 

8.x or later

Table 4 - Features 

Standard Features Series A Series B(1)

(1) Series C for Stainless Steel terminals.

FTP server – Yes –
Secure FTP server – No Yes

VNC client and server – Yes VNC Server

ActiveX controls (2) (3)

(2) For a complete list of ActiveX controls, go to https://rockwellautomation.custhelp.com and search the Knowledgebase for the 
keywords ‘ActiveX Support for PanelView Plus Terminals’. 

(3) See View FactoryTalk View ME Station Information on page 94 to view a list of ActiveX controls installed on the terminal.

– Yes FT View ME ActiveX 
controls

Third-party controller support – Yes Yes

PDF reader FoxIt FoxIt and Microsoft® Edge

Web browser Internet Explorer 6 Microsoft Edge

Remote desktop client Yes No

Media player Windows Media 
Player 9 Microsoft Edge

Microsoft Office file viewers
PowerPoint

Excel®
Word

Image viewer

Yes No

WordPad text editor Yes No
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Chapter 1          Overview
Open Versus Closed System Series A Terminals (and Stainless Steel Series A and B Terminals)

On Series A terminals, you can configure a terminal to run an open or closed desktop 
environment:

• An open system launches the Windows CE desktop on startup.
• A closed system launches a FactoryTalk View Machine Edition application or 

FactoryTalk View Machine Edition Station on startup. Desktop access is restricted. 

Series A terminals are shipped as closed systems with desktop access disabled. The first time 
that you start the system, the terminal launches FactoryTalk View ME Station Configuration 
mode. At this point, you can change the startup option and allow desktop access.

Series B Terminals(1)

Series B terminals are shipped as closed systems and there is no desktop available on the 
Windows 10 IoT Core operating system.

Desktop Access Series A Terminals (and Stainless Steel Series A and B Terminals)

On Series A terminals, you can allow or restrict access to the Windows desktop on the terminal. 
From the desktop, you can perform system and control panel operations, use Microsoft® file 
viewers, run third-party applications, and launch the web browser. You can also provide 
temporary access to perform specific tasks, then disable desktop access to help prevent 
unauthorized changes.

See Windows CE Desktop Access — Series A Terminals on page 66 for details on how to modify 
desktop access.

Series B Terminals(1)

Series B terminals do not have a desktop. When you exit Machine Edition, a Windows 10 Control 
Panel launches.

Startup Options The terminal can perform one of three actions at startup:
• Launch a FactoryTalk View Machine Edition HMI application.
• Launch FactoryTalk View Machine Edition Station in Configuration mode. In this mode, 

configure terminal settings and startup options, load applications to run, and so on.
• Launch the Windows desktop (available on Series A terminals only).

The factory default state and startup option following a firmware update is to launch the 
terminal in Configuration mode. See Configure Startup Options on page 70 for details on how 
to change the startup option.

For a list of actions you can perform using touch gestures, see the FactoryTalk View Machine 
Edition help.

(1) Series C for Stainless Steel terminals.

All terminals are initially shipped with desktop access disabled. 
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Chapter 1          Overview
EtherNet/IP Communication The PanelView Plus 7 Performance terminals use an EtherNet/IP embedded switch. These 
terminals communicate with ControlLogix and CompactLogix controllers over an Ethernet 
connection with DLR, linear, or star network topologies.

The terminals can reside on EtherNet/IP networks that run integrated motion and CIP Sync™ 
applications without affecting performance. The terminal is not a consumer or producer of 
CIP Sync or motion packets. 

Typical Configuration Traditional DLR, linear, and star network topologies are supported. See these topics for 
examples:

• Device Level Ring Network Topology on page 40
• Linear Network Topology on page 41
• Star Network Topology on page 42

Catalog Number 
Explanation

This table provides an explanation of the catalog numbers.

Bulletin Input Type Display Size Display Type Network Power Operating System Model - Option 

| | | | | | | | |

2711P- T = Touch 7 = 6.5-in. C = Color 22 = Ethernet DLR ports
A = AC 
(Series 
A only)

9 = Windows CE 6.0 
(Series A and Series B for 

Stainless Steel))
or

9 = Windows 10 IoT Core 
(Series B and Series C for 
Stainless Steel Terminals)

P = 
Performance - B = No brand identity

B = Key and 
Touch 9 = 9-in.

W = Wide 
aspect ratio 

color
D = DC -

BSHK(1)= No brand 
identity, stainless-

steel, hygienic, 
conformal coated

10 = 10.4-in. K = Conformal coated

12 = 12.1-in.
BM001– BM016(2) = 
ArmorView Plus 7 

terminal

15 = 15-in.

19 = 19-in.
(1) The -BSHK terminals are available in 9-in., 10-in., 12.1-in., and 15-in. touch screen terminals, with DC power, and without the Allen-Bradley logo.
(2) The ArmorView Plus 7 product includes a 12.1-in. PanelView Plus 7 Performance terminal and a 1732E ArmorBlock® EtherNet/IP I/O module. Both products are enclosed in a cast aluminum 

assembly that can be mounted on a machine, an arm mount system, a VESA-compatible bracket (with the optional VESA kit), or a pedestal. To order an ArmorView Plus 7 terminal, add 
BM001…BM016 to the 12.1-in. PanelView Plus 7 Performance touch terminal, 2711P-T12W22D9P. For explanations of the ArmorView Plus 7 catalog numbers, see the ArmorView Plus 7 
Installation Instructions, publication 2711P-IN013.
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Product Selections This table provides a description of the product selections by catalog number.

Table 5 - PanelView Plus 7 Performance Terminal Product Selections 

Cat. No.(1) Display Ethernet  Power Memory

Touch Key and Touch  Size Type DLR AC or DC RAM User(2)

2711P-T7C22D9P 2711P-B7C22D9P

6.5-in. VGA 
TFT Color 

Yes

DC

Series A 
(and Stainless Steel Series A and B)

512 MB

Series B(3)

4 GB 

Series A 
(and Stainless Steel Series A and B)

80 MB

Series B(3)

2 GB

2711P-T7C22D9PK(4) –

2711P-T7C22A9P 2711P-B7C22A9P AC(5)

2711P-T9W22D9P

– 9-in. 
(wide)

WVGA 
TFT Color 

DC2711P-T9W22D9PK(4)

2711P-T9W22D9P-BSHK
2711P-T9W22A9P AC(5)

2711P-T10C22D9P 2711P-B10C22D9P

10.4-in. SVGA 
TFT Color 

DC2711P-T10C22D9PK(4) –
2711P-T10C22D9P-BSHK

2711P-T10C22A9P 2711P-B10C22A9P AC(5)

2711P-T12W22D9P(6)

– 12.1-in. 
(wide)

WXGA 
TFT Color 

DC2711P-T12W22D9PK(4)

2711P-T12W22D9P-BSHK
2711P-T12W22A9P AC(5)

2711P-T15C22D9P 2711P-B15C22D9P

15-in.  XGA 
TFT Color

DC2711P-T15C22D9PK(4) 2711P-B15C22D9PK(4)

2711P-T15C22D9P-BSHK
2711P-T15C22A9P 2711P-B15C22A9P AC(5)

2711P-T19C22D9P

– 19-in.  SXGA 
TFT Color

DC
2711P-T19C22D9PK(4)

2711P-T19C22A9P AC(5)

(1) Add -B to the end of a catalog number ending in P to order a terminal without the Allen-Bradley logo and product identification, for example, 2711P-T9W22D9P-B.
(2) Memory available for user to store applications.
(3) Series C for Stainless Steel terminals.
(4) This terminal includes conformal coating.
(5) AC power is only available on Series A terminals.
(6) To order an ArmorView Plus 7 terminal, add BM001…BM016 to the 12.1-in. PanelView Plus 7 Performance touch terminal, 2711P-T12W22D9P. For explanations of the ArmorView Plus 7 catalog 

numbers, see the ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.
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Chapter 1          Overview
Accessories These tables list accessories for the PanelView Plus 7 Performance terminals.

For a list of accessories that are available for the ArmorView Plus 7 terminal, see the 
Visualization Solutions Selection Guide, publication VIEW-SG001.

Table 6 - Protective Overlays 

Cat. No.(1)

(1) The use of protective overlays may not be compatible in all hygienic applications. Consult the standards and protocols for 
your hygienic applications before you use a protective overlay on a stainless-steel terminal.

Display Size
Operator Input

Quantity
Touch Key and Touch

2711P-RGT7SP
6.5-in.

•

3

2711P-RGB7P •
2711P-RGT9SP 9-in. (wide) •
2711P-RGT10SP

10.4-in.
•

2711P-RGB10P •
2711P-RGT12SP 12.1-in. (wide) •
2711P-RGT15SP

15-in.
•

2711P-RGB15P •
2711P-RGT19P 19-in. •

Table 7 - Power Supplies and Power Terminal Blocks

Cat. No. Description Quantity
1606-XLP95E DIN rail power supply, 24…28V DC output voltage, 95 W 1
1606-XLP100E DIN rail power supply, 24…28V DC output voltage, 100 W 1
2711P-RSACDIN DIN rail power supply, AC-to-DC, 85…265V AC, 47…63 Hz 1

2711P-RTBAP 3-pin AC power terminal block (gray with black labels for L1, L2N, and 10

2711P-RTBDSP 3-pin DC power terminal block (black with white labels for +, –, and GND) 10

Table 8 - Mounting Hardware

Cat. No. Description Quantity

2711P-RMCP(1)

(1) Catalog number 2711P-RMCP mounting levers are used with PanelView Plus 7 Performance terminals. Do not use gray 
mounting levers; they are not compatible with PanelView Plus 7 Performance terminals. 

Mounting levers (black) 16

2711P-RTMC(2)

(2) Catalog number 2711P-RTMC mounting clips are used for stainless-steel terminals, catalog numbers 2711P-T9W22D9P-BSHK, 
2711P-T10C22D9P-BSHK, 2711P-T12W22D9P-BSHK, or 2711P-T15C22D9P-BSHK. If you need more than eight clips, order two 
2711P-RTMC mounting clip kits.

Mounting clips 8

Table 9 - Secure Digital (SD) Cards(1)

(1) To help reduce the chance of corruption when you use SD Cards or USB drives with the terminal, Rockwell Automation 
recommends that you use only the above SD card catalog numbers.

Cat. No. Description Quantity
1784-SD1 1 GB SD card 1
1784-SD2 2 GB SD card 1

1784-SDHC8 8 GB High Capacity SD card 1
1784-SDHC32 32 GB High Capacity SD card 1
2711C-RCSD USB to SD adapter for SD card 1

Table 10 - Battery Replacement

Cat. No. Description Quantity
2711P-RY2032 Lithium coin-cell battery, CR2032 equivalent 1
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Ethernet Cables See the Industrial Ethernet Media Brochure, publication 1585-BR001, for recommended 
Ethernet cables and media solutions.

See the USB to Serial Adapter Quick Start Guide, publication GMSC10-QS003, for information on 
USB to serial port adapters.

IMPORTANT Before you select the appropriate replacement gasket, you must 
identify the series of the PanelView Plus 7 Performance Stainless Steel 
terminal. The terminal’s series information is on the terminal’s product 
nameplate label. In the following table, gaskets that are listed for use on 
Series B or C terminals are not certified for use on Series A terminals, 
and gaskets that are listed for use on Series A terminals are not 
certified for use on Series B or C terminals.

Table 11 - Hygienic Gasket Replacement Kits for Stainless Steel Terminals

Cat. No. Description (1)

(1) Gasket material is compliant with FDA 21 CFR 177.2600.

Terminal Series Quantity

2711P-RGST9W Hygienic gasket, blue silicone
For 9-in. Series A Stainless Steel terminals A 1

2711P-RGST12W Hygienic gasket, blue silicone
For 12-in. Series A Stainless Steel terminals A 1

2711P-RGST9WB Hygienic gasket, blue, silicone, with ribs
For 9-in. Series B or C Stainless Steel terminals B or C 1

2711P-RGST12WB Hygienic gasket, blue, silicone, with ribs
For 12-in. Series B or C Stainless Steel terminals B or C 1

2711P-RGST10 Hygienic gasket, blue, silicone, with ribs
For 10-in. Series C Stainless Steel terminals C 1

2711P-RGST15 Hygienic gasket, blue, silicone, with ribs
For 15-in. Series C Stainless Steel terminals C 1
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Notes:
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Chapter 2

Install the PanelView Plus 7 Performance 
Terminal
This chapter describes how to install a PanelView™ terminal in the door or wall of a NEMA 
rated, UL Type rated, or IP rated enclosure. For instructions on how to install the PanelView 
terminal on a machine, pedestal, or wall, see the ArmorView™ Plus 7 Installation Instructions, 
publication 2711P-IN013.

ATTENTION: Do not use a PanelView Plus 7 Performance terminal for 
emergency stops or other controls critical to the safety of personnel or 
equipment. Use separate hard-wired operator interface devices that do not 
depend on solid-state electronics. Some configurations of the ArmorView Plus 
7 terminal include a separate emergency stop button that can be hard-wired.

Environment and Enclosure

ATTENTION: 
This equipment is intended for use in a Pollution Degree 2 industrial environment, in overvoltage Category II applications (as 
defined in IEC 60664-1), at altitudes up to 2000 m (6561 ft) without derating.
The terminals are intended for use with programmable logic controllers. Terminals that are AC powered must be connected 
to the secondary of an isolating transformer. 
This equipment is considered Group 1, Class A industrial equipment according to IEC CISPR 11. Without appropriate 
precautions, there may be difficulties with electromagnetic compatibility in residential and other environments due to 
conducted or radiated disturbances.
Korean Radio Wave Suitability Registration - When so marked this equipment is registered for Electromagnetic 
Conformity Registration as business equipment (A), not home equipment. Sellers or users are required to take 
caution in this regard.
이 기기는 업무용 (A급) 전자파적합기기로서 판 매자 또는 사용자는 이 점을 주의하시기 바라 
며, 가정외의 지역에서 사용하는 것을 목적으 로 합니다.
This equipment is supplied as open-type equipment. It must be mounted within an enclosure that is suitably designed for 
those specific environmental conditions that will be present and appropriately designed to prevent personal injury resulting 
from accessibility to live parts. The interior of the enclosure must be accessible only by the use of a tool. The terminals meet 
specified NEMA, UL Type, and IEC ratings only when mounted in a panel or enclosure with the equivalent rating. Subsequent 
sections of this publication may contain additional information regarding specific enclosure type ratings that are required 
to comply with certain product safety certifications.
In addition to this publication, see the following:
• Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1, for additional installation requirements.
• NEMA 250 and IEC 60529, as applicable, for explanations of the degrees of protection provided by different types of 

enclosure.
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Chapter 2          Install the PanelView Plus 7 Performance Terminal
The terminals(1) have a temperature code of T4 when operating in a 55 °C (131 °F) maximum 
ambient temperature. Do not install product in environments where atmospheric gases have 
ignition temperatures less than 135 °C (275 °F).

Wiring and Safety Guidelines

ATTENTION: 
Use publication NFPA 70E, Electrical Safety Requirements for Employee Workplaces, IEC 60364 Electrical Installations in 
Buildings, or other applicable wiring safety requirements for the country of installation when wiring the devices. In addition 
to the NFPA guidelines, here are some other guidelines to follow:
• Employ only qualified electricians to wire the device in accordance with local, state, and national codes.
• Connect the device and other similar electronic equipment to its own branch circuit.
• Protect the input power by a fuse or circuit breaker that is rated at no more than 15 A.
• Route incoming power to the device by a separate path from the communication lines.
• Cross power and communication lines at right angles if they must cross. 
• Communication lines can be installed in the same conduit as low-level DC I/O lines (less than 10V).
• Shield and ground cables appropriately to avoid electromagnetic interference (EMI). Grounding minimizes noise from EMI and 

is a safety measure in electrical installations.
For more information on grounding recommendations, see the National Electrical Code that is published by the National Fire 
Protection Association.

Hazardous Locations

The following information applies when operating this 
equipment in hazardous locations.

Informations sur l’utilisation de cet équipement en 
environnements dangereux.

When marked, these products are suitable for use in "Class I, 
Division 2, Groups A, B, C, D; Class II, Division 2, Groups F, G; 
Class III"; Class I, Zone 2, Group IIC hazardous locations and 
nonhazardous locations only. Each product is supplied with 
markings on the rating nameplate indicating the hazardous 
location temperature code. When combining products within 
a system, the most adverse temperature code (lowest "T" 
number) may be used to help determine the overall 
temperature code of the system. Combinations of 
equipment in your system are subject to investigation by the 
local Authority Having Jurisdiction at the time of installation.

Les produits marqués "CL I, DIV 2, GP A, B, C, D; CL II, Div 2, GP F, G; CL 
III;" ne conviennent qu'à une utilisation en environnements de 
Classe I, Zone 2, Groupes IIC dangereux et non dangereux. Chaque 
produit est livré avec des marquages sur sa plaque d'identification 
qui indiquent le code de température pour les environnements 
dangereux. Lorsque plusieurs produits sont combinés dans un 
système, le code de température le plus défavorable (code de 
température le plus faible) peut être utilisé pour déterminer le code 
de température global du système. Les combinaisons 
d'équipements dans le système sont sujettes à inspection par les 
autorités locales qualifiées au moment de l'installation.

WARNING: EXPLOSION HAZARD
• Do not disconnect equipment unless power has been removed or 

the area is known to be nonhazardous. 
• Do not disconnect connections to this equipment unless power 

has been removed or the area is known to be nonhazardous. 
Secure any external connections that mate to this equipment by 
using screws, sliding latches, threaded connectors, or other 
means provided with this product.

• Substitution of components may impair suitability for Class I, 
Division 2.

• Peripheral equipment must be suitable for the location in which it 
is used.

• The battery in this product must be changed only in an area 
known to be nonhazardous.

• All wiring must be in accordance with Class I, Division 2 wiring 
methods of Article 501 of the National Electrical Code and/or in 
accordance with Section 18-1J2 of the Canadian Electrical Code, 
and in accordance with the authority having jurisdiction.

AVERTISSEMENT: RISQUE D’EXPLOSION
• Couper le courant ou s'assurer que l'environnement est classé non 

dangereux avant de débrancher l'équipement.
• Couper le courant ou s'assurer que l'environnement est classé non 

dangereux avant de débrancher les connecteurs. Fixer tous les 
connecteurs externes reliés à cet équipement à l'aide de vis, loquets 
coulissants, connecteurs filetés ou autres moyens fournis avec ce produit.

• La substitution de composants peut rendre cet équipement inadapté à une 
utilisation en environnement de Classe I, Division 2.

• Les équipements périphériques doivent s'adapter à l'environnementdans 
lequel ils sont utilisés.

• S'assurer que l'environnement est classé non dangereux avant de changer 
la pile ou le module horloge temps réel de ce produit.

• Tous les systèmes de câblage doivent être de Classe I, Division 2, 
conformément aux méthodes de câblage indiquées dans les Articles 501 du 
National Electrical Code (Code Electrique National) et/ou conformément à 
la Section 18-1J2 du Canadian Electrical Code (Code Electrique Canadien), 
et en fonction de l'autorité de jurisdiction.

(1) The ArmorView Plus 7 terminal is not certified for use in hazardous locations.
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Required Circuit Port Parameters for USB Peripheral Devices

This product contains USB host ports that comply with hazardous location environments. Field 
wiring compliance requirements are provided in compliance with the National Electrical Code, 
Article 500.

Figure 1 - PanelView Plus 7 Performance Terminal Control Drawing

PanelView Plus 7 Performance terminals provide two, separately powered USB host ports. 
Table 12 defines the circuit parameters of these USB host ports.

Application Information

Per the National Electrical Code, the circuit parameters of associated field-wiring apparatus 
for use in hazardous locations shall be coordinated with the host product such that their 
combination remains nonincendive. PanelView Plus 7 Performance terminals and the USB 
peripheral devices shall be treated in this manner.

The USB peripheral devices and their associated cabling shall have circuit parameters with the 
limits that are given in Table 12 for them to remain nonincendive when used with the 
PanelView Plus 7 Performance terminal USB host ports. 

If cable capacitance and inductance are not known, use the following values from ANSI/ISA-RP 
12.06.01-2003:

Ccable = 197 pF/m (60 pF/ft)
Lcable = 0.7 µH/m (0.20 µH/ft)

Nonincendive field wiring must be wired and separated in accordance with 501.10(B)(3) of the 
National Electrical Code, ANSI/NFPA 70, or other local codes as applicable. This associated 
nonincendive field wiring apparatus has not been evaluated for use in combination with 
another associated nonincendive field wiring apparatus.

Nonincendive Field Wiring 
Apparatus

Associated Nonincendive Field Wiring Apparatus

PanelView Plus 7 Performance Host Product

USB Peripheral Device

USB Peripheral DeviceUSB Host Port

USB Host Port

Table 12 - Circuit Parameters for USB Host Ports

Parameter Value Parameter Definition

V oc (USB) 5.25V DC
Open circuit voltage of each host USB port.
The maximum applied voltage rating, Vmax (peripheral), of each USB peripheral device shall be 
greater than or equal to Voc (USB).

Vmax (peripheral) ≥ Voc (USB), 
(as appropriate)

I oc (USB) 1.25 A
Maximum output current of each host USB port.
The maximum current, Imax (peripheral), to which each USB peripheral device can be subjected 
shall be greater than or equal to I oc (USB).

Imax (peripheral) ≥ I oc (USB)

Ca (USB) 10 µF

This value is the maximum total capacitance that can be connected to each USB host port. 
The total capacitance of each USB peripheral device and its associated cable must not 
exceed the indicated value. 
The maximum total capacitance, Ci (peripheral), and cable capacitance of each separate USB 
peripheral device shall be less that or equal to Ca (USB).

Ci (peripheral) + Ccable (USB) ≤ Ca (USB)

L a (USB) 15 µH

This value is the maximum total inductance that can be connected to each USB host port. 
The total inductance of each USB peripheral device and its associated cable must not 
exceed the indicated value. 
The maximum total inductance, Li (peripheral), and cable inductance of each separate USB 
peripheral device shall be less than or equal to La (USB).

Li (peripheral) + Lcable ≤ La (USB)
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Mounting Considerations Consider the following when mounting the terminal: 
• Mount the terminal at a height suitable for most operators. You can mount the cabinet 

at another level than the operator floor.
• Use appropriate lighting. Do not operate the terminal in direct sunlight.
• Terminals are rated to operate at mounting angles between 0…180°.

Because the ArmorView Plus 7 terminals are pre-mounted in a custom enclosure for easy 
deployment, you may skip the following sections about mounting. For instructions on how to 
mount the ArmorView Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, 
publication 2711P-IN013.

Figure 2 - Acceptable and Unacceptable Mounting Positions
 

Mounting Clearances Plan for adequate space around the terminal, inside the enclosure, for ventilation and cabling. 
Consider the heat that the other devices produce in the enclosure.

The ambient temperature around the terminal must be 0…55 °C (32…131 °F), except for the 19-
in. Series A terminal (and Stainless Steel Series A and B), which has an ambient temperature 
requirement of 0…50 °C (32…122 °F). The ambient temperature for the 19-in. Series B terminal 
(Series C for the Stainless Steel terminals) is 0…55 °C (32…131 °F).

ATTENTION: Failure to follow these guidelines can result in personal injury or 
damage to the panel components.

1
6 66

11

1
6

6
6

1
1

1
66 6

1 1

Yes No

≤ 90°
From Vertical

≤ 90°
From Vertical

Table 13 - Minimum Required Clearances

Product Area Minimum Clearance
Top 51 mm (2 in.)

Bottom 102 mm (4 in.)

Sides 25 mm (1 in.) on side without an SD card
102 mm (4 in.) on side with an SD card

Back 0 mm (0 in.) (1)

(1) When mounting a stainless-steel terminal on a panel thicker than 3.66 mm (0.144 in.), the minimum clearance is 
from the mounting clip, not the back of the terminal.
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Chapter 2          Install the PanelView Plus 7 Performance Terminal
Panel Guidelines The terminals are panel-mount devices that mount in the door or wall of a NEMA rated, UL Type 
rated, or IP rated enclosure:

• Panels must have a thickness of 1.5…4.8 mm (0.060…0.188 in.).
• The material strength and stiffness of the panel must be sufficient to hold the terminal 

and maintain an appropriate seal against water and dust.
• The panel surface must be flat and free of imperfections to maintain an adequate seal, 

and NEMA and UL Type ratings.

Panel Cutout Dimensions Use the template that is shipped with your terminal to mark the cutout dimensions.

Prepare For Panel Mounting

Before mounting a terminal in a panel, read this section and the entire installation procedure 
on page 29.

Mounting levers insert into the slots around the bezel to secure the terminal in the panel. The 
number of levers varies by terminal size.

Each slot has six notches with alignment marks that are locking positions for a lever. The 
thickness of the panel in which you mount the terminal determines the locking position that is 
required to maintain a NEMA/UL Type seal.

Table 14 - Panel Cutout Dimensions - PanelView Plus 7 Performance Terminals

Terminal Size Input Type Height, mm (in.) Width, mm (in.)

6.5-in.
Keypad and touch 142 (5.59) 237 (9.33)

Touch 142 (5.59) 184 (7.24)

9-in. Touch 162 (6.38) 252 (9.92)

10.4-in.
Keypad and touch 224 (8.82) 335 (13.19)

Touch 224 (8.82) 269 (10.59)

12.1-in. Touch 218 (8.58) 312 (12.28)

15-in.
Keypad and touch 290 (11.42) 418 (16.46)

Touch 290 (11.42) 353 (13.90)

19-in. Touch 383 (15.08) 457 (17.99)

IMPORTANT To mount a stainless-steel terminal, skip this section and continue with 
Mount the Stainless Steel Terminal in a Panel on page 33.

IMPORTANT Catalog number 2711P-RMCP mounting levers (black) are used with the 
PanelView Plus 7 Performance terminals. Do not use gray mounting 
levers; they are not compatible with PanelView Plus 7 Performance 
terminals.
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Always orient a mounting lever vertically before inserting it into a slot. This method is the only 
way to slide the mounting lever knob within the slot for positioning. After sliding the mounting 
lever to a specific notch, rotate the mounting lever toward the panel to lock it in position. The 
flat side of the mounting lever must come into contact with the panel.

Table 15 - Lever Locking Positions

Mounting Slot Lever Lock Position Panel Thickness Range Typical Gauge
1 1.50…2.01 mm (0.060…0.079 in.) 16
2 2.03…2.64 mm (0.080…0.104 in.) 14
3 2.67…3.15 mm (0.105…0.124 in.) 12
4 3.17…3.66 mm (0.125…0.144 in.) 10
5 3.68…4.16 mm (0.145…0.164 in.) 8/9

6 4.19…4.80 mm (0.165…0.188 in.) 7

6
1

Notch
Alignment Mark

Orientation of Slot Varies

6 5 4 3 2 1

1

Flat Side
Knob on reverse 
side of lever 
inserts into 
large end of slot

1 2 3 4

The edge of the bezel has alignment 
indentations to assist with lever positioning.
The notch on the outside of the lever shows it 
is locked in position 3.

You can use an erasable marker or grease pencil to mark the 
indentations for visibility of slot positions.

Inner notch on lever 
shows current lever 
position. 
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Initially, secure the terminal in the panel by sliding each mounting lever to a position that is 
one or two notches greater than the final lock position. For example, if the final lock position is 
3, slide each mounting lever to position 4 or 5. Follow the sequence specific to the terminal 
size shown in Figure 3 on page 28. 

Then adjust each lever to its final lock position in the same sequence. See Figure 3 on page 28. 

This figure shows the lever orientation and lock sequence for a 10.4-in. touch terminal.

If the lock position is 6, slide the lever to the large end of the slot or insertion hole.

IMPORTANT This process equalizes the pressure of the levers against the panel at a 
gradual rate reducing the probability of broken clamps.

54

Notch shows locked position.

3 1

2 4

8

67

5

This 10.4-in. touch terminal has all levers that are locked in 
position 3, which is appropriate for a panel thickness of 
2.67…3.15 mm (0.105…0.124 in.).
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Figure 3 - Lever Orientation and Lock Sequence

ERR

STS

1 21 2

5

2 4

6

6.5-in. Touch Only - 6 Levers 6.5-in. Keypad and Touch - 8 Levers

2

7

4

8

8
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3 10 1

7

5

4
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5
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6
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15-in. Keypad and Touch - 14 Levers

5 3 1 7

3 1

6

3 1

1103

7

15-in. Touch Only - 12 Levers

19-in. Touch Only - 16 Levers

5 3 1 7

8 2 4 6

11

13

9

15

10

16

12

14

IMPORTANT: The mounting lever orientations that are shown are required to 
maintain NEMA, UL Type, and IP seals. If you require a NEMA, UL Type, or IP seal, 
do not use a mounting lever in a different orientation than shown.
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Mount the Aluminum 
Terminal in a Panel

The terminals are designed for single-person installation. No tools are required except for the 
tools that are used to make the panel cutout.

To mount the terminal in a panel, follow these steps.

1. Cut an opening in the panel by using the panel cutout template that shipped with the 
terminal, or the cutout dimensions in Table 14 on page 25.

2. Verify that the sealing gasket is present on the terminal.
This gasket forms a compression seal. Do not use sealing compounds.

3. Insert and stabilize the terminal in the panel cutout.
a. Insert the levers in the top corner slots by using the orientation in Figure 3 on 

page 28, and rotate the curved side of the levers toward the panel.

IMPORTANT To mount a stainless-steel terminal, skip this section and continue with 
Mount the Stainless Steel Terminal in a Panel on page 33.

ATTENTION: 
Disconnect all electric power from the panel before making the panel cutout.
Make sure that the area around the panel cutout is clear and that the panel is 
clean of any debris, oil, or other chemicals.
Make sure that metal cuttings do not enter any components that are installed 
in the panel, and that the edges of the cutout have no burrs or sharp edges.
Failure to follow these warnings can result in personal injury or damage to 
panel components.

The mounting levers for PanelView Plus 7 Performance terminals are black 
(catalog number 2711P-RMCP).
Do not use gray mounting levers; they are not compatible with PanelView 
Plus 7 Performance terminals.

Gasket

Flat SideCurved Side Curved Side
Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024 29



Chapter 2          Install the PanelView Plus 7 Performance Terminal
b. Tilt the terminal into the panel cutout and guide upward into the cutout so that the 
levers are behind the panel.

c. Pull the top of the terminal toward you to verify that the levers are still in place and 
the terminal is stabilized in the panel.

d. Insert the remaining levers in the slots by using the orientations for your terminal in 
Figure 3 on page 28. 
The direction that you rotate the levers varies for each terminal size. 

The levers help to help prevent the terminal from falling out of the panel.
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4. Slide and rotate each lever to a notch that is one or two positions greater than the final 
lock position, starting with the first lever in the sequence.
For example, if the final lock position is 3, slide the lever to notch 4 or 5.

a. See Figure 15 on page 26 to get the final lock position of the levers.
b. See Figure 3 on page 28 to get the locking sequence.
c. Rotate each lever until its flat side comes in contact with the panel.

5. Adjust each lever to its final lock position by using the same locking sequence in 
Figure 3 on page 28.
a. Unlock lever one in the sequence by rotating it away from the bezel.

b. With the lever positioned vertically to the slot, slide the lever to the final locking 
position in Table 15 on page 26.
The outer notch of the lever aligns with the bezel indentation. 

c. Carefully rotate the lever back toward the panel.

d. Lock the remaining levers to their final position.

Use the alignment marks or previous marks that you made on the bezel to 
help position the levers and identify the final slot position.

IMPORTANT Do not use tools or excessive force to rotate the mounting levers. 
The mounting levers are rotated and secured by hand.

A broken mounting lever does not damage the terminal.
The mounting levers are designed to break off the pin if they are over 
torqued. This breakage helps to prevent damage to the terminal bezel. If a 
pin is broken, you can turn around the lever and use the lever in another 
location. See Figure 3 on page 28 for details and restrictions.

54

Flat side
Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024 31



Chapter 2          Install the PanelView Plus 7 Performance Terminal
6. Verify that all levers are in the correct locked position.

The notch on the outside of the lever shows its locked position. 
These two views show levers that are locked in position 3.

ATTENTION: All levers must be in the correct and same locked position 
to provide an adequate gasket seal between the terminal and the panel. 
Rockwell Automation assumes no responsibility for water or chemical 
damage to the terminal or other equipment within the enclosure 
because of improper installation.

1 1

Outer Notch Outer Notch
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Mount the Stainless Steel 
Terminal in a Panel

Mounting clips secure the stainless-steel terminals in a panel. The number of clips varies by 
terminal size. Tools that are required for installation include panel cutout tools, a large slotted 
or Phillips screwdriver, and a torque wrench for tightening the mounting clips.

To mount the stainless-steel terminal in a panel, follow these steps.
1. Cut an opening in the panel by using the panel cutout template that shipped with the 

terminal, or the cutout dimensions in Table 14 on page 25.
2. Place the terminal screen-down on a clean, flat surface.

Be careful not to scratch or damage the terminal screen.
3. Position the gasket on the bezel, with the gasket alignment plugs facing the bezel 

alignment features.
This gasket forms a compression seal. Do not use sealing compounds.

4. Press each gasket alignment plug into the bezel alignment feature.
The alignment plugs hold the gasket to the bezel.

5. Place the terminal in the panel cutout.
Hold the terminal so it does not fall out of the panel.

ATTENTION: 
Disconnect all electric power from the panel before making the panel cutout.
Make sure that the area around the panel cutout is clear and that the panel is 
clean of any debris, oil, or other chemicals.
Make sure that metal cuttings do not enter any components that are installed 
in the panel, and that the edges of the cutout have no burrs or sharp edges.
Failure to follow these warnings can result in personal injury or damage to 
panel components.

IMPORTANT Slip the inside corners of the gasket 
under the corners of the bezel shroud.

Gasket with Alignment Plugs
Back of Bezel with Alignment Features

Panel

Terminal
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6. Position the backing plate over the terminal.

7. Slide the ends of the mounting clips into the slots on the terminal.
8. Tighten the mounting clip screws by hand until the backing plate contacts the panel 

uniformly.
9. Torque the mounting clip screws to 2.3…2.6 N•m (20…23 lb•in) by using the specified 

sequence.
The clips loosen as the adjacent clip is tightened.

10. Repeat step 9 until all mounting clips are at the specified torque.

IMPORTANT Make sure that the flat side of the backing plate faces away from 
the panel, as shown in the drawing.

ATTENTION: Tighten the mounting clips to the specified torque to provide a 
proper seal and to help prevent damage to the product. Rockwell Automation 
assumes no responsibility for water or chemical damage to the product or 
other equipment within the enclosure because of improper installation.

Backing Plate

Mounting Clips

Panel

9-in. Torque Sequence
8 Clips

12.1-in. Torque Sequence
10 Clips

1

2

3

4
5

6 7

8

2

3

49

10

7 6

85

1

10-in. Torque Sequence
8 Clips

2

3

4
5

6 7

8

1

15-in. Torque Sequence
12 Clips

1

2

3

49

10

7 6

85

11 12
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Outdoor Installation

When using a 2711P terminal outdoors, you must follow these recommendations to maximize 
the field life of the front bezel and display:

• Add UV protection and shielding (sun shade or sun visor)
• Manage terminal temperature
• Install a protective overlay
• Consider terminal orientation
• Select a proper enclosure

Ultraviolet (UV) and infrared radiation can reduce the field life of any electronic terminal. While 
the materials used in the terminal bezels provide long field life, that life can be improved by 
proper installation and by following the suggested guidelines.

UV radiation from the sun causes all plastics to fade or yellow and become brittle over time. 
Using a sacrificial antiglare overlay (see Table 6 on page 18) helps protect the front of the 
terminal from direct exposure to UV radiation, and by avoiding direct sunlight exposure, this 
overlay greatly increases its field life. Another recommendation for UV protection is a shield to 
shade the terminal from the direct rays of the sun. This also helps reduce the solar heating 
that is caused by direct sun exposure. When installing a sun shield that closes over the display, 
the temperature between the sun shield and the display cannot exceed the maximum 
temperature of the display, which is 55 °C (131 °F). Adequately ventilate all sun shields to help 
prevent excess heat rise on the terminal display.

Use stirring fans or active cooling in high altitude and high ambient temperature locations to 
keep the internal enclosure temperature below 55 °C (131 °F).

Confirm the ambient temperature that the product is operating in does not fall below its 
minimum rated 0 °C (32 °F).

The temperature differential between the inside of the terminal enclosure and the front panel 
must be minimized to reduce the potential for condensation and possible pressure variation 
between the inside and outside of the product. 

Avoid placing the terminal on the south (north in the southern hemisphere) or west side of the 
cabinet. This reduces the heat rise due to solar heating during the hottest part of the day.

Mount the terminal vertically to minimize solar heating on the display. Do not mount the 
terminal in a sloped enclosure if it exposes the terminal to direct sunlight.

Protect the terminal from water and dust by mounting it in a proper enclosure following the 
instructions in the PanelView Plus 7 Performance Terminals Product Information, publication 
2711P-PC007. The terminals meet specified NEMA, UL Type, and IEC ratings only when properly 
mounted in a panel or enclosure with the equivalent rating. Other sections of this publication 
may contain additional information regarding specific enclosure type ratings that are required 
to comply with certain product safety certifications.

ATTENTION: Failure to follow the recommended installation practices for 
outdoor use substantially reduces product life and void product warranty.
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Chapter 2          Install the PanelView Plus 7 Performance Terminal
Remove and Replace Power 
Terminal Block

The product has a three-pin terminal block for power connections. You can remove the 
terminal block for ease of installation, wiring, and maintenance.

The terminal block has different markings for AC and DC power connections. Use a 0.6 x 3.5 
mm screwdriver for terminal block wiring.

To remove the terminal block, follow these steps.
1. Loosen the two screws that secure the terminal block.

2. Gently pull the terminal block away from the connector.

To install the terminal block, follow these steps.
1. Reattach the terminal block to the connector until seated.

2. Tighten the two screws that secure the terminal block to the connector.

WARNING: Explosion Hazard
If you connect or disconnect wiring while the power is on, an electric arc can 
occur. An electric arc can cause an explosion in hazardous location 
installations. Verify that the power is off and the area is nonhazardous before 
proceeding.
Failure to turn power off can result in electric shock or damage to the 
terminal.

Table 16 - Wire Specifications for Power Input Terminal Block

Wire Type Dual-wire Size(1)

(1) Two-wire maximum per terminal.

Single-wire Size Strip Length Wire Torque Mounting Torque

Stranded or solid
Cu 90 °C (194 °F)

0.3…1.3 mm2

22…16 AWG
0.3…2.1 mm2

(22…14 AWG)
7 mm (0.28 

in.)
0.4…0.5 N•m 

(3.5…4.4 lb•in)
0.15…0.2 N•m 
(1.3…1.8 lb•in)

1 1

AC Terminal Block
(Series A only) (1)

DC Terminal Block

ATTENTION: Do not use excessive force to press the terminal block 
into position. The terminal blocks are keyed to fit the DC or AC 
connector. If the terminal block does not fit into the connector, verify 
that you have the correct terminal block. See Table 7 on page 18.
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Connect to DC Power Terminals with a 24V DC power supply have these power ratings:
• 24V DC nominal (18…30V DC)
• 50 W maximum (2.1 A at 24V DC)

Terminals with a DC power input support operation from a safety extra low voltage (SELV) or 
protective extra-low voltage (PELV) 24V DC power supply. Supported power supplies include 
catalog numbers 1606-XLP95E, 1606-XLP100E, or 2711P-RSACDIN.

You can power the terminal from the same power source as other equipment by using a DC 
power bus. 

To connect the operator terminal to a DC power source, follow these steps.
1. Verify that the wiring is not connected to a power source.
2. Strip 7 mm (0.28 in.) of insulation from the ends of the wires.

3. Secure the DC power wires to the marked terminals (+ and –) on the terminal block.

4. Secure the earth ground wire to the GND terminal on the terminal block.
The GND terminal must be connected to a low-impedance earth ground.

5. Apply power to the operator terminal.

ATTENTION: The power supply is internally protected against reverse 
polarity. To avoid damage to the terminal:
• Do not connect DC+ or DC- to the earth ground terminal. 
• Do not connect AC power, or more than 30V DC, to the power terminal block.

ATTENTION: Use a SELV or PELV supply as required by local wiring codes for 
your installation. The SELV and PELV power sources provide protection so that 
under normal and single fault conditions, the voltage between conductors and 
earth ground does not exceed a safe value.

ATTENTION: The earth ground connection to ground is mandatory. This 
connection is required for noise immunity, reliability, and 
Electromagnetic Compliance (EMC) with the European Union (EU) EMC 
Directive for CE marking conformance. This connection is required for 
safety by Underwriters Laboratory.

7 mm
20 mm

1 1

GNDDC+ DC–

Performance Terminals

Stainless Steel Terminals
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Connect to AC Power(1) Terminals with an AC power supply have these power ratings:
• 100…240V AC (50…60 Hz)
• 105VA maximum

To connect the operator terminal to an AC power source, follow these steps.
1. Verify that the wiring is not connected to a power source.
2. Strip 7 mm (0.28 in.) of insulation from the ends of the wire.

3. Secure the AC power wires to the marked terminals (L1 and L2N) on the terminal block. 

4. Secure the protective earth ground wire to the marked terminal on the terminal block.
The protective earth terminal must be connected to a low-impedance earth ground.

5. Apply power to the operator terminal.

(1) Available on Series A terminals only.

ATTENTION: Improper wiring of the power terminals can result in 
voltage at the communication connector shells. 
Do not apply power to the terminal until all wiring connections have 
been made. Failure to do so can result in electric shock.
ATTENTION: Do not connect stainless-steel terminals to AC power. 
Stainless-steel terminals are only compatible with DC power.

ATTENTION: The earth ground connection to ground is mandatory. This 
connection is required for noise immunity, reliability, and 
Electromagnetic Compliance (EMC) with the European Union (EU) EMC 
Directive for CE marking conformance. This connection is required for 
safety by Underwriters Laboratory.

7 mm
20 mm

1 1

L1
L2/Neutral

Protective Earth 
to Ground Bus
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Connect to a Network The two Ethernet ports connect to controllers on an EtherNet/IP™ network by using standard 
Ethernet connections. These network types are supported:

• Device Level Ring Network Topology on page 40 
• Linear Network Topology on page 41
• Star Network Topology on page 42

Each of these EtherNet/IP network topologies supports applications that use Integrated 
Motion over an EtherNet/IP network, if necessary.

Ethernet Ports

The Ethernet port has two 10/100Base-T connectors for network communication and supports 
MDI/MDI-X connections and DLR network topology as indicated by the DLR network icon.

The terminal connects to an EtherNet/IP network by using a CAT5, CAT5E, or CAT6 twisted-pair, 
Ethernet cable with RJ45 connectors.

The maximum cable length between the Ethernet ports and a 10/100Base-T port on an 
Ethernet hub (without repeaters or fiber) is 100 m (328 ft).

IMPORTANT The terminal has dual-Ethernet ports but only one device IP address.

IMPORTANT To help prevent accidental disconnection of the Ethernet cable, follow 
these steps:
• Secure the Ethernet cable to minimize vibration at the connector, and 

reduce the chance that personnel working inside the panel can 
accidentally disconnect the cable.

• Do not install the Ethernet cable too tightly. Leave some slack in the 
cable to help prevent pulling on the cable when the panel door is opened 
and closed.

WARNING: In hazardous locations, do not connect or disconnect any 
communication cable with power that is applied to this device or any device on 
the network. An electric arc can cause an explosion in hazardous location 
installations. Make sure that the power is off or the area is nonhazardous before 
proceeding.

Link 1Link 2

1 1

Network Ports
Link 1Link 2

Performance Terminals

Stainless Steel Terminals
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Each Ethernet port has two indicators that provide the status of activity.

Device Level Ring Network Topology

A DLR network is a single-fault tolerant ring network that is intended for the interconnection of 
automation devices. This topology is also implemented at the device level. No additional 
switches are required.

DLR network topologies automatically convert to linear network topologies when a fault is 
detected. The conversion to the new network topology maintains communication of data on 
the network. The fault condition is typically detected and corrected.

For more information on DLR network topology, see the EtherNet/IP Embedded Switch 
Technology Application Guide, publication ENET-AP005.

Table 17 - Ethernet Connector Pinout

Connector Pin Pin Name

View of RJ45 

Connector

1 TD+

2 TD-

3 RD+

4 Unused

5 Unused 

6 RD-

7 Unused

8 Unused

Shield Connection No direct connection (AC coupled to chassis GND)

Table 18 - Ethernet Status Indicators

Indicator Color Description

Link Integrity Green On when a link is present.

Activity Yellow Blinks when activity is detected on Ethernet link. 

A DLR network has supervisor nodes and ring nodes. The PanelView Plus 7 
Performance terminal operates only as a ring node on the network.

1 8

Yellow 
Status 
Indicator

Green 
Status 
Indicator
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Figure 4 - PanelView Plus 7 Performance Terminal in a DLR Topology Network

Linear Network Topology

A linear network topology is a collection of devices that are daisy chained together across an 
EtherNet/IP network. Devices capable of connecting to a linear network topology use 
embedded switch technology to remove the need for a separate switch, as required in Star 
network topologies.

Figure 5 - PanelView Plus 7 Performance Terminal in a Linear Topology Network
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The PanelView Plus 7 Performance terminal with dual Ethernet ports can be 
attached in the middle, or at the end, of a linear network.
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Via a 1783-ETAP EtherNet/IP Tap
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Performance Terminal
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Star Network Topology

A star network topology is a traditional EtherNet/IP network that has multiple devices that are 
connected to each other via an Ethernet switch.

Figure 6 - PanelView Plus 7 Performance Terminal in a Star Topology Network

Computer
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1734-AENTR POINT I/O Adapter
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PanelView Plus 7 Performance Terminal
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Initial Startup — Series A 
Terminals (and Stainless 
Steel Series A and B)

The first time that you start the system, the terminal goes through its startup sequence and 
launches FactoryTalk® View ME Station in Configuration mode.

To change the action that occurs at startup, follow these steps.
1. Select Terminal Settings.
2. Select Startup Options.

You can configure these options:
- Launch a FactoryTalk View Machine Edition HMI application.
- Launch FactoryTalk View ME Station in Configuration mode (default).
- Launch the Microsoft Windows® desktop. (This functionality is available on series A 

terminals only. Series B terminals (Series C for Stainless Steel terminals) launch the 
Control Panel).

For more information on how to change the startup option and desktop access, see Configure 
Startup Options on page 70.

Terminals are initially shipped with desktop access disabled. You can also 
configure the terminal to allow desktop access.
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Initial Startup — Series B 
Terminals(1)

Initial startup for Series B terminals (Series C for Stainless Steel terminals) differs from initial 
startup for Series A terminals. To complete initial startup for Series B terminals (Series C for 
Stainless Steel terminals), complete the steps that are shown in the following sections. For 
more information about the initial startup of Series B terminals (Series C for Stainless Steel 
terminals), see the PanelView Plus 7 Performance Series B Terminals Quick Start, publication 
2711P-QS002.

Calibrate the PanelView Terminal
1. Connect the terminal to an appropriately rated DC power source.

After the initial power-up, the terminal displays the Calibration Menu screen.

2. On the Calibration Menu screen, select Touch Screen Calibration.

3. In the Touch Screen Calibration dialog box, select Yes.

(1) Series C for Stainless Steel terminals.

WARNING: Series B terminals (Series C for Stainless Steel terminals) are 
designed for use with DC power only. Do not apply AC power or attempt to 
insert an AC terminal block (gray in color) into a Series B terminal (Series C 
for Stainless Steel terminals). 
For additional information about how to connect to DC Power, see Connect 
to DC Power on page 37.

For the following steps, if you do not have a keyboard or mouse that is 
connected to your terminal, you can select commands and icons on the 
screen.
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4. On the first calibration screen, calibrate the touch screen boundaries as prompted.

a. Carefully tap the blue portion of the target as close to the edge as possible and slide 
it off the edge of the display.
The target moves after your finger slides off the display.

b. Repeat as the target moves around the screen. 
The terminal saves these settings and then displays the second calibration screen.

5. On the second calibration screen, calibrate the touch screen as prompted:

a. Carefully tap and hold the center of the target for at least 1 second. 
The target moves after you do this. 

b. Repeat as the target moves around the screen. 
6. To save the calibration settings, tap the screen, as prompted.

7. In the Success dialog box, select OK.
8. Select Exit Calibration Menu.

IMPORTANT  If this is not done within 30 seconds, the settings are not saved. 
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9. In the Exit Calibration Menu dialog box, select Yes.
The terminal reboots and displays the first Welcome to PanelView Plus screen.

10. Review the information on this screen, and then select the Next button.
The terminal displays the second Welcome to PanelView Plus screen.

11. In the Administrator password field, enter a password for the PanelView Plus Windows® 
10 IoT Core Control Panel.
The only requirement for the password is that it must be from 1 to 64 characters.

12. Reenter the password in the Confirm password (must match the password you entered) 
field.

For the following PanelView screens, if you do not have a keyboard or 
mouse that is connected to your terminal, tap inside a field to display an on-
screen keyboard. On the keyboard, tap each character for the information 
you want to enter. When you are finished entering the information, tap the X 
in the upper-right corner of the keyboard. The keyboard closes and the 
information appears in the appropriate field.
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13. Select Next.
The terminal displays the Network Adapters setup screen.

14. Enter information about your network into the following fields:
- Automatic address—The default setting is On, which means that the system provides 

dynamic IP addresses. If you prefer to use a static IP address, turn this field Off by 
tapping the button indicator and sliding it to the left. The Automatic DNS field 
becomes inactive, and the following fields become active so that you can enter your 
information into them:
• IP address
• Subnet Mask
• Gateway

- Automatic DNS—The default setting is On, which means that the system generates 
DNS information for you. If you prefer to specify your own DNS information, turn this 
field Off by tapping the button indicator and sliding it to the left. The following fields 
become active so that you can enter your information into them:
• Preferred DNS
• Alternate DNS

If the Automatic DNS field is inactive, turn the Automatic address field On by 
tapping that button indicator and sliding it to the right. Then slide the 
Automatic DNS button indicator to the right to turn that field Off.
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15. Select Next.
The terminal displays a verification screen.

16. Select Save and Reboot.

The terminal restarts and displays the PanelView Plus Firmware Update Utility screen.

17. Continue with Update the System Firmware on page 49.

If you must change your network settings after this initial setup, you can do 
that in FactoryTalk View ME Station by selecting Terminal Settings [F4] > 
Networks and Communications > Network Connections > Network Adapters.

IMPORTANT If a USB Storage Device is not plugged into the terminal, the 
Update from USB Storage button is not visible on the screen. Plug 
in a USB storage device and the button is automatically added.
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Update the System Firmware

You can update the firmware on your terminal by using one of the following methods:
• USB storage device
• ControlFLASH™ client, which is available in the following formats:

- ControlFLASH Plus™
- ControlFLASH

Update the Firmware Using a USB Storage Device
1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at 

rok.auto/pcdc.
2. On the home page, select Available Versions.

3. Click the Select a Product link, and in the Select a Product dialog box, enter PanelView 
Plus 7 Performance in the search field, and then select the Search button.

4. Select PanelView Plus 7 Performance, and then select B for the Series B (Series C for 
Stainless Steel terminals) firmware.

5. Select the Show Downloads icon for the desired firmware revision for PanelView Plus 7 
Performance (Series B (Series C for Stainless Steel terminals)). 

6. Select and download the CAB Files for the desired firmware revision.

7. After the .ZIP file has downloaded, extract the contents to the root of the USB Storage 
Device.

Firmware for Series B terminals (Series C for Stainless Steel terminals) 
starts at version 12.XXX.

IMPORTANT Do not download the DMK file. It does not work to update 
firmware via a USB Storage Device.

Use a USB Storage Device with at least 8 GB of storage available. Any 
Windows file system (including FAT32 or NTFS) is acceptable.
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8. Insert the removable storage device into one of the USB ports at the bottom of the 
PanelView terminal. 

9. Select Update from USB Storage and wait for the firmware update to complete. 

Before the update starts, the terminal displays the warning message that is shown in 
the following graphic. As the message states, do not remove the USB storage device 
while the file is being copied. Wait until you are prompted to remove the USB storage 
device. 
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10. Select OK when you are ready to continue.
While the firmware is updating, the terminal displays the update status. When the 
update is complete, the terminal displays the message that is shown in the following 
graphic.

It is recommended that you remove the USB Storage device when prompted with the 
message shown in the image.

11. Select OK to continue.
When the update is complete, the terminal reboots again and then displays the 
Password Entry screen. 

12. Continue with Enter a Password on page 58.

Update the Firmware Using the ControlFLASH Client

The following ControlFLASH clients are available to update the firmware:
• ControlFLASH Plus
• ControlFLASH

Before you can use ControlFLASH Plus or ControlFLASH, you must download the DMK file from 
the Product Compatibility and Download Center (PCDC).

Download the ControlFLASH or ControlFLASH File
1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at 

rok.auto/pcdc.
2. On the home page, select Available Versions.

3. Click the Select a Product link, and in the Select a Product dialog box, enter PanelView 
Plus 7 Performance in the search field, and then select the Search button.

4. Select PanelView Plus 7 Performance, and then select B for the Series B firmware (C for 
Series C Stainless Steel terminals).
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5. Select the Show Downloads icon for the desired firmware revision for PanelView Plus 7 
Performance (Series B (Series C for Stainless Steel terminals)). 

6. Select and download the DMK file for the desired firmware revision.

7. Save the DMK file in the desired Firmware Kits location.
The default location is C:\Users\Public\Documents\RockwellAutomation\Firmware Kits

8. On the PanelView terminal, under System Firmware, select Start Update Utility.

Update the Firmware Using ControlFLASH Plus

For details about how to install ControlFLASH Plus software, see the ControlFLASH Plus Quick 
Start Guide, publication CFP-QS001.

1. After you save the DMK file in the desired Firmware Kits location, launch ControlFLASH 
Plus.

2. Browse to and select the PanelView Plus 7 Performance Series B terminal (series C if it 
is a Stainless Steel terminal).

Firmware for Series B terminals (Series C for Stainless Steel terminals) 
starts at version 12.XXX.

IMPORTANT Before updating firmware on the PanelView terminal, the 
terminal must have a valid IP address. During initial startup the 
IP address can only be assigned via BootP/DHCP. After the 
terminal is flashed with firmware network configurations can be 
managed through the FactoryTalk View ME settings.

IMPORTANT Use ControlFLASH Plus, version 4, or higher. The following procedure 
uses ControlFLASH Plus, version 4.
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3. Select Next.

4. Confirm that the information is correct, and then select Flash.
A series of status changes occur on the ControlFLASH Plus screen and on the PanelView 
terminal.
On the ControlFLASH Plus screen, the Status field displays the Transmitting update 
status.

On the PanelView terminal, the status changes to CONNECTED: transferring updates… .
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Once the firmware file transmission is complete, on the ControlFLASH Plus screen, the 
Status field displays the Polling for power-up status.

On the PanelView terminal, the status changes to PLEASE WAIT: verifying and preparing 
updates…

The PanelView terminal reboots, and on the ControlFLASH Plus screen, the Flash Results 
dialog box displays a Succeeded message.
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5. Select Close, and then select Done.
When the firmware update is complete, the terminal reboots and displays moving gears 
while the update installs. 

6. Continue with Enter a Password on page 58.

Update the Firmware Using ControlFLASH

For information on how to install ControlFLASH, see the ControlFLASH User Manual, publication 
1756-UM105.

To use the ControlFLASH software to update the firmware in a PanelView Plus 7 Performance 
Series B terminal (Series C for Stainless Steel terminals), follow these steps.

1. Select Start > Programs > FLASH Programming Tools > ControlFLASH.
2. Make note of the required information in the Welcome dialog box, then select Next.

3. Select the catalog number of the PanelView Plus 7 Performance Series B terminal 
(Series C for Stainless Steel terminals) that you want to update and select Next.

IMPORTANT Use ControlFLASH, version 15.05, or higher. The following procedure 
uses ControlFLASH, version 15.05.

IMPORTANT Before updating firmware on the PanelView terminal, the terminal must 
have a valid IP address. During initial startup the IP address can only be 
assigned via BootP/DHCP. After the terminal is flashed with firmware 
network configurations can be managed through the FactoryTalk View 
ME settings.
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4. To update on the EtherNet/IP network, browse to and select the device, then select OK. 

5. Select the firmware revision that you want to install and select Next.

6. Read the Danger information in the Summary dialog, then select Finish.
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7. Select Yes to confirm that you want to update the target device.

The update starts and can take several minutes to complete.

When the firmware is sent to the terminal, the terminal resets and performs 
diagnostics.
The Update Status dialog box opens when the update is complete. If the update was 
successful, the Status area is green.

8. Select OK.
If the update fails, the status area is red and reads Update failure. For troubleshooting 
information, see the ControlFLASH User Manual, publication 1756-UM105.

9. Close the ControlFLASH software.
10. Continue with Enter a Password on page 58.

IMPORTANT Do not cycle power to the terminal during this process or the 
firmware update does not complete successfully.
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Enter a Password

After the PanelView terminal is updated with the desired firmware revision, the terminal 
displays the Change Desktop Access Password screen. The password that you enter here is 
used to exit ME Station and access the Windows 10 IoT Core Control Panel menu.

1. On the Change Desktop Access Password screen, in the Password field, enter a 
password that meets the following criteria:
- Contains from 8 to 20 characters
- Contains at least one lowercase and one uppercase character
- Contains at least one numerical or special character
- Is not any form of the word password

If you must change (reset) your password after this initial setup, you can do that in 
FactoryTalk View ME Station by selecting or selecting Terminal Settings [F4] > 
Desktop Access Setup > Reset Password [F4].

If you do not have a keyboard or mouse that is connected to your terminal, select 
Set Password to display an on-screen keyboard. On the keyboard, tap each 
character for your password. When you are finished typing the password, tap the 
Enter button. The password appears in the Password field. 

The buttons that appear next to the other fields on the Change Desktop Access 
Password screen, for example, Confirm Password, Set Challenge, and Set 
Response, display the same on-screen keyboard. Use the on-screen keyboard for 
these fields as described in the previous Note. 
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2. Tap the Confirm password field, and enter the password again.
3. Tap the Challenge question field, and enter a question.

4. Tap the Challenge response field, and enter the answer to the challenge question.
The response must be a minimum of six characters. 

5. Select OK.
The terminal displays the FactoryTalk View ME Station startup screen.

6. Continue with Transfer Runtime Files (.mer) on page 59.

Transfer Runtime Files (.mer)

You can transfer project files (.mer) to your terminal by using one of the following methods:
• Transfer Utility (via Ethernet)
• Removable storage (USB drive or SD card)

Transfer Utility

To transfer runtime files (.mer) by using the Transfer utility, complete the following steps:
1. From the FactoryTalk View Studio application on your PC, select Tools > Transfer Utility.

2. In the Transfer Utility dialog box, select the ellipsis to the right of the Source file field, 
browse to the location of the .mer file, and select the .mer file.

The challenge question is used to reset the password.
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3. In the Select destination terminal field, browse to the location of the PanelView Plus 7 
Series B terminal (Series C for Stainless Steel), and select it.

4. Select Download.

The runtime file (.mer) file is downloaded to your PanelView terminal.
60 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 3

Configure Terminal Settings
FactoryTalk View ME 
Station

FactoryTalk® View ME Station is the runtime environment of the terminal. This environment 
lets you configure startup options, load and run HMI applications, adjust terminal settings, 
access the Windows® desktop (Series A terminals only), and perform other terminal 
operations.

When you restart the terminal, one of these actions occurs depending on the configured 
startup option:

• FactoryTalk View ME Station launches in Configuration mode (factory default).
• FactoryTalk View ME .mer application runs.
• Windows desktop launches (Series A terminals only).

Figure 7 - FactoryTalk View ME Station Configuration Menu

IMPORTANT • To access Configuration mode from an HMI application on the terminal, 
select Goto Configuration Mode. This button is added to application 
screens in FactoryTalk View Studio software during application 
development. The application stops running but is still loaded.

• If your application does not have a Goto Configuration Mode button, see 
Enter Configuration Mode on Startup on page 71 for details on how to 
access Configuration mode.

• To access Configuration mode from the Windows desktop (available only 

on Series A terminals), double-click the FTViewME Station icon .
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Table 19 - Terminal Operations

Select To

Load Application [F1]
Open a dialog box where you select a .mer application to load in the device. 
You must load an application before you can run it.
The name of the loaded application appears under Current Application.

Run Application [F2] Run the .mer application that is loaded in the terminal.

Application Settings [F3]
Open a menu of application-specific settings, such as device shortcuts 
defined for the loaded .mer application. Device shortcuts are read-only.
For example, CLX is the device shortcut for a ControlLogix® controller.

Terminal Settings [F4] Open a menu of options to modify terminal settings.

Delete Log Files Before Running [F5]

Toggle between Yes and No. 
• Select Yes to delete all data log files, alarm history, and alarm status files 

before running the application. 
• Select No to run the application without deleting log files.

Reset [F7]
Reset the terminal and launch an HMI application, FactoryTalk View ME 
Station software, or the Windows CE desktop (Series A terminals only). The 
action that occurs depends on the configured startup-option. 

Exit [F8] Exit FactoryTalk View ME Station. If desktop access is allowed, you can 
access the desktop (series A terminals only).

Device, IP Address, Subnet
(Display only)

Identifies the device name, IP address, and subnet of the terminal on a 
connected Ethernet network. 
The network information is updated every 60 seconds. If the terminal is 
disconnected from the network, the IP address and subnet appear as 
0.0.0.0.

On devices with a keypad and a touch screen, press a function key or select the 
touch screen button to access an operation. For example, to access terminal 
settings:
• Press the F4 function key, or
• Select the Terminal Settings touch screen button
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Terminal Settings The terminal has settings that you can adjust that are not specific to the application. 
1. Select Terminal Settings from the FactoryTalk View ME Station dialog box.
2. Select an option by using the up and down cursor.

- On touch screen terminals, touch the up or down cursor.
- On keypad terminals, press the corresponding key on the keypad.

3. Press Enter to access the selected function.

Table 20 - Terminal Settings

Select This Option:  If You Want to:

Alarms Close the alarm display on the terminal when an operator acknowledges the newest alarm. By default, the alarm display is closed.

Diagnostics Setup Forward diagnostic messages from a remote log destination to a computer that runs diagnostics.

Display Adjust the brightness of the display, configure the screen saver, and enable/disable the touch screen cursor.

Desktop Access Setup Allow or restrict access to the desktop. Set or reset the desktop password (Series A terminals exit to the desktop. Series B terminals 
(Series C for Stainless Steel terminals) exit to the Control Panel).

File Management Copy application files and font files to the terminal, an SD card, or a USB drive. You can also delete application files or log files.

Font Linking Link a font file to a base font loaded on the terminal.

Input Devices Configure settings for the keypad, attached keyboard, mouse, or touch screen, including touch screen calibration. You can also 
choose between a pop-up character input or pop-up keyboard for string input.

File Integrity Check Check the integrity of the .mer application file and runtime files by logging details to a file integrity check log. You can view and 
clear this log at any time.

Networks and Communications Configure Ethernet and other communication settings for an application. KEPServer Driver Configuration is a new option available 
on both Series A and Series B terminals (Series C for Stainless Steel terminals).

Print Setup Configure settings to print displays, alarm messages, or diagnostics messages generated by the application.

Startup Options Specify whether the terminal launches the desktop, an application, or FactoryTalk View ME Station Configuration mode on startup. 

System Event Log Display system events that are logged by the terminal, and clear events from the log.

System Information Display power, temperature, battery, and memory details for the terminal. You can also view the firmware revision for FactoryTalk 
View ME Station, and other software loaded on the terminal. Technical support information.

Time/Date/Regional Settings Set the date, time, language, and numeric format used by terminal and applications. 

Certificates Management Import and view certificates on the terminal.
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Soft Keyboard When you activate a data entry field, a keyboard opens. For fields that require numeric values 
only, 0…9 and the decimals are enabled.

To enter characters in the display area above the keyboard, follow these steps.
1. Select a character on the keyboard: 

- On a touch screen terminal, touch a key.
- On a keypad terminal, press the arrow keys to navigate to a key.

2. Use Select to copy the character to the display area.
3. Select Enter when done to exit the keyboard.

Table 21 - Soft Keyboard Controls

Select This Key: To:

SHF Switch keys between their shifted and unshifted state.

CAP Switch between lowercase and uppercase characters. 

SPACE Enter a space between characters in the Display Area.

Backspace Delete the previous character (to the left of the cursor) in the Display Area.

Select Select a character and enter it in the Display Area.

Left, Right, Up, Down Arrow Select the character to the left, right, above, or below the selected character.

Enter Accept the entered characters and return to the previous dialog box.

ESC Cancel the current operation and return to the previous dialog box.
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Load and Run Application To run a FactoryTalk View ME .mer application on the terminal, you must first load the 
application. You can load the application from internal storage (nonvolatile memory) in the 
terminal, an SD card, or a USB drive.

To load and run an application on the terminal, follow these steps.
1. Select Load Application from the FactoryTalk View ME Station dialog box.
2. Select Source to select the location of the file to load:

- Internal Storage - nonvolatile memory of the terminal.
- External Storage 1 - SD card that is loaded in the card slot.
- External Storage 2 - USB drive that is loaded in the USB host port.

3. Select a .mer file from list by using the up and down cursor keys.
4. To load the selected application, select Load.

You are asked if you want to replace the current communication settings for the 
terminal with the settings that are defined in the application. 

5. Select Yes or No.
- Select Yes to use the communication settings in the application.
- Select No to use the communication settings of the terminal.
The application loads and the application name appears at the top of the FactoryTalk 
View ME Station dialog box.

6. To run the application that you loaded, select Run Application on the FactoryTalk View 
ME Station dialog box.

The path for Machine Edition files on the terminal is My Device\Application 
Data\Rockwell Software\RSViewME\Runtime.
The path for Machine Edition files on the SD card or USB drive is \Rockwell 
Software\RSViewME\Runtime.

Applications generate log files. You can delete log files from the FactoryTalk 
View ME Station dialog box before running the application. Delete log files to 
reclaim memory in the terminal. 
To set the application to run on startup or reset, see Run the Loaded 
Application on Startup on page 72.
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Windows CE Desktop 
Access — Series A 
Terminals

You can allow or restrict desktop access on the terminal (Series A(1) terminals allow Windows 
CE desktop access. Series B terminals exit to the Control Panel). From the desktop, you can 
perform system and control panel operations, use file viewers, the web browser, and the 
media player. You can allow temporary access, then disable desktop access to help prevent 
unauthorized changes.

With restricted access, the only way to access the desktop is to enter a password. Each 
terminal has a default password and challenge question. 

Enable Desktop Access

To enable desktop access, follow these steps.
1. Select Terminal Settings, then select Desktop Access Setup.
2. To choose Allow, select Desktop Access.

The Enter Password dialog box opens. 
Each time that you change desktop access from disallow to allow, you must enter a 
password. The default password is ‘password’. 

3. To enter the password, select Password.
4. Press Enter.
5. To return to Desktop Access Management, select Enter again.

Notice that the password is no longer set.
6. Select OK to exit Desktop Access Management, then Close to exit terminal settings and 

return to the FactoryTalk View ME Station dialog box.
7. To access the desktop, select Exit.

When desktop access is enabled, you are not required to enter a password.

(1) Series B on Stainless Steel terminals.

Terminals are shipped from the factory with desktop access disabled.

Table 22 - Default Restricted Access Settings

Default Password Credentials Values
Password password (case sensitive)
Challenge question What is the opposite of lock?
Challenge answer unlock (case sensitive)

Rockwell Automation recommends that you change the default password and 
challenge question and answer to something unique for your installation.
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Disable Desktop Access

To restrict desktop access, define a desktop password and challenge question:
• The password lets you access the desktop from FactoryTalk View ME Station when you 

select Exit.
• The challenge question and response lets you change the password with the Reset 

function.

To disable desktop access, follow these steps.
1. Select Terminal Settings, then choose Desktop Access Setup.
2. To choose Disallow, select Desktop Access.

The Set Password button is enabled.

3. See Set a Desktop Password on page 68 to define a new password and challenge 
question.

IMPORTANT To restrict desktop access, set the startup option to either Go to 
Configuration Mode or Run Current Application. See page 70 for details.

IMPORTANT If an error message displays, you can change the startup option 
to Go to Configuration Mode or Run Current Application.
You cannot restrict access to the desktop if Startup Options is 
configured to Do not start FactoryTalk View ME Station.
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Set a Desktop Password

On Series B terminals (Series C for Stainless Steel terminals), the desktop password is used to 
exit ME into the Windows Control Panel.

To define a new desktop password, follow these steps.
1. Select Set Password.

The Desktop Access Set Password dialog box opens.

2. Select Set Password, enter an 8…20 character password, then select Enter.

3. Select Set Challenge to enter a challenge question that you must correctly respond to 
when resetting the desktop password.

4. Select Set Response to enter a response to the challenge question, then select Enter.
5. Select OK. 

The Desktop Access Management Dialog shows that a password and challenge question 
are set.

6. Select OK to return to terminal settings.

IMPORTANT When you restrict access to the desktop, you must define a new 
password and challenge question.

IMPORTANT You must correctly enter this password to access the desktop.

IMPORTANT Secure your password and challenge question for future use. To clear 
and reset the password, you must correctly respond to the challenge 
question. If you forget the response, the only way to clear the password 
is to restore the factory default settings on the terminal. See Factory 
default on page 196.
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Reset the Desktop Password

To clear and change the current password, you must correctly respond to the current 
challenge question. If you do not remember the response, you must restore the terminal to its 
factory defaults. See Maintenance Mode Operations — Series A Terminals on page 196.

To reset the desktop password, follow these steps.
1. Select Reset Password from the Desktop Access Management dialog box.

2. Select Answer Challenge and enter the correct response to the current challenge 
question.

3. Select Clear Password to clear the current password and challenge question.
The dialog box shows the updated status of the password and challenge information.

4. Select Close.
5. Refer to Set a Desktop Password on page 68 to set a new password and challenge 

question.
After clearing the password, you must set a new desktop password or change the 
desktop access to allow.

IMPORTANT You can reset the password and challenge questions if access to the 
desktop is restricted or set to disallow.
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Configure Startup Options You can specify what action the terminal takes on startup or a reset.

Disable FactoryTalk View ME Station on Startup

To launch the desktop on startup, you must disable FactoryTalk View ME Station. 

To disable FactoryTalk View ME Station on startup, follow these steps.
1. Select Terminal Settings, then choose Startup Options.

2. Select On Startup until ‘Do not start FactoryTalk View ME Station’ is selected.

3. Select OK.

This Startup Option Performs This Action Typical System

Do not start FactoryTalk View ME Station
Launches the Windows desktop on startup (available 
only on Series A terminals. This option is not available 
on Series B terminals. (Series C for Stainless Steel 
terminals)).

Open

Go to Configuration Mode Launches FactoryTalk View ME Station in 
Configuration mode on startup (factory default). Closed

Run Current Application Runs the FactoryTalk View ME application that is 
loaded in the terminal on startup. Closed

IMPORTANT When desktop access is restricted, the startup option must be set to 
Run Current Application or Go to Configuration Mode (default). See 
page 66 for details on how to allow or restrict desktop access.

You can also launch the desktop by selecting Exit on the FactoryTalk View ME 
Station dialog box. 

On Series A terminals only, desktop access must be set to allow or you get a 
warning. See Enable Desktop Access on page 66.
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Enter Configuration Mode on Startup

To launch FactoryTalk View ME Station in Configuration mode on startup, follow these steps.
1. Select Terminal Settings, then choose Startup Options.
2. To choose Go to Configuration Mode, select On Startup.
3. To view or change optional settings, select Configuration Mode Options.

4. To specify whether you want to load the current application on startup, select Load 
Current Application.

5. To specify what configuration settings are used when the loaded application is run, 
select Replace FactoryTalk Linx Communications:
- To use the RSLinx® communication settings in the terminal, select No. 
- To replace the terminal settings with the communication settings in the application, 

select Yes. Any changes to RSLinx device addresses or driver properties on the 
terminal are lost. 

6. To return to the previous dialog box, select OK.
7. To return to terminal settings, select OK.

On Series B terminals, the Do not start FactoryTalk View ME Station option is not 
available and appears dimmed.(1)

(1) Series C for Stainless Steel terminals.
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Run the Loaded Application on Startup

To run the FactoryTalk View .mer application that is loaded in the terminal on startup, follow 
these steps.

1. Select Terminal Settings, then choose Startup Options.
2. To choose Run Current Application, select On Startup.
3. To view or change optional settings, select Run Options.

If the application is not loaded, the options are disabled.

4. To specify what configuration settings are used when running the application, select 
Replace FactoryTalk Linx Communications:
- To use the RSLinx communication settings in the terminal, select No. 
- To replace the terminal settings with the communication settings in the application, 

select Yes. Any changes to RSLinx device addresses or driver properties on the 
terminal are lost.

5. To specify what action to take with the log files on startup, select Delete Log Files On 
Every Power Cycle:
- To delete all log files (data, alarm history, alarm status) generated by the terminal 

before running the application, select Yes. The files are deleted from the system 
default location.

- To retain all log files, select No.
6. To return to the previous dialog box, select OK.
7. To return to terminal settings, select OK.
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Configure Controller 
Address

You can configure communication information for your application and controller by using 
FactoryTalk Linx software.

To edit the device address of the controller, follow these steps.
1. Select Terminal Settings, then choose Networks and Communications > FactoryTalk 

Linx Communications.

2. Select the controller in the tree.
3. To view the device name and current address, select Edit Device.
4. To modify the address, select Device Address.

The input panel opens with the current address.
5. Enter the address in the input panel and select Enter.
6. Select OK.

Updates do not take effect until the terminal is restarted.

You can also configure communication information for your application and 
controller by using FactoryTalk View Studio software.
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Configure Ethernet Settings The terminal has a built-in Ethernet driver. You can modify the Ethernet information for your 
device:

• IP address of terminal on network including link speed
• Device name that identifies terminal on network
• User name and password to access network resources
• Enable or disable either Ethernet port to configure for DLR, star, or linear network 

topologies

Set the MAC Address of the Terminal

Some networks automatically assign an IP address to Ethernet devices if Dynamic Host 
Configuration Protocol (DHCP) is enabled. If DHCP is disabled, you can manually enter an IP 
address.

To view or enter an IP address for your terminal, follow these steps.
1. Select Terminal Settings, then choose Networks and Communications > Network 

Connections > Network Adapters.

2. To view or modify the IP address, select IP Address.
3. To enable or disable DHCP assignment of addresses, select Use DHCP.

- If DHCP is enabled or set to Yes, IP addresses are automatically assigned to newly 
attached devices on the network.

- If DHCP is disabled or set to No, you can manually enter the IP address. Select IP 
Address, Subnet Mask, and Gateway to enter IP formatted addresses.

4. Select OK when done.
If prompted, reset the device from the FactoryTalk View ME Station dialog box.

5. Select Close.

• IP Address - The format of the IP address is xxx.xxx.xxx.xxx, for example, 
10.90.95.15. The first set of decimal numbers is in the range 1…255; the last 
three sets in the range 0…255. The default is 000.000.000.000. 

• Subnet Mask - The address must be identical to the server subnet mask. 
• Gateway - optional address.
• MAC ID - read-only field.
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Set the Ethernet Link Speed

You can change the rate and mode at which data is transmitted on the Ethernet network. The 
default setting is Auto. The Auto option automatically configures the speed of the device to 
match the speed on the local network.

1. Select Terminal Settings, then choose Networks and Communications > Network 
Connections > Network Adapters.

2. To access the Ethernet link settings, select Settings.
3. To change the rate at which data is transmitted over the Ethernet network, select 

Ethernet Configuration.
4. To return to the Network Adapters dialog box, select OK.

The Auto option is preferred because it determines the actual speed and duplex 
setting of the connected device on the Ethernet network.
If you select a manual option, make sure that the speed and duplex setting for the 
connected device on the Ethernet network is identical. If the settings are different, 
there can be decreased network performance and errors.
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Define Name Server Addresses

You can define Name Servers addresses for the EtherNet/IP™ network adapter. These 
addresses are automatically assigned if DHCP is enabled for the adapter.

1. Select Terminal Settings, then choose Networks and Communications > Network 
Connections > Network Adapters.

2. Select Name Servers.
3. To enter a corresponding name server address, select Primary or Secondary DNS.
4. Select OK when done.

Configure the Ethernet Ports

To configure the Ethernet ports of the terminal, follow these steps.
1. Select Terminal Settings, then choose Networks and Communications > Network 

Connections > Network Adapters.
2. To access the Ethernet link settings, select Settings.
3. To enable or disable the ports that you want to use for your network configuration, 

select Ethernet Link1 and Ethernet Link2.

4. To select Auto, select Ethernet Configuration.
5. To save the configuration, select OK.
6. Restart the terminal for the changes to take effect.

You can also configure the Ethernet ports as a system default for a closed system. See 
Configure the Ethernet Ports on page 132.

Primary WINS and Secondary WINS are not available on Series B terminals (Series 
C for Stainless Steel terminals).
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View the Network Diagnostic Data

To view the network data, follow these steps.
1. Select Terminal Settings, then choose Networks and Communications > Network 

Connections > Network Adapters > Network Diagnostics.

The table provides a description of Network Status text.

2. Select Close to exit the Network Diagnostic data.

Status Text Description
Network Status

Normal If the network topology is Linear/Star, the network status is always normal.
Ring Fault A non-fatal error condition exists.

Loop Detected
This value can only occur in a Linear/Star topology. This status occurs when an 
unexpected loop occurs in the network. It may not be possible for the terminal to report 
this condition (the terminal may not be capable of detecting the frames that it has sent).

Network Topology Identifies the network configuration as Linear/Star or Ring.
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Modify Device Name of 
Terminal

Each terminal has a unique name that identifies it on the network.
1. Select Terminal Settings, then choose Networks and Communications > Network 

Connections > Device Name.
2. To view or edit the default device name, select Device Name.

3. To modify the description for the device, select Device Description.

4. Select OK.

The device name has 1…15 characters:
• First character must be an upper or lowercase letter a…z, A…Z.
• The other characters can be a…z, A…Z, 0…9, or - (hyphen).

The description is a maximum of 50 characters. The default description is 
Rockwell Automation plus the device catalog number.
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Copy Files on Terminal You can copy FactoryTalk View ME application (.mer) files or font files between the nonvolatile 
memory of the terminal and a USB drive, or SD card. 

1. Select Terminal Settings, then choose File Management > Copy Files > Copy Applications 
or Copy Fonts.

2. To select the location of the file that you want to copy, select Source:
- Internal Storage - nonvolatile memory of the terminal.
- External Storage 1 - SD card that is loaded in the card slot of the terminal.
- External Storage 2 - USB drive that is loaded in the USB host port of the terminal.

3. Select a file that appears in the list for the selected storage area.
4. Select Destination on the same dialog box.

5. To select the storage location to copy the file, select Destination. 
The destination must be different than the source location.

6. To copy the selected file to the target location, select Copy.
If the file exists, you are asked if it is okay to overwrite the file. Respond by selecting 
Yes or No.

FactoryTalk View ME Station software looks for .mer files in the folder
My Device\Application Data\Rockwell Software\RSViewME\Runtime\ 
and font files in the folder \Rockwell Software\RSViewME\Fonts\ 
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Delete Files from Terminal You can delete FactoryTalk View ME application .mer files or font files that reside in the 
nonvolatile memory of the terminal, a USB drive, or an SD card.

1. Select Terminal Settings, then choose File Management > Delete Files > Delete 
Applications or Delete Fonts.

2. To select the storage location of the application or font file that you want to delete, 
select Source:
- Internal Storage - nonvolatile memory of the terminal.
- External Storage 1 - SD card that is loaded in card slot of the terminal.
- External Storage 2 - USB drive that is loaded in the USB host port of terminal.

3. Select a file that appears in the list for the selected storage area.
4. Select Delete.
5. Select Yes or No when asked if you want to delete the selected application or font file.

Delete Log Files

You can delete log files, alarm history files, and alarm status files from the System Default 
location of the terminal. The application generates these files during runtime.

1. Select Terminal Settings > File Management > Delete Files > Delete Log Files.
You are asked to confirm the deletion of the files.
Do you want to delete all FactoryTalk View ME Station Log Files?

2. Select Yes or No.

Log files not in the System Default location are not deleted.
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Display Settings For the terminal display, you can change its brightness, configure the screen saver, or disable 
the screen cursor.

Adjust Display Intensity

You can adjust the intensity of the backlight in 10% increments from 0…100%. At 0%, the 
backlight is minimally visible. You can use the default intensity of 100% or adjust the intensity 
for runtime operations.

1. Select Terminal Settings, then choose Display > Display Intensity.

2. To switch between Default intensity and Runtime intensity, select Startup Intensity.
- If you select Runtime, the startup screens use the runtime intensity.
- If you select Default, the startup screens us the default setting of 100%.

3. To increase or decrease the intensity for runtime operations, use the up or down 
cursors.

4. To save changes, select OK.

Startup Intensity is not available on Series B terminals (Series C for 
Stainless Steel terminals).
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Configure the Screen Saver

A screen saver image appears on the terminal display when no user activity has been sensed 
for a certain time. The default idle time is 10 minutes. You can adjust the idle time and 
intensity level of the screen saver, disable the screen saver, or disable the screen saver image.

1. Select Terminal Settings, then choose Display > Screen Saver.

2. To change the idle period for activating the screen saver, select Screen Saver.
To disable the screen saver, select Disabled.

3. To increase or decrease the brightness intensity of the screen saver, use the up and 
down cursors.

4. To access the screen saver image setting, select Advanced Settings.
a. To disable or enable the current screen saver, select Screen Saver Image.

See Screen Saver on page 112 for details on how to change the screen saver image.
b. To return to the Screen Saver dialog box, select OK.

5. To exit and return to terminal settings, select OK.

Disable the Screen Cursor

The terminal has a screen cursor that you can disable or enable.
1. Select Terminal Settings, then choose Display > Cursor.

2. To disable or enable the cursor, select Enable Cursor.
3. To exit and return to terminal settings, select OK.

Screensaver is not available in the initial Series B release (Series C for Stainless 
Steel terminals); it is added later. 

This is an unsupported feature on Series B terminals (Series C for Stainless Steel 
terminals).
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Input Device Settings You can adjust settings for input devices that are used by the terminal including the keypad, 
touch screen, attached keyboard or mouse, and string entry pop-up.

Configure Keyboard or Keypad Settings

You can adjust settings for keys on the terminal or an attached keyboard.
1. Select Terminal Settings, then choose Input Devices > Keyboard/Keypad.

2. Select Repeat Rate to specify the number of times a key repeats itself per second when 
held down.
Valid values are 0, 2…30. Values are device-dependent for an attached keyboard, but 
typically the same.

3. Select Repeat Delay to select the time that elapses per second before a key is repeated.
Values are device-dependent. Unsupported values are dimmed.

4. Select OK when done.

Calibrate the Touch Screen

To calibrate PanelView™ Plus 7 Performance Series A terminals with a touch screen, follow 
these steps. For information on how to calibrate the Series B terminals (Series C for Stainless 
Steel terminals), see See Initial Startup — Series B Terminals on page 44.

1. Select Terminal Settings, then choose Input Devices > Touch Screen > Calibration.

This is an unsupported feature on Series B terminals (Series C for Stainless Steel 
terminals). The Keyboard/Keypad configuration page is removed from Series B 
terminals (Series S for Stainless Steel terminal).

IMPORTANT Use a plastic stylus with a minimum tip radius of 1.3 mm (0.051 in.) A 
stylus is more precise than a finger and also helps to protect the 
screen.

Carefully press and briefly hold the stylus on the center of the 
target. Repeat as the target moves around the screen.
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2. Follow the instructions on the screen.
When the calibration is complete, a message appears to indicate the measurement of 
new calibration settings.

Set the Double-tap Sensitivity for a Touch Screen

You can set and test the sensitivity of both speed and physical distance between touch screen 
presses. 

1. Select Terminal Settings, then choose Input Devices > Touch Screen > Double Tap 
Sensitivity.

2. To set the sensitivity of touch screen presses, double-tap Set.
3. To test the sensitivity of touch screen presses, double-tap Test. 

The Test button reverses its foreground and background colors.
4. Select OK when done.

Change the Pop-up for String Entry

You can use a string pop-up for character input instead of the pop-up keyboard or input panel.
1. Select Terminal Settings, then choose Input Devices > String Pop-up.

2. To select the preferred method for character input, select Invoke pop-up character 
input instead of pop-up keyboard.

3. Select OK.

On This Type of Terminal: Do This:

Touch screen only • Touch the screen to register saved data. 
• Wait for 30 seconds to cancel saved data and keep the current settings.

Keypad and touch screen • Press the Enter key to accept new settings.
• Press the Esc key to cancel and keep the current settings.

The process is identical for setting and testing the sensitivity of mouse clicks. To 
adjust the sensitivity of mouse clicks, select Terminal Settings, then choose Input 
Devices > Mouse.
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Change Pop-up Input Color Settings

You can change the pop-up input color settings for your terminal.
1. Select Terminal Settings, then choose Input Devices.

2. In the Input Devices dialog box, choose Pop-Up Input Color Settings.
Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024 85



Chapter 3          Configure Terminal Settings
3. In the Pop-up Input Color Settings dialog box, choose the input element for which you 
want to change the color: Keypad, Keyboard, or Character input.

4. Choose each of the color areas that you want to modify for the input element, for 
example, Back color, and then select a color for that area.

5. To save the color changes, select OK.
The new colors are changed for that input element, as shown in the following example.
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Configure Print Options You can configure settings to print displays, alarm messages, or diagnostic messages from 
FactoryTalk View ME applications. The setup to print displays and messages are the same; 
advanced settings are different.

PanelView Plus 7 Performance Series A terminals support selected printers. For a list of 
supported printers, go to https://rockwellautomation.custhelp.com and search the 
Knowledgebase for the keywords ‘Printers Supported on PanelView Plus’.

PanelView Plus 7 Performance Series A terminals support selected Canon, Epson, Hewlett-
Packard, and Brother printers. Printer installation is plug and play. Supported printers are 
automatically mapped to the appropriate driver. Printers that do not configure automatically 
to the appropriate driver can be installed manually. 

To access the print setup, follow these steps.
1. Select Terminal Settings, then choose a Print Setup > option:

- Alarm Print Setup
- Diagnostic Setup
- Display Print Setup

The Print Setup dialog box shows installed printers that are available to the FactoryTalk 
View ME application. The list of printers that shows depends on what printers you 
install.
The terminals are not shipped with pre-configured printers so initially the dialog box is 
empty.

The following information applies to PanelView Plus 7 Performance Series A 
terminals. Series B terminals (Series C for Stainless Steel terminals) support the 
Internet Printing Protocol (IPP). On Series B terminals (Series C for Stainless Steel 
terminals), if a network printer is plugged in at terminal startup, the printer is 
automatically detected and there is no requirement to configure printer drivers. 
However, the IPP service must be enabled for this automatic detection to work. 
See Services Screen on page 151 for information on how to enable this service. 

Series B terminals (Series C for Stainless Steel terminals) have a pre-configured 
printer driver. With the IPP service enabled on Series B terminals (Series C for 
Stainless Steel terminals), if an IPP printer is detected it automatically appears in 
the printer selection list. 
The PDF printer driver is available by default on Series A and Series B terminals 
(Series C for Stainless Steel terminals).
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2. Select an installed printer.

3. To access these options, select Advanced Settings:
- Options to print displays include print orientation, draft mode, and color.
- Options to print diagnostic and alarm messages determine when to print messages 

that are sent to the network or USB port.

4. Select OK when done.
5. Select OK to return to terminal settings.

The printer that you select must be in the control panel Printers applet.
A failed attempt to automatically install a printer is reported in the system event 
log. A printer that does not install automatically can be installed manually by using 
the control panel in Windows Explorer.

Print Messages After Default Value Example

Specified number of 
messages 60 messages

When the queue has 60 messages, the messages are printed 
regardless of how long they have been in the queue.
You can change the number of messages.

500 messages or 
timeout period, 
whichever is first

168 hours 
(7 days)

If the queue has 350 messages after 168 hours, 350 messages are 
printed.
You can change the timeout period.

Specified number of 
messages or timeout 
period, whichever is 
first

60 messages
168 hours 
(7 days)

If the queue has 60 messages after 24 hours, 60 messages are printed.
You can change the number of messages and the timeout period.
For example, the number of messages is set to 75 and the timeout 
period is set to 48 hours.
• If the queue has 75 messages after 24 hours, then the 75 messages 

are printed before the set timeout of 48 hours.
• If the queue has 15 messages after 48 hours, the 15 messages are 

printed after the set timeout period.
88 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 3          Configure Terminal Settings
Configure Diagnostics You can log diagnostics to a remote computer for troubleshooting. 

To configure and forward diagnostics to a computer, follow these steps.
1. Select Terminal Settings, then choose Diagnostic Setup.

A list of diagnostic nodes appears.

The Remote Log destination forwards messages to a Windows computer that runs diagnostics. 
The IP address and port number identify the computer. 

Select Message Routing to access the following dialog boxes:
• Remote Log
• FactoryTalk View Diagnostics List

Each dialog box shows a list of message that can be sent to a destination. Cursor to a 
message, then select On/Off to enable or disable the message. Messages with selected boxes 
are enabled. Messages with cleared boxes are disabled. 

Audit Message Logging lets you log messages as Audit or Information.

To access Remote Log or Message Routing setup, select the node then select Edit.

Field Description Valid Values

Address IP address of the remote Windows computer. xxx.xxx.xxx.xxx

Port The port that is used to communicate with the remote Windows computer. 4445 (default)
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Check Integrity of 
Application Files

It is good practice to periodically check the integrity of the .mer application that is loaded in 
the terminal and the runtime files. Errors, warnings, and information messages are logged to a 
file. You can view the log and clear items from the log. 

1. Select Terminal Settings, then choose File Integrity Check.

2. Select either of the Enable options to disable integrity checks of the .mer application or 
the runtime files.

Integrity checks are automatically performed on the application .mer file and 
runtime files. If you disable either of these functions, the files are not selected and 
the log file is not updated.

3. To save changes, select OK.

To view the log generated by runtime files, follow these steps.
1. Select View Log from the File Integrity Check dialog box.

2. To display details for that event, select an event, then select More Details.
3. To clear all details from the log, select Clear All.
4. To return to previous dialog box, select Close.

Runtime files allow applications to run on the terminal. If the terminal is not 
functioning correctly, a review of the logs can identify an error in a runtime file.
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View and Clear the System 
Event Log

Note: The following information applies to PanelView Plus 7 Performance Series A terminals. 
For Series B terminals (Series C for Stainless Steel terminals), the Control Panel contains the 
System Event Log.

The System Event Log displays warnings, errors, and events logged by the terminal. The log 
provides a time stamp of when each event occurred and a description of the event. If the 
event log is full when a new event occurs, the oldest entry is removed to accommodate the 
new event.

1. Select Terminal Settings > System Event Log.
2. To display details for the event, select an event, then select More Details.
3. Select Clear All clear all events in the log.
4. Select Close.

Enable or Disable the Alarm 
Display

The terminal displays each alarm as it occurs in the alarm display or alarm banner. When the 
operator acknowledges the most recent alarm, the alarm display closes or remains open. The 
default is to close the alarm display. 

1. Select Terminal Settings, then choose Alarms.

2. Select “Close Alarm Display When Newest Alarm Acknowledged” to toggle between Yes 
or No. 
- Yes closes the alarm display when the newest alarm is acknowledged.
- No leaves the alarm display open when the newest alarm is acknowledged. 

3. Select OK.
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Display System Information You can view terminal and firmware revision information for software that is installed on a 
terminal.

View Terminal Information

You can view the following read-only information:
• Total power on time in minutes
• Processor temperature
• Battery voltage and state
• Memory that is allocated and used
• Random access memory (RAM) memory usage during runtime

To view the status information for your terminal, follow these steps.
1. Select Terminal Settings, then choose System Information > Terminal Information.

.

Processor temperature must be less than 90 °C (194 °F).

Battery voltage must be at least 2.75V DC.

IMPORTANT Over-temperature messages are recorded in the system event 
log:
• 85 °C (185 °F) issues a warning message.
• 90 °C (194 °F) issues an error message.

Battery State Description
GOOD Good battery condition.
FAILING Low battery. Replace the battery.
BAD Battery is missing or bad. Replace the battery.
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2. To view information about storage RAM, program RAM, and available nonvolatile 
memory, select Memory Allocation.

3. To return to the previous dialog box, select Close.
4. To troubleshoot anomalies by showing RAM used by the application at runtime, select 

Runtime RAM Usage.

5. To return to the previous dialog, select OK.
6. Select Close until you return to terminal settings.
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View FactoryTalk View ME Station Information

You can view firmware and version information for components that are installed on your 
terminal and access technical support information.

1. Select Terminal Settings, then choose System Information > About FactoryTalk View ME 
Station.

2. To display the support telephone number and website, select Technical Support.
3. Select Close until you return to terminal settings.
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Time and Date Settings You can change the date, time, time zone, and regional settings for terminal operations.

Change the Time Zone on Terminal

You can view or modify the current time zone on the terminal. Time zones are installed with 
the operating system. Changing the time zone adjusts the current time and date to match the 
time zone.

The clock in the terminal records the time when files are created or modified on the terminal. 
You can change the time and time zone of the clock.

1. Select Terminal Settings, then choose Time/Date/Regional Settings > Time Zone.

2. To select a time zone, use the up or down cursor.
Daylight Saving Time is enabled for all time zones except Japanese, which does not, 
support daylight savings. The clock is adjusted automatically when Daylight Saving 
Time changes. 

3. Optionally, select Daylight Savings to enable or disable Daylight Saving Time for a time 
zone.

Changes are not permanent until you close the Time Zone dialog box.
4. Select Close when done.
5. To return to the previous dialog box, select OK.

Set the time zone before you change the current date and time on the terminal.
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Change the Current Date on Terminal

To adjust the date on the terminal, follow these steps.
1. Select Terminal Settings, then choose Time/Date/Regional Settings > Date.

2. To change the current values above the button, select Year, Month, and Day:
- Year is four digits in the range 1980…2099
- Month is in the range 1…12
- Day is in the range 1…31 and validated by month

3. Select OK when done.

Change the Current Time on the Terminal

To adjust the time on the terminal, follow these steps.
1. Select Terminal Settings, then choose Time/Date/Regional Settings > Time.

2. To change the current values, select Hour, Minute, and Seconds:
- Hour range is 0…23 (24-hour format)
- Minute and second range is 0…59

3. Select OK when done.
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Regional Settings You can change the format to display dates, times, and numerics to match the standards of a 
country or region. Languages are installed with the operating system. Before changing 
regional settings, you must select a language.

To select a language that is installed on the terminal, follow these steps.
1. Select Terminal Settings, then choose Time/Date/Regional Settings > Language.

2. To select a language, use the up and down cursors.
3. Press OK.

The selected language shows under Current Language on the Regional Settings dialog 
box.

Change the Decimal Separator

You can change the decimal separator that is used in numeric formats for the selected 
language. The default separator is a period.

1. Select Terminal Settings, then choose Time/Date/Regional Settings > Numeric Format.

The default separator is shown.
2. Enter a maximum of three characters for the new separator.
3. Select OK.
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Change the Time Format for a Language

To change the format of the time for the selected language, follow these steps.
1. Select Terminal Settings, then choose Time/Date/Regional Settings > Time Format.

The current time appears in the selected format.
2. To adjust the formats, make the appropriate selections.

The sample format changes as you make selections.

3. Select OK.

Field Description Example

Time Format
12 hour

h:mm:ss tt (default)
h = 12-hour time display, no leading zero
tt = AM or PM symbol

7:23:02 AM or 1:13:31 PM
11:43:59 AM

hh:mm:ss tt
hh = 12-hour time display with leading zero
tt = AM or PM symbol

07:23:02 AM or 01:13:31 PM
11:43:59 PM

Time Format
24 hour

H:mm:ss
H = 24-hour time display, no leading zero

7:03:42 or 1:13:32
23:43:59

HH:mm:ss
HH = 24-hour time display with leading zero

07:03:42 or 01:13:22
23:43:59

AM Symbol
Characters to indicate AM. If the time format is set to a 
12-hour time display (h:mm:ss tt or hh:mm:ss tt), you can 
modify the AM symbol. 

AM (default)
12 character max

PM Symbol
Characters to indicate PM. If the time format is set to a 
12-hour time display (h:mm:ss tt or hh:mm:ss tt), you can 
modify the PM symbol. 

PM (default)
12 character max

Separator Characters that separate fields in time format. : (default)
3 character max
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Change the Short Date Format for a Language

To change the short date format for the selected language, follow these steps.
1. Select Terminal Settings, then choose Time/Date/Regional Settings > Short Date 

Format.

2. To change the short date format, select Format.
The date updates in the Sample area as you make changes.

3. To change the character between date elements, select Separator.
The separator can be three characters. The default separator is – or /. 

4. Select OK when done.

Change the Long Date Format for a Language

To change the long date format for the selected language, follow these steps.
1. Select Terminal Settings, then choose Time/Date/Regional Settings > Long Date Format.

2. To change the long date format, select Format.
The date updates in the Sample area as you make changes.

3. Select OK when done.
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KEPServer Driver 
Configuration (Series B 
Only)(1)

The PanelView Plus 7 Performance Series B terminals (Series C for Stainless Steel terminals) 
allow you to select a KEPServer driver.

1. Select Terminal Settings.

2. In the Terminal Settings dialog box, select Networks and Communications.

(1) (Series C for Stainless Steel terminals)
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3. In the Networks and Communications dialog box, select KEPServer Driver Configuration.

4. Use the arrow keys to highlight the desired drivers, and then select the On/Off button to 
select the drivers. 

5. Select OK when you are finished. 

6. Select Yes and Restart your computer.

IMPORTANT A terminal reset is necessary for the settings to take effect.
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Certificate Management 
(Series B Only)(1)

The PanelView Plus 7 Performance Series B terminals (Series C for Stainless Steel terminals) 
allow you to import and update certificates for your terminal.

Before you can use the Certificate Import tool, you must copy the certificates to the 
Certificates folder by. You can do this by using Control Panel > Explore > File Explorer.

After you copy the certificates to the Certificates folder, complete the following steps to copy 
the certificates to your terminal.

1. Select Terminal Setting, and then select Certificates Management.

2. In the Certificates dialog box, select the certificate in the list, and then select the Import 
button.
The certificates are imported to your PanelView terminal.

(1) (Series C for Stainless Steel terminals)
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Series A Terminals with Windows CE OS 
Operating System Features The PanelView™ Plus 7 Performance terminals run the Microsoft Windows® CE 6.0 operating 

system (OS) providing the following features:
• Command shell
• Command processor
• Console window
• Windows® Explorer shell
• Common dialog box
• Control panel
• Network user interface
• Soft keyboard input panels
• PDF reader
• Mouse and touch screen support with right-click support.

• VNC server and client viewer

Application Support

The Windows CE operating system supports these applications:
• .NET Compact Framework, version 3.5 or later
• C++ libraries and runtimes 
• Component services DCOM/COM/OLE
• Message queuing MSMQ
• MSXML, version 3.0 or later
• Microsoft® foundation classes (MFC) for devices, version 9.0 or later
• Active template library (ATL)
• ActiveSync
• Cabinet (CAB) file installer/uninstaller
• ToolHelp application programming interface (API)
• Error reports (generator, transfer driver, control panel)

Scripting Support

The Windows CE operating system supports these scripting features:

Touch the screen for 1 second or longer for a right-click.

IMPORTANT The platform distributes two VNC client viewers:
• Vncviewer.exe is in the /Windows folder on the terminal desktop. 

You can deploy this viewer to a personal computer to connect, 
view, and control a PanelView Plus 7 Performance terminal.

• Another viewer on the terminal lets you establish a VNC 
connection between two PanelView Plus 7 Performance 
terminals. To access this viewer, choose Start > Programs > VNC 
Viewer.
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• Batch/Command (BAT and Cmd files)
• CS-Script
• JScript

Network Support

The Windows CE 6.0 operating system supports these network features:
• Winsock support
• Network utilities - ipconfig, ping, route
• Network Driver Architecture (NDIS)
• Windows Networking API/Redirector
• Wired Local Area Network, 802.3, 802.5

Server Support

The Windows CE 6.0 operating system supports these servers.

Extended Features

The PanelView Plus 7 Performance terminals support these additional desktop applications 
that are not available on the PanelView Plus 7 Standard terminals.

Table 23 - Windows CE 6.0 Server Support

Server Default State Description

Web server Enabled The web server delivers content, such as webpages, by using the HTTP protocol 
over the web. 

FTP server Enabled File Transfer Protocol (FTP) is a standard network protocol for exchanging files 
over the Internet (TCP/IP-based network). 

UPnP server Enabled Universal Plug and Play (UPnP) is a set of networking protocols that lets devices 
install and connect to a network.

File Server Disabled A network protocol that provides shared access to files, printers, serial ports, 
and miscellaneous communication between computers on a network.

VNC server Disabled
Virtual Network Computing (VNC) is a graphical desktop sharing system that you 
can use to remotely control another computer. It transmits keyboard/mouse 
events from one computer to another, over a network.

ViewPoint Server Enabled
A web server application that provides remote user access via a web browser to 
the FactoryTalk® View Machine Edition HMI application that is running on the 
terminal. ViewPoint software is a Rockwell Automation product.

Table 24 - Operating System with Extended Features

Icon Software Icon Software

Microsoft Internet Explorer 6 web browser 
with Silverlight 2 Microsoft Office 2003 PowerPoint file viewer 

– Adobe Flash Lite 3.1
ActiveX plug-in for Internet Explorer 6 Microsoft Office 2003 Word file viewer 

Microsoft Remote Desktop Connection Microsoft Office 2003 Excel® file viewer 

Microsoft media player 6.4 and 7.0 OCX – Westtek JETCET PDF viewer 

Microsoft WordPad text editor – Image viewer
104 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 4          Series A Terminals with Windows CE OS
Windows Explorer Use one of these methods to access Windows Explorer from the desktop:
• Open the My Device icon.
• Choose Start > Programs > Windows Explorer.

A few folders contain items specific to the PanelView Plus 7 Performance platform.

Taskbar From the taskbar, you can access the Start menu, device IP information, the current language 
and time, input panels, and open programs.

To turn the taskbar on or off, follow these steps:
1. Choose Start > Settings > Taskbar > Start Menu.
2. Clear or check the Auto Hide checkbox.

Soft Input Panels The operating system offers different input panels for entering data. You can access the input 
panels from the taskbar or the control panel. From the taskbar, select the input panel icon and 
choose the input panel (keyboard) that you want to use:

• CHT Chajei IM (Chinese)
• CHT Phonetic IM (Chinese)
• Keyboard (small keyboard)
• LargeKB (large keyboard)
• MS Kana IM (Japanese)
• MS Roma IM (Japanese)
• Hide Input Panel (closes the keyboard)

Folder Content

Application Data Contains FactoryTalk View Machine Edition application files.
Path: \Application Data\Rockwell Software\RSViewME

VFS (Virtual File System) Contains firmware files and backup/restore files for the current system image. 
Path: \VFS\Platform Firmware

On touch screen terminals, touch the bottom of the display to recover the 
taskbar when in Auto Hide mode.

The input panel icon changes depending on which input panel you select.
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Windows Control Panel Applications in the Windows control panel let you view and configure system and terminal 
settings. For example, you can monitor hardware performance, perform a touch screen 
calibration, or adjust screen saver settings.

The language of the control panel applications is based on the language set for the operating 
system. English is the default.

Use one of these methods to access the control panel:
• Choose Start > Settings > Control Panel.
• Open My Device on the desktop, then double-click Control Panel. 

This section covers control panel applications specific to the terminal.

Most terminal settings are also available in FactoryTalk View ME Station 
Configuration mode.

From the View menu, you can change the size of the icons or see a brief 
description of each.

Many control panel applications have scroll bars to allow you to view information 
on smaller displays.
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Backup and Restore The Backup and Restore application lets you back up the current system image on the 
terminal, then restore that image to the same terminal or other HMI devices. This function is 
useful if you want to copy the same system image to multiple HMI devices. 

A typical backup image includes the following items:
• File system
• Firmware image
• Windows registry
• Optional user configuration data

To include user configuration data in the backup image, select Advanced Network & Display 
Settings in the Backup & Restore dialog box.

Perform a Backup

To perform a backup, follow these steps.
1. Insert a USB drive or SD card into the appropriate slot on the terminal.
2. In the control panel, double-click the Backup & Restore icon.

3. To browse for a backup location, select ... on the Backup tab.

You can back up a system image to a USB drive or SD card. Rockwell Automation 
recommends using a USB drive or SD card with a minimum of 1 GB of available 
space. For applications with a large file system, use a minimum of 2 GB of 
available space.

Table 25 - Advanced Network Display Settings

Setting Description

Ethernet Network

• DHCP-enabled or fixed IP address
• Primary and secondary DNS
• Primary and secondary WNS
• Speed and duplex settings

USB network USB IP address and subnet mask, Gateway, DHCP-enabled or fixed IP address
Network Device name

Display • Display brightness
• Screen saver dimmer timeout
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4. Select the target location for the backup file:
- USB Storage if you use a USB drive
- Storage Card2 if you use an SD card
- Target folder if you back up the file to the terminal

5. Enter a name for the backup file. 
Backup files have the .pvb file type.

6. Select OK.

7. Select Backup to start the process.
A progress bar shows the status of the operation. The backup can take a few minutes. 
You receive notification when the backup completes.

8. Select OK.
If a file exists, you are asked if you want to overwrite the current file.

9. To close the Backup & Restore dialog box, select Exit.

To verify the .pvb file was successfully created, double-click My Device and select 
the target location for the backup. If the .pvb file was not successfully created, 
use a USB drive or SD card with more available space.
Rockwell Automation recommends using a USB drive or SD card with a minimum of 
1 GB of available space. For applications with a large file system, use a minimum of 
2 GB of available space.
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Restore a Backup Image

To restore or clone a backup image to a storage device, follow these steps.
1. Insert the USB drive or SD card into the appropriate slot of the target device.
2. In the control panel, double-click Backup & Restore.

3. Select the Restore tab.
4. To select the backup file to restore, select ...

5. Select the location of the backup file:
- USB Storage if you use a USB drive
- StorageCard2 if you use an SD card

6. Select the .pvb backup file that you want to restore.
7. Select OK.

8. Select Restore.
The restore includes advanced network and display settings if you selected this option 
when performing the backup.
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9. To start the restore, select Yes.
The terminal starts the restore process, which takes few minutes.

When the restore completes successfully, the terminal restarts.

IMPORTANT Do not remove the USB drive, SD card, or power off the terminal during a 
restore. These actions can corrupt the firmware.
If the restore fails, reset the terminal from the maintenance menu.
See Maintenance Mode Operations — Series A Terminals on page 196 for 
details.
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Display Properties Use Display Properties to control the desktop background image and appearance, the 
brightness of the backlight, and screen saver settings.

Desktop Background

The Background tab in Display Properties controls the background bitmap on the desktop. The 
default bitmap is ‘abclocknight’.

You can select another image from the dropdown menu or browse the system for a bitmap 
image. Custom images are in the \Windows folder.

Desktop Appearance

The Appearance tab in Display Properties controls the visual style and colors of the desktop 
and other window elements.

Two custom schemes and images provide for day or night viewing. When you change schemes, 
you must also change the image on the background tab.

Backlight Intensity

You can adjust the intensity of the backlight in 10% increments from 0…100%. At 0%, the 
backlight is minimally visible. 

Table 26 - 

Scheme Desktop Color Background Logo
AB Day Blue abclocknight
AB Night Black ablclockday
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Screen Saver

The screen saver extends the life of the display. When the terminal is idle for a continuous 
period, the screen saver dims the backlight and displays a moving image. When deactivated, 
the display brightness returns to its normal level.

The Screen Saver tab in Display Properties lets you perform these actions:
• Change the idle timeout for the screen saver. The default is 10 minutes.

When the screen saver activates, the dimmer controls the backlight intensity. You set 
the brightness of the dimmer in range 0…100%. The default intensity is 10%. At 0%, the 
backlight is minimally visible.

• Browse the system for another screen saver bitmap. The default screen saver is 
SSFloat.bmp. Select Add or Remove to change screen saver bitmap. The system 
recognizes bitmaps in the \Windows folder.

• Disable the screen saver by clearing the ‘Start screen saver after’ checkbox.

Cursor

The Advanced tab in Display Properties lets you enable or disable the visible cursor that you 
see on the display. The cursor is visible by default.

Screen Rotation

The Advanced tab in Display Properties lets you rotate the screen on the terminal. The default 
is 0°.

After you change the screen rotation, you have to calibrate the Touch Screen.
1. Plug in a USB mouse to the terminal.
2. Restart the terminal.
3. Use the mouse to calibrate the Touch Screen.
4. See Calibrate the Touch Screen on page 83 for calibration details.
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Hardware Monitor The Hardware Monitor provides continuous voltage, and temperature, load information for the 
terminal.

Processes

The Processes tab in the Hardware Monitor shows all processes that are running on the 
terminal, and the memory usage of each process.

System Event Log

The System Event Log in the Hardware Monitor shows warnings, errors, events, and 
information.

The log provides a date and time stamp of each event, and text that describes the event. The 
maximum size of the log is 1 MB, approximately 4000 records. If the log exceeds 1 MB, the 
oldest 512K of information is removed. You can perform these operations on the log file:

• Select Export Log to export the log file to a CSV file (*.csv) in the \Windows folder. The 
default file name is SystemLog.csv.

• To clear all events from the log, select Clear Log.
• To view more details on a selected event, select Details.
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Monitors

The Monitors tab in the Hardware Monitor provides continuous voltage, temperature, and load 
information for the terminal.

Battery Voltage

The Monitors tab gives a visual status and voltage reading of the battery for the real-time 
clock. The battery voltage updates at powerup, then every hour. 

An event is logged to the system event log for a low or depleted battery.

Temperatures

The Monitors tab gives a visual status and reading of the current temperature of the logic 
board. The temperature updates every ten minutes.

An event is logged to the system event log for a failed temperature sensor.

Table 27 - Battery Conditions

Condition Battery
Depleted Less than 2.0V indicates a dead battery or no power.
Low 2.0…2.74V
Normal 2.75V or higher

Table 28 - Temperature Conditions

Condition Logic Board
Low –
Normal 25…94 °C (77…201 °F)
High 95 °C (203 °F) and higher

IMPORTANT A high temperature condition causes an automatic restart attempt. 
Restart attempts continue indefinitely until the system is cool enough 
to resume normal operation. High temperature conditions are logged to 
the system event log.
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Logo Manager Use the Logo Manager to change the logo that appears on the splash screen at startup and the 
default screen saver image. The default splash-screen image is the Allen-Bradley logo 
(ablogo.bmp).

The logo can be a .bmp, .jpg, .gif, or .png image. A 90 x 90 pixel, 16-bit color image provides a 
good result.

Before applying the new logo, you can do the following:
• Preview the logo on the splash screen.
• Resize image to fit the fixed area of the splash screen.

To apply a new logo the splash screen and the screen saver, follow these steps.
1. Double-click Logo Manager in the control panel.

The Logo Manager opens with the current logo.

2. Select Load.

3. Select the location of the new image you want to load:
- A folder on the terminal.
- Storage Card2 - SD card
- USB Storage - USB drive

4. Select the image file to load.
5. Verify that the file type is correct.
6. Select OK.
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The new logo appears in the Logo Manager dialog box.

7. Check ‘Preview entire screen’ to view the logo on the splash screen.
If the logo is truncated or too small, check ‘Stretch/shrink image to fit’ to resize the logo 
to fit the area.

8. If satisfied with the preview, select Apply.
A dialog box confirms that the splash screen was updated. The default screen saver, 
ssfloat.bmp, is updated with the new image.

9. Select OK, then select Exit to close the Logo Manager.

User Accounts User Accounts let you create NT LAN manager (NTLM) user accounts to authenticate client 
connections when using the FTP, web, and file servers. A user account consists of a user name 
and a password.

To add a user account, follow these steps.
1. Double-click User Accounts in the control panel.

2. In the User Name field, enter a name.
3. In the Password field, enter a password to replace the default value.

Asterisks display as you enter the new password.
4. In the Confirm pwd field, reenter the new password.

NTLM is the security protocol that provides authentication, integrity, and 
confidentiality to users on Windows operating systems. NTLM is still included to 
support Windows 2000, 2002, and 2003 server systems.
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5. Select Add User.

6. Select OK to acknowledge the new user account.

The new user name is added to the list.

7. Repeat steps 1 through 6 to add additional user accounts.
8. When done, select X to close the dialog box.

To remove a user account, follow these steps.
1. Select a name from the user name list.

2. Select Remove User.
3. To confirm the removal of the selected user account, select Yes.

The user account list is permanently deleted from the list.
4. To close the User Account Manager, select X.

Users who are entered in authentication lists of FTP, web, or file server 
configurations are removed when user accounts are deleted.
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Services The Services application shows servers the PanelView Plus 7 Performance platform supports. 
You can enable (start) or disable (stop) each server. 

The buttons are color-coded:
• Green indicates that the server is running and automatically started at system startup.
• Red indicates that the server is not running.
• Gray indicates that the server is not available on the platform.

To enable or disable a server, select the corresponding button and the color changes 
accordingly.

Network Server 
Configuration

The Network Server Configuration application configures settings for VNC, FTP, web, 
Kepware®, and file server activities on an Ethernet network.

VNC Server Configuration

The terminal provides two VNC client viewers:
• Vncviewer.exe is in the /Windows folder on the terminal desktop. You can deploy this 

viewer to a personal computer to connect, view, and control a PanelView Plus 7 
terminal. See these sections for details:
- VNC Connection Requiring a Password for View-only Operations on page 120
- VNC Connection with Separate Passwords for View and Control Operations on 

page 121
• Another viewer on the terminal lets you establish a VNC connection to another 

PanelView Plus 7 terminal. To access this viewer, select Start > Programs > VNC Viewer. 
See these sections for details:
- Establish a VNC Connection Between a Local Terminal and a Remote Terminal on 

page 123
- Close a VNC Connection to a Remote Terminal on page 124
- Make a New VNC Connection to a Remote Terminal on page 124
- Transfer Files Between a Local and a Remote Terminal on page 125

The VNC Server tab in the Network Server Configuration dialog box configures settings for a 
client device to view or control the terminal over a VNC connection. 

Select OK in the title bar of the dialog box to apply new settings. You are asked if 
you want to restart the service immediately.
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Table 29 - VNC Server Parameters

VNC Parameter Description Default
General

View Only (no remote control)

Select this option to let users view terminal displays over a 
VNC connection.
If you clear View Only, users can control and view terminal 
displays over a VNC connection.
If security is disabled, users are not required to enter a 
password when connecting to the terminal.

Enabled for view only

Security

Enable security

Check this option to require password protection for VNC 
connections to the terminal. Users must enter a valid 
password before viewing or controlling terminal displays.
If you enable security, you must supply a password for one 
of these parameters:
• Password - for control and view operations
• View-only password - for view only operations

Disabled (cleared)

Password

Specifies a password that a user must enter when 
establishing a VNC connection to control terminal displays. 
Select the box, then enter a password in the field at the 
bottom of the dialog box. The password is a maximum of 
seven characters.
Password protection is required to control terminal 
displays if:
• View Only is cleared (allows control access)
• Security is enabled

No password

View-only password

Specifies a password that a user must enter when 
establishing a VNC connection to view terminal displays. 
Select the box, then enter a password in the field at the 
bottom of the dialog box. The password is a maximum of 
seven characters.
TIP: If you clear the View Only parameter, you have control 
and view access to the terminal. With control access 
enabled, you can restrict one or more users to view-only 
access by providing a View-only password. 
View-only password protection is required to view terminal 
displays if security is enabled:
• View Only is selected or cleared
• Security is enabled

No password
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VNC Connection Requiring a Password for View-only Operations

The default VNC configuration enables view-only access to the terminal without requiring a 
password. This configuration requires the VNC viewer that you copy from your terminal to a 
computer. 

To configure a VNC connection that requires a password to view terminal displays, follow 
these steps.

1. From the control panel, select Server Config.

2. On the VNC Server tab, check these items:
- View only (no remote control)
- Enable security

3. Select View-only password, then enter a seven-character password in the field that 
opens.

4. Select OK
5. Restart the server when prompted to apply new settings.

To launch a VNC connection to view terminal operations, follow these steps.
1. On your computer, choose Start > Programs > TightVNC > TightVNC Viewer.

2. Enter the IP address of your terminal and select Connect.

3. Enter the View-only password that is defined on the terminal and select OK.
The PanelView VNC Server opens the current view of the terminal on your desktop. You 
can view but not control terminal operations.

4. When finished, close the PanelView VNC Server.

Copy vncviewer.exe, in the /Windows folder on the terminal, to your computer and 
install the TightVNC software.

Select the network connection icon in the system tray to view the IP 
address of the terminal.
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VNC Connection with Separate Passwords for View and Control Operations

You can configure the VNC server to require separate passwords for view-only and control 
operations. This example uses the VNC viewer that is deployed to a computer to connect to the 
terminal.

To configure the VNC server to require a separate password for view-only and control 
operations, follow these steps.

1. From the control panel, select Server Config.

2. On the VNC Server tab, do the following:
- Clear View only (no remote control).
- Check Enable security.

3. Select Password, then enter a password for control privileges.
Passwords are a maximum of seven characters.

4. Select View-only password, then enter a password for view-only privileges.
5. Select OK, then restart the service when prompted to apply new settings.

Copy vncviewer.exe, in the /Windows folder on the terminal, to your computer and 
install the TightVNC software.
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To launch a VNC connection to enable control of the terminal, follow these steps.

1. On your computer, choose Start > Programs > TightVNC > TightVNC Viewer.

2. Select Options.

3. Clear View only (inputs ignored).
4. Select OK.

5. Enter the IP address of your terminal and select Connect.

The Standard VNC Authentication dialog box opens.

6. Enter the control password that is defined on the terminal and select OK.
7. On your computer, perform some actions to verify that you have control of the terminal.
8. When finished, close the PanelView VNC Server.

To launch a VNC connection on your computer that requires a password for view-
only operations, see VNC Connection Requiring a Password for View-only 
Operations on page 120 and follow steps 1 through 4.

Select the network connection icon in the system tray to view the IP address of the terminal.
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Establish a VNC Connection Between a Local Terminal and a Remote Terminal

To establish a VNC connection from a local terminal to a remote terminal, follow these steps.
1. Access the Windows desktop of the local terminal.
2. On the local terminal (viewer) desktop, choose Start > Programs > VNC Viewer.

3. Enter the IP address of the remote terminal that you want to connect to and select 
Connect.

A Status message displays while the connection is being made. The messages can cycle 
as the status changes.

The message ‘Please wait - initial screen loading’ can also display after the connection 
has been made and while the desktop of the remote terminal is loading.
After the screen has loaded, the desktop of the remote terminal displays on the local 
terminal. You can now access the features and functions of the remote terminal. 

Select an IP address from the dropdown menu, or enter an IP address by 
using a USB keyboard or soft input panel (see Soft Input Panels on 
page 105).

The white dotted line indicates the remote terminal and is only for reference (the dotted 
line does not actually appear on the local terminal).
Note the two Start buttons: circled in white is the remote terminal; circled in black is the 
local terminal.
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Close a VNC Connection to a Remote Terminal

To close a VNC connection between a local terminal and a remote terminal, follow these steps.
1. Establish a VNC connection from a local terminal to a remote terminal (see page 123).
2. On the local terminal, right-click PanelView VNC Server.

3. Select Close.
The VNC connection to the remote terminal is closed.

Make a New VNC Connection to a Remote Terminal

To make a new VNC connection to another terminal, follow these steps.
1. Establish a VNC connection from a local terminal to a remote terminal (see page 123).
2. Select the New connection icon in the menu bar.

3. Enter the IP address of the new remote terminal that you want to connect to and select 
Connect.

The local terminal creates a VNC connection to the new terminal.

Touch the screen for 1 second or longer for a right-click.

Select PanelView VNC Server to toggle between the remote terminal (server) 
and local terminal (viewer) views.

Select an IP address from the dropdown menu, or enter an IP address by 
using a USB keyboard or soft input panel on the local terminal (viewer) (see 
Soft Input Panels on page 105).

Remote Terminal

Local Terminal
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Transfer Files Between a Local and a Remote Terminal

You can perform these tasks with the TightVNC File Transfer dialog box:
• Transfer files and folders between connected terminals
• Rename a selected file or folder
• Create a folder
• Delete a selected file or folder

To transfer files between the local terminal and the remote terminal, follow these steps.
1. Establish a VNC connection from a local terminal to a remote terminal (see page 123).
2. Select the Transfer files icon in the menu bar.
3. Select the folder or files that you want to transfer.
4. Select the upload (>>) or download (<<) files icon.
5. Select Yes.
6. Select Refresh to view the change (in needed).

Download selected files from the remote 
terminal to the local terminal.

Upload selected files from the local terminal 
to the remote terminal.

Indicates the current 
directory level.

Double-click the arrow to move 
up one directory level.

Message field that records 
actions and errors for the 
current VNC session.

Rename = opens a dialog box where you can rename the selected file or folder.
Mkdir = lets you create a folder.
Remove = deletes the selected file or folder.
Refresh = updates the view.
Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024 125



Chapter 4          Series A Terminals with Windows CE OS
Web Server Configuration

The web server tab in the Network Server Configuration application configures settings that 
are used for HTTP web activities. These parameters are standard Microsoft Windows CE 
parameters.

FTP Server Configuration

The FTP Server tab in Network Server Configuration defines settings that are used to exchange 
files over a network. These parameters are standard Microsoft Windows CE parameters.

Select OK in the title bar of the dialog box to apply new settings. You are asked if 
you want to restart the service immediately.

Table 30 - Web Server Parameters

Parameter Description Default

Admin Users

Specifies a list of users who are allowed to administer web 
activities. 
When selected, enter a list of user names, which are separated 
by semicolons, in the field that opens at the bottom of the 
dialog box.

ADMIN

Basic Authentication Check this option to require a user name and password to 
access the web server. Disabled (cleared)

Default Web Page Specifies default webpages that users can access. default.htm; index.htm

Allow Directory Browsing Check this option to let users browse directories on a web 
server. Disabled (cleared)

Max Connections Specifies the maximum number of incoming web connections. 256

Log File Directory Specifies the path where the log file is stored. This file logs web 
activity. \windows\www

Max Log Size
Specifies the maximum size of the log file that is stored in the 
log file directory.
A new log file is created, when the current log file reaches its 
maximum size. 

32768 bytes

NTLM Authentication 

Check this option to require a valid user name and password to 
access the web server.
If NTLM Authentication is enabled, you must enter a valid user 
name in the Admin Users field. 
NTLM user accounts are defined in the User Account Manager of 
the control panel.

Enabled (selected)

Select OK in the title bar of the dialog box to apply new settings. You are asked if 
you want to restart the service immediately.
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FTP Anonymous Login and Upload

With the default FTP security options, you can log on anonymously to the terminal and copy 
files between your computer and the default FTP folder on the terminal. 

To establish an FTP connection to the terminal by using anonymous logins and file transfers to 
and from the FTP folder, follow these steps. 

1. On your computer, open the web browser or any folder.
2. To determine the IP address of your terminal, select the Network Connection icon in the 

system tray.
3. Enter the terminal IP address in the address field. 

Table 31 - FTP Server Parameters

FTP Parameters Description Default
General 

Default Directory Specifies a storage location on the terminal where users can transfer files. 
The directory that users come to when they first connect to the FTP server. \Temp\

Idle Timeout
Specifies an idle period after which inactive control connections are closed during a data transfer. An FTP session 
requires one control connection, plus one data connection, during file transfers.
Without a timeout, the FTP server process can be left pending indefinitely if the corresponding client crashes without 
closing the control connection.

300 seconds 
(5 minutes)

Debug Output Channels Specifies the number of debug output channels. 2
Debug Output Mask Specifies the port number of the output mask that is used for debugging. 23
Base Directory Specifies the path where the FTP log file and other support files are stored. \Windows

Log Size Specifies the maximum size of the file that logs FTP activities. The log file is stored in the base directory. 
A new log file is created, when the current log file reaches its maximum size. 4096 bytes

Security Parameters

Use Authentication
Check this option to require a valid NTLM user name and password to access the FTP server.
If authentication is enabled, you must enter one or more valid user names in the User List field. 
NTLM user accounts are defined in the User Account Manager of the control panel.

Enabled (selected)

Allow Anonymous Logins Check this option to let anyone connect to the FTP server. Anonymous logins do not require a user name and password. Enabled (selected)

Allow Anonymous Uploads Check this option to let users logged on anonymously to upload (or write) files to the FTP server (or default directory).
If cleared, users that are logged on anonymously can download (or copy) files from the server. Disabled (cleared)

Allow Anonymous VRoots Check this option to let users who are logged on anonymously to access virtual roots. Disabled (cleared)

User List
Specifies the NTLM users that can access the FTP server and exchange files to or from the default directory.
When selected, you can enter a list of NTLM user names, which are separated by semicolons, in the field that opens at 
the bottom of the dialog box. User names and passwords are defined in the User Account Manager of the control panel.

None

If Allow Anonymous Uploads is cleared, you can copy files from the default FTP 
folder on the terminal but not to the folder.

EXAMPLE Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.
For example, ftp://192.168.124.96
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A connection is established to the \Temp folder, the default FTP directory on the 
terminal. The terminal shows two files.

If you launch the FTP connection from your web browser, this view can appear.

To see the folder view, choose Open FTP site in Windows Explorer from the Page dropdown 
menu.

4. Transfer files between your computer and the FTP folder on the terminal:
- Drag or copy a file from the FTP folder to your computer.
- Drag or copy a file from the computer to your FTP folder.

FTP Connection Requiring User Authentication

You can require a user name and password before establishing an FTP connection. On the FTP 
Server tab, check Use Authentication. Select User List and enter a valid user name in the field 
that opens at the bottom of tab.

To establish an FTP connection to the terminal by first entering a valid user name and 
password, follow these steps. 

1. On your computer, open any folder or the browser.
2. Determine the IP address of your terminal by selecting the Network Connection icon in 

the system tray.
3. Enter the terminal IP address in the Windows Explorer address field.

4. Select OK if the FTP Folder Error dialog box appears.
5. From the File menu, choose Login As.

You can create user names and passwords in the User Accounts application of the 
control panel. See User Accounts on page 116.

EXAMPLE Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.
For example, ftp://192.168.124.96
128 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 4          Series A Terminals with Windows CE OS
6. Enter a valid user name and password.

7. Select Log On. 

The default FTP directory on the terminal opens. You can transfer files to or from this 
folder.

File Server

The File Server tab in Network Server Configuration has settings that allow shared access to 
files, printers, serial ports, and miscellaneous communication between computers on a 
network. These parameters are standard Microsoft Windows CE parameters.

The user name must be in the User List of the FTP configuration and 
previously configured as a valid account in the User Accounts application. 

Select OK in the title bar of the dialog box to apply new settings. You are asked if 
you want to restart the service immediately.

Table 32 - File Server Configuration

Parameter Description Default
General
Adapter List Provides a list of valid adapters. * (all adapters)
Max Printer Swap Size Specifies the maximum size of the printer swap file. 4096 bytes
Security Options

Use Authentication

Check this option to require a valid NTLM user name and 
password to access the file server.
If authentication is enabled, you must enter one or more valid 
user names in the User List field. 
NTLM user accounts are defined in the User Account Manager 
of the control panel.

Disabled (cleared)

User List

Specifies a list of valid NTLM users who are allowed to access 
the file server. 
When selected, you can enter a list of NTLM user names, which 
are separated by semicolons, in the field that opens at the 
bottom of the dialog box. User names and passwords are 
defined in the User Account Manager of the control panel.

None
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KEPServer Configuration

The Kepware Server tab in Network Server Configuration lets you select Kepware 
communication drivers for connected devices.

For a complete list of Kepware drivers, go to the Knowledgebase Support Center at
rok.auto/knowledgebase and search the Knowledgebase for keywords ‘Kepware 
Drivers for PanelView Plus’.

IMPORTANT Select OK in the title bar to apply new settings. You are asked if you 
want to restart the service immediately. You must also restart the 
terminal.
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System Information The System Information application provides tabs to view and set system-wide properties for 
your terminal. 

General Information

The General tab of System Information shows the current version of the Windows CE operating 
system, the processor type, speed, and available memory.

Startup Options

The Startup Options tab of System Information lets you set these startup options:
• Show or hide the battery warning
• Launch the terminal as open or closed
• Configure the Ethernet ports for DLR, star, or linear topology
• Disable or enable Safe mode
• Show or hide system watchdog errors

Battery Warnings

If the battery is low, missing, or depleted, a warning appears 
each time that the terminal starts up.

You have three options for handling the battery.

• The terminal can operate without a battery if the accuracy of the 
date and time is not critical. 

• When replacing the battery, you can verify the accuracy of the 
system date and time from the desktop control panel or the 
terminal settings in FactoryTalk View ME Station.

Battery Warning 
Startup Options Description

Always show at startup 
(continue with startup)

Shows the battery warning at startup with 
FactoryTalk View ME Station software running 
behind it (default). 

Always show at startup 
(halt startup)

Shows the battery warning at startup but halts 
the startup or boot process until you select OK. 

Never show at startup Hides the battery warning at startup.
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Startup Options

Use the Shell options to launch an open or closed desktop at startup and set the visual 
appearance of button controls.

Boot Option

The boot options provide a way for you to enter Safe mode at startup.

Configure the Ethernet Ports

The ‘Network (On-board Embedded Ethernet Switch - DLR)’ provides options to configure the 
on-board Ethernet switch of the terminal for the network topology. You can also configure the 
Ethernet ports from the terminal menus. See Configure the Ethernet Ports on page 76.

After changing the selections, restart the terminal.

Shell Startup Options Description

Type

Launches the terminal as an open or closed system at startup:
• (Open system) – launches the Windows CE desktop on startup.
• (Closed system) (default) – launches FactoryTalk View ME Station Configuration mode 

on startup.
You can also allow or restrict desktop access within FactoryTalk View ME Station 
Configuration mode by selecting Terminal Settings > Desktop Access Setup. See Windows 
CE Desktop Access — Series A Terminals on page 66.

User Interface Button 
Controls

Sets the visual appearance of control buttons at startup:
• Windows XP Style (default)
• Windows 95 Style

Safe Mode Options Description
Do not detect Safe mode request at startup Disables Safe mode detection during startup (default).

Detect Safe mode request at startup

Displays a small white box in the lower left corner of the terminal 
display during startup. Select and hold the white box to enter Safe 
mode. Safe mode lets you bypass a loaded FactoryTalk View ME 
application and go directly to Configuration mode. If you do not 
select the white box, the system boots up normally.
Another way to enter Safe mode is to access Maintenance mode. 
See Maintenance Mode Operations — Series A Terminals on page 196.

Port (Link) Configuration Description
Port 1 (Link 1) and Port 2 (Link 2) Enabled Enables Link 1 and Link 2 Ethernet connections for DLR configuration.
Port 1 (Link 1) Only Enabled Enables Link 1 Ethernet connection for star or linear configuration.
Port 2 (Link 2) Only Enabled Enables Link 2 Ethernet connection for star or linear configuration.
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Watchdog Errors

You can show or hide watchdog errors at startup.

Advanced Diagnostics

Advanced diagnostics are for technical support that is used to diagnose and resolve system 
errors. They are not for use in a normal production environment.

Device Name

The Device Name tab of System Information identifies your terminal to other devices on the 
network by providing a device name and description.

Watchdog Error Options Description

Always show watchdog errors at startup 

Shows the fatal watchdog error (error 02) at startup and halts the 
normal boot process (default).
The system launches the maintenance window with the watchdog error 
displayed. You can continue booting from this window. See Maintenance 
Mode Operations — Series A Terminals on page 196 for details.
The error is logged to the System Event log.

Never show watchdog errors at startup Hides the errors at startup and adds the error to the system event log.

Device names must be unique. Duplicate names conflict and cause network 
problems.
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Touch Properties Touch Properties is accessible on devices with a touch screen. It lets you calibrate the touch 
screen and set the sensitivity of touch screen taps.

Calibration

The Calibration tab lets you recalibrate the touch screen if your device is not responding 
appropriately to taps. Follow the instructions in the dialog box to recalibrate.

Double-tap

The Double-Tap tab lets you set and test the double-tap sensitivity of the touch screen taps.
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PDF Reader The PDF reader provides typical view and search functions. You can run this reader from the 
Windows desktop or a command prompt.

When viewing a PDF document, you can initiate functions from the menu or toolbar. 
Bookmarks that are created in the original PDF appear under bookmarks.

Figure 8 - PDF Reader Workspace

Some viewing functions can be initiated on touch screen terminals by touching or dragging.

Page 
Navigation

Zoom 

Rotate

Search

Bookmarks Page Navigation
Slide BarOpen

Current Page 

Magnified view of page with minimap. You can 
touch the gray areas on the minimap to view 
another area of page at the same zoom level.

Prev/Next

3/32

Table 33 - Touch Screen Operations 

To Do This Indicator

Zoom In or Out
Tap the screen once to zoom in.
Tap the screen again to zoom out.
If Menu > View > Minimap is chosen, a miniview of the page appears in the lower 
right of workspace. You can tap the gray areas to change view.

Navigate pages

• Drag your stylus or finger to the right or left to view next and previous pages.
An indicator shows the direction you are dragging.
A box shows the current page/total page count.

• Drag up or down the screen to activate the page navigation bar on the right.
Move slide bar up or down to navigate pages.

See page 
navigation bar 
in Figure 8.

Rotate Drag in a circular, clockwise or counterclockwise direction to rotate the page.

3/32
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Command Prompt Parameters

To run the PDF reader from the Windows Command Prompt, choose Start > Programs > 
Command Prompt, and execute the command parameters in Table 34.

Command Prompt Syntax
Foxitreader “file_path\file-name.pdf” parameter parameter_ value
- Enclose the file path and file name in double quotes and use forward slashes to 

separate the file path directories and file name.
- Use spaces to separate the parameter from the file name and optional parameter 

value.

Command Prompt Example
Foxitreader “windows\desktop\example.pdf” -p 4
This command prompt opens example.pdf in Foxit Reader at page 4.

Table 34 - Command Prompt Parameters

Parameter Parameter Function Example Description
-p Go to page Foxitreader “file_path\file.pdf” -p 2 Opens the PDF file to page 2.
-zw Fit width Foxitreader “file_path\file.pdf” -zw Opens the PDF file and fits the view to the page width.
-zp Fit page Foxitreader “file.pdf”-zp Opens the PDF file and shows the full page.
-z Zoom to Foxitreader “file.pdf”-z 150 Opens the PDF file and zooms to 150%.
Multiple 
parameters

Enter empty spaces between 
parameters and parameter values Foxitreader “file_path\file.pdf” -p 2 -zw Opens the PDF file to page 2 and fits the view to the page width.

-b Go to bookmark Foxitreader “file_path\file.pdf” -b “Bookmark1” Opens the PDF file to the location specified within Bookmark1.
-d Go to named destination Foxitreader “file_path\file.pdf” -b “Destination1” Opens the PDF file to the location specified within Destination 1.

-g Disable the File > Open command on 
the Menu and the Open folder button. Foxitreader “file_path\file.pdf” -g Opens the PDF file and dims the Menu, File > Open command 

and the Open button.
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System Features The PanelView™ Plus 7 Performance Series B(1) terminals run the Windows® 10 IoT Core 

operating system (OS), which provides the following features:
• VNC Server 
• PDF reader
• SFTP Server
• Microsoft® Edge web browser
• FactoryTalk® ViewPoint
• Internet Printing Protocols (IPP)
• File Explorer

Windows Control Panel The following sections describe the functionality that is available from the Control Panel. To 
access the Control Panel, select Exit on the FactoryTalk View ME Station startup screen.

Menu Icons

The main Menu displays icons that allow you to configure various features of your PanelView 
Plus 7 Performance Series B terminal (Series C for Stainless Steel terminals).

(1) Series C for Stainless Steel terminals.
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Table 35 - Menu Icons

Icon Name Description

Menu

When selected, this button expands the menu bar. Displays the following menus 
that are available in the Control Panel:
• System
• Network and Wi-Fi
• Firmware Updates
• Power Options
• Touch
• Services
• Event Log

Start

Displays tiles for the following programs: 
• Web Browser
• Notifications
• File Explorer

Device Info

Displays the following information about your terminal:
• Device Name
• Network
• IP Address
• OS Version
• Platform Version
• Bootloader Version
• DLR Network Switch
• Connected Devices
The following Network information is displayed:
• IPv4
• Status

Web Browser Launches the web browser that you specified on the Menu Settings screen.

Account 
Management

Displays the Account Management page, which allows you to change your 
password.

Settings Displays the Menu Settings page, which allows you to set a default page, a web 
browser home page, and the size, color, and scaling of tiles.

Exit Closes the Control Panel and launches Machine Edition (ME).
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Navigation Icons

All screens that you access through the Control Panel display a navigation bar at the bottom of 
the screen.

Start Menu

The Start menu displays the applications available on the terminal.

Table 36 - Navigation Icons

Icon Description

Moves to the previous screen.

Moves to the next screen.

Moves to the top of the current screen.

Moves to the bottom of the current screen.

Displays the following information about your terminal:
• IP Address
• OS Version
• ControlPanels Version

Allows you to toggle between full screen view and partial screen view.

Displays a menu with the following options:
• Set Default Page
• Quick-Save Log
• Session Log
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Notifications page

File Explorer - Main Page 

The Folders section displays important folders that you may need to use. Selecting a folder 
displays its contents. The following folders are available:

• ME Apps—contains your runtime .mer files
• Temp—contains any temporary files that are generated as you work in PanelView
• Documents—contains document files such as PDFs, text files, etc. 
• Certificates—contains any certificates that you have acquired, for example, ViewPoint 

if you use HTTPS, or domain authentication if you use SSL

The Drives section displays a removable storage device (USB or SD card) that you plugged in to 
the terminal.

Table 37 - Start Menu Icons

Section Icon Description

Explore

Opens a web browser. See Web Browser Menu on page 143

Lists notifications that have occurred since the Control Panel started running (see 
Figure ). Exiting out of the Control Panel (by going to ME Station or by resetting the 
terminal) clears the list. The list is limited to 20 items.

Opens File Explorer, which can be used to view files on the device or copy/move files 
to and from the terminal to USB storage devices. Each page in File Explorer includes 
a close button (red button with white X) and an address bar. For more information, 
see the following illustrations:
• Figure  shows the main File Explorer page.
• Figure  shows the contents of a folder.
• Figure  shows an empty folder.
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File Explorer - Folder Contents

If you select on a folder, a list of its contents is displayed. Right-clicking a file displays a menu 
of common operations, such as Copy, Cut, or Rename. 

File Explorer - Empty Folder

Right-clicking inside a folder displays a menu of operations, such as Move, Sort by, or Refresh, 
that help you organize your folder. (The Open in Terminal is not functional at this release).

You must have a mouse plugged into the terminal to use these commands.

You must have a mouse plugged into the terminal to use these commands.
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Device Info Menu

The Device Info menu displays name, network, and version information about your PanelView 
terminal.

Table 38 - Device Info 

Field Description

Network 
Information

If the network cable is not plugged in, there is no information displayed here. If a network 
cable is plugged in, the following information is shown:
• IPv4—Displays the IPv4 address currently assigned to the terminal.
• Status—Displays the type of access available. Displays Local network access only or Local 

and Internet access, depending on the internet access availability.

Device Name
Displays the name that you entered for the device. This can be configured on the out of box 
first power up or in ME Station - Terminal Settings > Networks and Communications > 
Network Connections > Device Name. 

Network Displays Ethernet if connected to a network. If no connection is identified, it displays No 
Internet Connection. 

IP Address Displays the IP address that is currently assigned to the terminal. If the network cable is not 
plugged in, the IP Address displays as 0.0.0.0

OS Version Displays the Microsoft Windows® 10 IoT Core OS version.

Platform Version Displays the version of the bundled firmware from Rockwell Automation. The more… button 
displays a page that shows versions of additional components.

Copyright Info Displays the copyright year of the terminal. The more… button displays a complete copyright 
page.

Bootloader Version Displays the version of Bootloader that is loaded on the terminal.
DLR Network Switch 
Version Displays the firmware revision of the Device Level Ring Network Switch.

Connected Devices Displays the device name of any connected USB devices.
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Web Browser Menu

The web browser is a Microsoft Edge browser that supports HTML5. You can view webpages 
and PDFs by using this browser. The browser can also be used to view files stored locally on 
the terminal. The default home page can be set by going to Settings > Menu Settings > Web 
Browser > Home page. 

Loading Local Content

Local content can be loaded onto the terminal via File Explorer (launched from Windows 10 IoT 
Core Start Menu). Content must be copied over from external media (USB drive or SD card) to 
the "Web Content" folder on the Z drive. Sub folders under "Web Content" should not contain 
spaces in their names. It is recommended to have a mouse and keyboard connected to the 
terminal when loading content to make it easier to right click and rename files.

File Formats

The Microsoft Edge web browser included on PanelView Plus 7 Performance graphic terminals 
supports most file formats supported by modern HTML 5 web browsers.

The recommend formats for file types are:

Opening Local Content

Local content can be opened in the web browser by typing in the local file address into the 
address bar. The file address should consist of the prefix "ab-webcontent:///" followed by the 
file address from the Web Content folder. For example, a file located in "Z:\Web 
Content\LocalFileAccess\startpage.html" should be entered into the address bar as 
"ab-webcontent:///LocalFileAccess\startpage.html"

File Type Format
Text .html
Image .jpg, .png, .bmp, .svg, .gif
Video .mp4
Audio .mp3, .wav
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Account Management Menu

The administrator password is used to turn services on/off. The administrator password is 
also used for the Secure File Transfer Protocol (SFTP) and file server access. This password 
differs from the password that is used to exit ME station into the Control Panel (Desktop 
Access Password).

The initial administrator password is configured as a part of the out of box experience (OOBE). 
See step 11 on page 46 for this initial setup.

When changing the administrator password, the new password cannot be blank. It must be 
from 1 to 64 characters. There are no special character requirements; any special characters 
can be used if desired. We recommend these best practices for passwords to ensure they are 
as secure as possible.

Table 39 - Account Management Screen

Section Field Description

Administrator—Change 
Password

Old password This field is where you enter your current password.
New password This field is where you enter a new password.
Confirm new password This field is where you reenter the new password.
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Menu Settings Screen

The Menu Settings screen allows you to select which application page and home page you 
want to use as a default. This screen also allows you to set the size and color of the tiles that 
are displayed on the terminal.

Use the scroll bar at the right of the screen to view all available fields on this screen.

Table 40 - Menu Settings Screen

Section Field Description
General Default Page Allows you to set the application page you want to use as your default page.
Web Browser Home Page Allows you to set the webpage you want to use as your default webpage.

Personalization

Tile Width Allows you to enter a number (representing pixels) that defines the width of a tile.
Tile Height Allows you to enter a number (representing pixels) that defines the height of a tile.
Scaling 
Factor

Allows you to enter a number (when the Auto Scaling toggle switch is Off) to define 
how the tiles are scaled.

Auto Scaling Allows the application to define (when the toggle switch is On) how the are scaled.

Tile Color

Provides the following fields that you can use to determine the color of the tiles 
on your terminal:
• Color scale--lets you select the color by sliding a 
• RGB/HSV field--toggles between RGB and HSV values. Select RGB to enter 

numerical values in the Red, Green, and Blue fields. Select HSV to enter 
numerical values in the Hue, Saturation, and Value fields.

• Hexadecimal field--lets you enter in a hexadecimal value to define a color.
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System Screen

The System screen allows you to set the language for your terminal. In addition, you can select 
the language for your soft keyboard, and the time zone you work in.

Table 41 - System Screen

Section Field Description

— Language
Provides a dropdown list that allows you to select the language that is 
displayed in the Windows Configuration Menu. This has no impact on the 
language that is displayed in Machine Edition (ME) Station

— Keyboard layout Provides a dropdown list that allows you to select the language used for the 
soft keyboard on your terminal.

Maintenance Menu — Contains the Go to Maintenance Menu button, which allows you to return to 
the Maintenance Menu.
146 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 5          Series B Terminals with Windows 10 I0T Core OS
Network & Wi-Fi Screen

The Network & Wi-Fi screen displays information about the direct and Wi-Fi connections of 
your terminal.

Table 42 - Network & Wi-Fi Screen

Section Field Description

— View network properties Displays the network properties of your terminal, as shown in the 
following screenshot.

Direct Connections — Displays the connection type of the terminal.

Wi-Fi —
Displays information about the Wi-Fi connection available for your 
terminal. Includes a Refresh button that allows you to refresh the 
Wi-Fi information.
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Firmware Updates Screen

The App Updates screen allows you to obtain updates for the operating system, as well as for 
applications that you use on the terminal.

Use the scroll bar at the right of the screen to view all available fields on this screen.

When you select Switch to Firmware Update mode, a system warning box appears. Select yes 
to continue into the firmware update mode. The firmware update mode is displayed.

The System Firmware section includes information about the operating system and ME 
station. This can be updated via ControlFLASH or a USB storage device. When updating via 
ControlFLASH, a .dmk file is used. When updating via a USB Storage Device, a .CAB file is used. 

The Update from USB Storage button is visible only when a USB storage device is plugged in. 
For instructions on how to update the firmware, Update the System Firmware on page 49.

Table 43 - Firmware Updates Screen

Section Field Description

PanelView Plus 
Firmware Updates —

Contains the Switch to Firmware Update mode button, which allows you to use 
ControlFLASH™ to obtain the latest version of the FactoryTalk View ME Station 
software.
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The DLR Network Switch Firmware section is new for Series B terminals (Series C for Stainless 
Steel terminals). This firmware is for the DLR functionality of the terminal.

Power Options Screen

The Power Options screen allows you to choose whether to restart or shut down your terminal.

Table 44 - Power Options Screen

Section Button Description
— Restart Restarts the terminal into ME Station or loads the ME application (if configured to do so).
— Shut down Shuts down the terminal.
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Touch Screen

The Touch screen allows you to recalibrate the touch screen of your terminal if your device 
does not respond appropriately to taps.

Table 45 - Touch Screen

Section Button Description

Calibration Go to Calibration Menu Reboots the terminal and then launches the Calibration menu, which 
allows you to recalibrate the sensitivity of the touch screen.
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Services Screen

The Services Screen allows you to specify whether you want to access various file servers.

ATTENTION: By default, all services are disabled. To enable a service, slide 
the toggle switch to the right. To disable a service, slide the toggle switch to 
the left. To change any setting, you must enter the administrator password.
We recommend that you do not enable a service unless your custom 
application explicitly requires doing so. If you do customize your terminal 
settings, you should follow not only the design guidelines for your company, 
but also industry-standard engineering practices and behaviors.
If you change the default Services settings, you assume responsibility for any 
potential issues that arise as a result of those changes. It is your 
responsibility to protect and secure your PanelView Plus 7 Performance Series 
B terminal from malware and network attacks.

Table 46 - Services Screen

Section Button Description

— ViewPoint Server 
(HTTP/HTTPS)

Set this switch On to enable the FactoryTalk ViewPoint server. Set this switch Off 
disable the FactoryTalk ViewPoint server
This functionality is not available in the initial release.

— File Server 
(SMB™) Set this switch On to enable file sharing. Set this switch Off to disable file sharing.

— Internet Printing 
Protocol (IPP)

Set this switch On to enable printing (if this switch is not set to On, the printer is 
not recognized in the list of available printers within ME Station). Set this switch 
Off to disable printing.

— Secure File 
Transfer (SFTP)

Set this switch On to turn on the secure FTP server. Set this switch Off to turn off 
the secure FTP server.

— Remote Client 
Access (VNC)

Set this switch ON to turn on the VNC server. Set this switch Off to turn off the VNC 
server.

— Ping Response 
(ICMP)

Set this switch On to allow the terminal to reply to pings. Set this switch Off to 
disable ping replies.
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Remote Client Access (VNC)

Setting the Remote Client Access (VNC) switch to On turns on the VNC server. When the VNC 
server is running on the terminal, a VNC viewer on a personal computer can connect, view, and 
control the terminal. Once turned On, use the arrow button to open the Remote Client Access 
(VNC) options.

Table 47 - Remote Client Access (VNC) Options

Field Description

View Only Password

Allows you to set a password for View Only access with the VNC viewer. The password is 
limited to 8 characters. Once you enter a password, select the Save Passwords button to 
save the password. After successfully entering the administrator password, a notification 
appears at the top of the screen confirming that the VNC password was saved.
After navigating away from the Services Screen, this field appears blank even if a 
password has been saved.

Full Control Password

Allows you to set a password for Full Control (inputs enabled) access with the VNC viewer. 
The password is limited to 8 characters. Once you enter a password, select the Save 
Passwords button to save the password. After successfully entering the administrator 
password, a notification appears at the top of the screen confirming that the VNC 
password was saved.
After navigating away from the Services Screen, this field appears blank even if a 
password has been saved.

File Transfer Support
Allows you to toggle between enabling or disabling File Transfer Support:
Disabled – Prevents file transfer with the VNC viewer
Enabled – Allows file transfer with the VNC viewer
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Event Log Screen

The Event Log screen lets you select and view event logs for your terminal.

Table 48 - Event Log Screen

Section Field Description

— —

Displays a dropdown list that allows you to select an event log to display. The following 
choices are available.
• Application—displays events that are related to software installed on the Windows 10 IoT 

Core.
• Parameters—displays the Parameter log.
• System—displays events that are related to the Windows 10 IoT Core system.
• WinCEApplication—displays events that are related to software installed in the Windows CE 

App Container.
• WinCESystem—displays events that are related to the Windows CE App Container system.
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Notes:
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Install and Replace Components

Prevent Electrostatic Discharge (ESD)

ATTENTION: 
This equipment is sensitive to electrostatic discharge, which can cause 
internal damage and affect normal operation.
Follow these guidelines when you handle this equipment:
• Touch a grounded object to discharge potential static.
• Wear an approved grounding wriststrap.
• Do not touch connectors or pins on component boards.
• Use a static-safe workstation, if available.

ATTENTION: Disconnect all power before installing or replacing any 
components. Failure to remove power can result in electrical shock or 
damage to the terminal. 

At the end of its life, this equipment should be collected separately from any 
unsorted municipal waste.

For a complete list of supported devices, go to
https://rockwellautomation.custhelp.com and search the Knowledgebase for the 
keywords, ‘PanelView Plus Hardware Compatibility List’.
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Connect to USB Ports The PanelView™ Plus 7 Performance Series A terminals have two USB 2.0 (type A) host ports. 
The Series B terminals (Series C for Stainless Steel terminals) have one USB 2.0 port and one 
USB 3.0 host port. The USB host ports support removable USB drives and a USB printer.

Icons identify the USB host connections. The USB host connection supports 0.5 A at 5V DC. 
Connected USB devices must not exceed this power load. 

Connect only externally powered USB hubs to the terminal that are USB 2.0 compatible. Before 
you attach the devices to a USB hub, verify that the power adapter is connected and powered 
on.

USB Cables

Use only hi-speed, USB 2.0 or higher certified cables for error-free transmissions. 

IMPORTANT See Required Circuit Port Parameters for USB Peripheral Devices on 
page 23 for information on how to use the USB host ports and USB 
peripheral devices in hazardous locations.

IMPORTANT The USB host connections are intended for temporary use. Do not use 
the USB host connections for runtime operations.

Table 49 - USB Connector Pinout

USB Port USB Icon USB Connector Pin Signal Description

Host

1 VCC +5V

2 D- Data -

3 D+ Data +

4 GND Ground

WARNING: USB devices that are not powered by the USB port must be within the 
same enclosure as the terminal. The USB devices must be connected to a ground 
system common with the terminal or used with a USB hub that provides galvanic 
isolation.

1 1

Two USB Host Ports

Performance Terminals

Stainless Steel Terminals

IMPORTANT: The 
USB device port is 
not functional. Do 
not use this port.
156 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 6          Install and Replace Components
Install a USB Printer Series A Terminals

PanelView Plus 7 Performance Series A terminals support the connection of one USB printer 
such as Canon, Epson, Hewlett-Packard, and Brother. The printers support plug-and-play 
installation and manual installation if a suitable driver is available. You can connect a printer 
to a USB port on the terminal.

Note: Series B terminals (Series C for Stainless Steel terminals) do not support USB printers. 
They support only network printing via IPP.

Printers are configured and managed from the Printers application in the desktop 
control panel. A wizard is supported for each printer type.

After configuring a printer, you can access it from desktop applications or from FactoryTalk® 
View Machine Edition Station. Select Terminal Settings, then choose Print Setup. Applications 
can also select and share printers.

Plug-and-Play Installation

To install a plug-and-play printer from the Windows desktop, follow these steps. For manual 
printer installation, see Manual Printer Installation on page 159.

1. Connect the printer to a USB host port on the terminal.
2. Plug the power cord of the printer into an outlet and turn on the printer.

Windows automatically detects your plug-and-play printer, and in most cases, without 
requiring you to make any selections.
The printer is ready to print.

3. Verify printer installation from the desktop control panel by opening the 
Printers application. 
Notice the icon for the Deskjet 5650C printer. The check mark indicates that this printer 
is the default.

For more information on supported printers, go to
https://rockwellautomation.custhelp.com and search the Knowledgebase for the 
keywords, ‘Printers Supported on PanelView Plus’.

Table 50 - Support for Printers

Printer Type Description

Local USB 
You can connect a JETCET supported printer to a USB host port.
The printer that is attached to the USB host port can be shared by a remote terminal when 
configured as a network printer on the remote terminal. 

Network The terminal supports a remote printer that is connected to the network via the Ethernet port. The 
printer address can be its device name or IP address. 

RDP/ICA A local printer can be made available to a Windows® server application that is running in an RDP 
(Remote Desktop Protocol) session on the terminal. 

This procedure shows a plug-and-play installation for the Hewlett Packard HP 
Deskjet 5650 printer.

IMPORTANT If the automatic plug-and-play installation is not supported for a 
printer, this error is logged to the System Event sign in the 
Hardware Monitor. 
For example, JETCET PRINT was unable to auto-configure printer. 
To manually configure printer, go to the Printers folder from the 
Control Panel.
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4. From the File menu, choose Properties to view the properties of the printer.

Printer properties include the printer name, manufacturer and model, print driver, and 
port-specific parameters.

5. To verify installation, right-click the printer and print a test page.

When printing from an application such as WordPad, a Print dialog box opens where you can 
adjust settings.

• New printer configurations are retained through a power cycle.
• Printers that are configured through the desktop control panel are also 

available within the FactoryTalk View ME Station when selecting Terminal 
Settings > Print Setup.
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Manual Printer Installation

To configure a supported printer, follow these steps.
1. Connect the printer to a USB port of the terminal.
2. Plug the power cord of the printer into an outlet and turn on the printer.

3. From the desktop control panel, open Printers .
4. Select Add Local Printer.

5. To configure the printer, follow the Add Local Printer Wizard instructions:
a. Verify that the connected printer appears on the USB printer port.
b. Select the manufacture and model of the JETCET printer.
c. Accept the default printer name or enter another.
d. To verify the installed printer, print a test page.
e. Specify whether you want the printer to be shared on the network.

Series B Terminals(1)

To enable printing on Series B terminals (Series C for Stainless Steel terminals), the Internet 
Printing Protocol (IPP) service must be turned on. By default, this service is turned off. 

To enable the Internet Printing Protocol (IPP) Service:
1. Navigate to the Windows Control Panel.
2. Select the Settings Menu (Gear Icon).
3. Select Services.
4. Under Internet Printing Protocol (IPP), move the slider to the right to turn on the service.
5. Enter the Administrator password when prompted.
6. Verify that the slider is on the right in the on position. 

For instructions on how to configure the printing in the Machine Edition environment on the 
terminal, see Configure Print Options on page 87.

(1) Series C for Stainless Steel terminals.
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Insert an SD Card An SD card provides extra storage when inserted into the SD card slot of the terminal. 
Supported cards include catalog numbers 1784-SD1, 1784-SD2, 1784-SDHC8, and 1784-SDHC32. 
The SD cards are hot-swappable; they can be inserted and removed while the terminal is 
powered on and running.

The SD card slot is accessible from inside of the back panel of the installed terminal.

To install an SD card in the card slot, follow these steps.
1. Verify that the SD card is locked or unlocked according to your preference. 

- If unlocked, the terminal can write data to or read data from the card.
- If locked, the terminal can only read data from the card.

2. Insert the SD card firmly into the slot 
until you hear a click.
When you hear the click, the card has 
locked into place.
To remove the card, push the SD card in 
slightly and remove then it from the slot.

WARNING: Explosion Hazard
If you remove or insert an SD card while the power is on, an electric arc can 
occur. This arc can cause an explosion in hazardous location installations.
Do not remove and insert the SD card unless power has been removed or the 
area is known to be nonhazardous.

ATTENTION: Position the SD card correctly before you insert the card 
into the slot. If you force the card into the slot, you can damage the 
card or the terminal.

Unlocked
Locked

1
6

1
6

SD Slot

The aluminum terminal is 
shown. The SD card location is 
the same on the stainless-
steel terminal.
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Connect a Speaker You can connect a speaker or audio amplifier to the terminal to announce alarms, provide 
feedback of operator actions, and provide sound during video playback. 

Note: Series B terminals (Series C for Stainless Steel terminals) support audio through the 
audio out port and USB audio.

Selecting a Speaker for a Class D Amplifier

The audio port is a class D amplifier output. It has a two-pin terminal block for connecting a 4 
ohm or 8 ohm speaker. The audio port can also drive externally amplified speakers.

On Series A terminals, the speaker works in the Windows CE operating system 
(Windows Media Player). On Series B terminals (Series C for Stainless Steel 
terminals), the speaker works in the Windows 10 operating system (Microsoft® 
Edge Browser). FactoryTalk View ME Station software does not support the 
speaker.

Speaker Impedance Ω Test Frequency (KHz) THD + N (%)
Output Power (W)

Series A Series B(1)

(1) Series C for Stainless Steel terminals.

4 1 1 2.2 2

4 1 10 2.7 2.5

8 1 1 1.3 1.42

8 1 10 1.6 1.8

ATTENTION: The audio port is nonisolated. Follow these guidelines:
• A connected speaker must be within the same enclosure as the terminal. 

Amplified speakers must be connected to a ground system common with the 
terminal.

• The audio is provided as a terminal block connection for use in hazardous 
locations. Connect and tighten wires securely. 

1
6

1
6

Audio Out

The aluminum terminal is shown. The 
speaker connection is the same on the 
stainless-steel terminal.

+
-

+

-

+

+
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Use a 0.4 x 2.5 mm screwdriver for terminal block wiring. The wire length must not exceed 1 m 
(39 in.).

To connect a speaker to the audio port, follow these steps.
1. Use wire strippers and remove about 5 mm (0.2 in.) of insulation from the ends of the 

wire. 
2. Attach one of the newly exposed wires to the positive (+) terminal and the other to the 

negative (–) terminal on the operator device.
3. Connect the opposite exposed ends of the wire to the positive (+) and negative (–) 

terminals on the speaker or amplified speakers.

Table 51 - Audio Port Wiring

Wire Type Wire Size Strip Length Torque Min…Max

Stranded or solid
Cu 90 °C (194 °F)

0.05…1.3 mm2

30…16 AWG 5 mm (0.2 in.) 0.22…0.25 N•m
(1.95…2.2 lb•in)
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Replace the Battery The product has a lithium battery that provides backup power for the real-time clock and 
static RAM. The battery can be replaced while the product is mounted in the panel. You need a 
#1 Phillips screwdriver (#1 Phillips bit) to remove the logic module and access the battery. 

Perchlorate material – special handling may apply. See www.dtsc.ca.gov/hazardouswaste/
perchlorate.

This perchlorate warning only applies to primary Lithium Manganese Dioxide (LiMnO2) cells or 
batteries, and products containing these cells or batteries, which are sold or distributed in 
California, USA.

To replace the battery, follow these steps.
1. Remove power from the terminal.
2. Loosen the screws that secure the logic module to the back of the display.

3. Carefully lift the logic module away from the display module and turn over to expose the 
circuit board.

This product contains a sealed lithium battery that may need to be replaced 
during the life of the product.
At the end of its life, the battery that is contained in this product should be 
collected separately from any unsorted municipal waste.
The collection and recycling of batteries helps to protect the environment and 
contributes to the conservation of natural resources as valuable materials are 
recovered.

ATTENTION: There is a danger of explosion if the lithium battery or real-time 
clock module in this product is incorrectly replaced. Do not replace the 
battery or real-time clock module unless power has been removed and the 
area is known to be nonhazardous. 
Replace the battery only with catalog number 2711P-RY2032 or an equivalent 
CR2032 coin-cell battery.
Do not dispose of the lithium battery or real-time clock module in a fire or 
incinerator. Dispose of used batteries in accordance with local regulations.
For safety information on the handling of lithium batteries, including handling 
and disposal of leaking batteries, see Guidelines for Handling Lithium 
Batteries, publication AG 5-4.

This equipment is sensitive to Electrostatic Discharge (ESD).
Follow ESD prevention guidelines when handling this equipment.

Logic Module

Display Module

The aluminum terminal 
is shown. Battery 
replacement is the 
same on the stainless-
steel terminal.
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4. Locate the coin-cell battery on the circuit board.

5. To remove the battery, lift the side of the battery.
6. Insert the new battery with the positive (+) polarity up.
7. Reattach the logic module by aligning the connector on the bottom of the logic module 

with the connector on the back of the display module.

8. Push down on the logic module and make sure it is fully seated.
9. Tighten the screws to a torque of 0.68…0.90 N•m (6…8 lb•in).

Install a Protective Overlay

The overlay helps to protect the touch screen and keys from scratches, dust, fingerprints, and 
external damage from chemicals or abrasive materials. See Table 6 on page 18 for a list of 
available overlays.

IMPORTANT Do not use protective overlays with the stainless-steel terminals. The 
protective overlays are not compatible in hygienic applications. 
The 12-inch overlay may be used on an ArmorView™ Plus 7 terminal, but 
it will only fit the touch screen portion of the product.

IMPORTANT Follow these guidelines when installing the overlay:
• Make sure that your hands are clean and dry.
• Handle the overlay by its edges to help prevent fingerprints or lint. If you 

do get marks or lint on the overlay, remove them before proceeding. 
• Do not touch the adhesive ring.
• Do not use Isopropyl Alcohol, chemicals that contain silicone, or soap to 

clean the surface of the terminal. Doing so may cause the overlay not to 
adhere properly to the terminal surface. 

• Denatured cleaning ethanol (95%) or a mild glass cleaner is 
recommended to clean the terminal surface before applying the 
protective overlay.
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The protective overlay covers the entire surface of the 
terminal bezel inside the aluminum perimeter. The overlay 
has a protective liner that is removed by pulling back on a 
tab. Do not remove the liner until you are ready to install 
the overlay. 

Before installing the overlay, use a lint-free cloth and a 
mild glass cleaner or denatured cleaning ethanol (95%) to 
clean the touch screen surface, and keys, if present. 
Remove all fingerprints, grease, or dust. Marks that are 
not removed are trapped underneath the overlay. Grease 
also affects the adhesion of the overlay.

To apply the protective overlay, follow these steps.
1. Pull the tab from one of the short sides and partially peel the liner away from the 

adhesive layer.

Hold the peeled back portion of the protective liner out of the way as you perform the 
next step.

2. Center the overlay over the bezel and carefully position the adhesive surface on the 
terminal.
While the protective liner is still covering the rest of the overlay, verify that it is properly 
centered.

3. Slowly peel off the rest of the liner while using a soft cloth to press the overlay on the 
screen.
Make sure that the overlay lies flat with no bubbles or warps.

4. With a soft cloth or finger, press around the edges of the overlay to seal it, and remove 
any air bubbles trapped in the adhesive.

Clean the Overlay

Use a clean, lint-free cloth, and a mild glass cleaner that leaves no streaks to clean the overlay. 
Windex or an eye glass cleaner is recommended. Do not use cleaners that contain abrasives.

Remove the Overlay

Remove the overlay if it is damaged or needs replacement. Lift a corner and slowly pull off the 
overlay. Use isopropyl alcohol to remove any residual adhesive. Do not reuse the overlay.

Tab

Adhesive Ring

Protective liner
(covers adhesive)

Overlay

Bezel

Protective Liner
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Replace the Stainless Steel 
Terminal Gasket

The hygienic gasket for the stainless-steel terminal is blue.

To replace the stainless-steel terminal gasket, follow these steps.
1. Remove power from the terminal.
2. Label all wiring and connections so you can attach them correctly later.
3. Remove all wiring and connections.
4. Remove the mounting clips and backing plate.

Hold the terminal so it does not fall out of the panel.

5. Remove the terminal from the panel.
6. Place the terminal screen-down on a clean, flat surface.

Be careful not to scratch or damage the terminal screen.
7. Remove the old gasket from the bezel.
8. Clean any dirt or residue from the bezel.
9. Position the new gasket on the bezel, with the gasket alignment plugs facing the bezel 

alignment features.
This gasket forms a compression seal. Do not use sealing compounds.

10. Press each gasket alignment plug into the bezel alignment feature.
The alignment plugs hold the gasket to the bezel.

IMPORTANT Slip the inside corners of the gasket 
under the corners of the bezel 
shroud.

Backing Plate

Mounting Clips

Panel
Terminal

Gasket with Alignment Plugs
Back of Bezel with Alignment Features
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11. Place the terminal in the panel cutout.
Hold the terminal so it does not fall out of the panel.

12. Position the backing plate over the terminal.

13. Slide the ends of the mounting clips into the slots on the terminal.
14. Tighten the mounting clip screws by hand until the backing plate contacts the panel 

uniformly.
15. Torque the mounting clip screws to 2.3…2.6 N•m (20…23 lb•in) by using the specified 

sequence. 
The clips loosen as the adjacent clip is tightened.

IMPORTANT Make sure that the flat side of the backing plate faces away from 
the panel, as shown in the drawing.

Panel

Terminal

Backing Plate

Mounting Clips

Panel
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16. Repeat step 15 until all mounting clips are at the specified torque.

17. Reattach all wiring and connections.

ATTENTION: Tighten the mounting clips to the specified torque to 
provide a proper seal and to help prevent damage to the product. 
Rockwell Automation assumes no responsibility for water or chemical 
damage to the product or other equipment within the enclosure 
because of improper installation.

9-in. Torque Sequence
8 Clips

12.1-in. Torque Sequence
10 Clips

1

2

3

4
5

6 7

8

2

3

49

10

7

5

1

10-in. Torque Sequence
8 Clips

2

3

4
5

6 7

8

1

15-in. Torque Sequence
12 Clips

1

2

3

49

10

6

8

12

7

5

11

6

8
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Terminal Firmware Firmware components are packaged as execute-in-place (XIP) regions in a System Code (SC) 

.img file. When the SC .img file is copied to the Virtual File System (VFS) on the terminal, the 
terminal XIP regions are updated and the terminal restarts automatically. These firmware 
components are affected during an update: 

• FactoryTalk® View Machine Edition Station software
• Communication protocols and drivers including Kepware® drivers
• Windows® fonts
• Windows CE components
• FactoryTalk components
• User extensions

Note: The description of XIP and VFS is only applicable to PanelView™ Plus 7 Performance 
Series A terminals.

A firmware update does not affect these terminal components or settings: 
• Windows registry

• File system including the FactoryTalk View Machine Edition application that is loaded(1) 
in the terminal

• Network parameters including the network device name, DHCP-enabled and static(2) IP 
addressing, speed, and duplex setting

• Display settings and screen saver configuration
• Touch screen calibration

(1) In some cases, the FactoryTalk View ME application can be missing after a firmware update.
(2) In some cases, static IP addresses have been changed to DHCP-enabled IP address after a firmware update.
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Download Firmware Files 
(Series A Terminals Only)

Note: The following description applies to PanelView Plus 7 Performance Series A terminals 
only. Series B terminals (Series C for Stainless Steel terminals) use ControlFLASH™ to update 
firmware (files that are downloaded from the web are in .dmk format).

Download the appropriate firmware installation package from the Rockwell Automation 
website. The package is named:

PVP7_<terminal family>_x.xx-yyyymmdd.exe, where:
• <terminal family> is the terminal name
• x.xx is the FactoryTalk View ME software version that is contained in the package
• yyyymmdd is the date that the package was created

This installation package contains the following:
• Firmware Update Package (FUP) contains an autorun executable and the new firmware 

files.
• Firmware Upgrade Wizard (FUW), version 6.10 or later, is used to update the terminal 

firmware by using the contents of the FUP.

The FUP and FUW are copied to your computer during the download. 

To download firmware installation files to your computer, follow these steps.
1. Visit the Product Compatibility and Download Center at rok.auto/pcdc.

2. Select Downloads by Product.
3. From the All Families pull-down menu, choose PanelView™ Plus 7 Performance terminal.
4. Select a firmware revision, then select Find Downloads.

5. Download the update file (.exe) to a temporary folder on the same drive as 
FactoryTalk View Machine Edition (ME) software.

6. Run the update file (.exe) installation procedure: 
- The FUW is installed in the FactoryTalk View ME folder. 
- The firmware update package file (.fup) is installed into the folder that is specified 

during the installation procedure.

You are now ready to run the FUW to update the terminal firmware from a USB drive or SD card 
or by using a network connection.

ATTENTION: Do not download or install firmware files from other 
sources. Be sure to install only the secure and sanitary originals from 
the Product Compatibility and Download Center at rok.auto/pcdc.

The FUP name is ME_PVP7xX_6=8.xx-yymmdd
• yyyymmdd is the date that the firmware package was created
• 8.xx is the version of ME contained in this package
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Firmware Upgrade Wizard 
(Series A Terminals Only)

Note: The following description applies to PanelView Plus 7 Performance Series A terminals 
only. Series B (Series C for Stainless Steel terminals) terminals use ControlFlash to update the 
firmware.

The Firmware Upgrade Wizard (FUW) is used to update the terminal firmware. Two methods 
are provided to update the firmware:

• Create a firmware update card with the contents of the FUP file that you can then load 
in the terminal to update the firmware. 
The firmware update card can be a USB drive or an SD card, catalog number 1784-SDx.

• Update firmware in a terminal that is connected to a computer over a direct network 
connection. The network connection requires a computer running FactoryTalk Linx 
software, version 5.0 or later. In the FactoryTalk Linx software, you select the terminal 
that you want to update.

You can run the FUW from within FactoryTalk View Studio software or from the Programs 
menu on your computer:

• In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade 
Wizard.

• Choose Start > Programs > Rockwell Software > FactoryTalk View > Tools > ME 
Firmware Upgrade Wizard.
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Update Terminal Firmware 
from a Storage Device 
(Series A Terminals Only)

There are two steps to update the firmware from a storage device.
1. Create a firmware update card with the required firmware files.
2. To update the firmware, load the card in the target terminal.

The firmware update card can be a USB drive or an SD card.

Create a Firmware Update Card

Note: The following procedure is only available for PanelView Plus 7 Performance Series A 
terminals.

To copy firmware files to a USB drive or SD card, follow these steps.
1. Insert either a USB drive or an SD card into the appropriate slot on your computer.
2. Run the Firmware Upgrade Wizard:

- In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade 
Wizard.

- Choose Start > Programs > Rockwell Software > FactoryTalk View > Tools > ME 
Firmware Upgrade Wizard.

3. Follow these steps from the initial Firmware Upgrade Wizard dialog box.
a. Select Create firmware update card.

b. Select the location of the firmware card by browsing to the root directory of the 
storage card that is loaded in your computer, for example, E:\.
The firmware files are copied to this location. You can also specify a folder on the 
hard drive.

c. From the Existing terminal type pull-down menu, select a PanelView Plus 7 terminal.
d. Select Next.
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4. Follow these steps from this dialog box.
a. Browse to the location of the firmware source files on your computer, where the FUP 

was installed.

b. Choose the firmware revision for the update.
c. Select Next.

It can take several seconds for the next dialog box to appear while the FUP is being 
retrieved.

5. From this dialog box, optionally select the KEPServer drivers that you want included 
with the firmware, then select Next.

Kepware drivers are already installed on the PanelView Plus 7 Performance terminals.
The final dialog box summarizes your choices for creating the firmware update card.

6. Select Finish to copy the firmware files to the firmware update card.
A progress bar automatically updates as files are copied to the USB drive or SD card. 
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7. Select OK when the firmware update completes successfully. 

8. Remove the USB drive or SD card from your computer.

Update Terminal Firmware by Using Firmware Update Card

The following procedure is only available for PanelView Plus 7 Performance Series A terminals.

To transfer firmware files from the USB drive or SD card to the terminal, follow these steps. 
Use the firmware update drive or card that you created in the previous section. 

1. Insert the USB drive or SD card into the appropriate slot on your terminal. 
The firmware update automatically starts and displays this dialog box.

2. To start the firmware update, select update or [F7] on the terminal.
The terminal restarts and displays a progress bar during the update. 
When the update is complete, the terminal restarts, and executes the new firmware.

3. Remove the USB drive or SD card from the terminal.

If the firmware files were copied to the hard drive, copy the files to the root 
directory of the USB drive or SD card.

IMPORTANT For information on how to use a USB drive or SD card with the 
ArmorView™ Plus 7 terminal, see the ArmorView Plus 7 Installation 
Instructions, publication 2711P-IN013.

IMPORTANT • Do not remove or accidentally disconnect the USB drive or SD card while 
a firmware update is in process. This action can corrupt the firmware 
and make the terminal unstable.

• Do not power off the terminal during a firmware update.
• USB hubs can produce unexpected behavior and are not recommended.

IMPORTANT If the firmware update fails because of a power loss or the firmware 
update card is inadvertently removed, you can restore the terminal to 
the factory default firmware. See Maintenance Mode Operations — 
Series A Terminals on page 196 for details on how to restore the factory 
default settings.
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Update Terminal Firmware 
Over the Network (Series A 
Terminals Only)

Note: The following procedure is only available for PanelView Plus 7 Performance Series A 
terminals.

You can update firmware in a terminal that is connected to a computer over a direct network 
connection. The network connection requires a computer with the Firmware Upgrade Wizard 
(FUW) and FactoryTalk Linx software, version 5.0 or later.

FactoryTalk Linx software is required so that you can select the terminal on the network.

To copy firmware files to the terminal over a network by using FactoryTalk Linx software and 
Ethernet communication, follow these steps.

1. Run the Firmware Upgrade Wizard:
- In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade 

Wizard.
- Choose Start > Programs > Rockwell Software > FactoryTalk View > Tools > ME 

Firmware Upgrade Wizard.

2. Select update firmware on the terminal and select Next.
3. Select Yes to continue.

It is not necessary to back up files on PanelView Plus 7 Performance terminals.
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4. Select ‘Network connection (using FactoryTalk Linx)’ and select Next.

This connection is the only valid selection for PanelView Plus 7 Performance terminals.
5. Select the terminal for the firmware update.
6. Select Next.
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7. Follow these steps from this dialog box.

a. Browse to the location of the firmware source files on your computer, where the FUP 
was installed.
The default location is shown.

b. Choose the version of the update firmware from the pull-down menu.
c. Select Next.

It can take several seconds for the next dialog box to appear while the FUP is being 
retrieved.

8. From this dialog box, optionally select the KEPServer drivers that you want included in 
the firmware, then select Next.

Kepware drivers are already installed on the PanelView Plus 7 Performance terminals.
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The final dialog box summarizes your choices for upgrading the terminal firmware.

9. Select Finish to update the firmware in the terminal. 
10. Select Yes to continue with the update.

A progress bar updates as firmware files are copied to the terminal.
11. Select OK when the firmware update is complete.

The terminal restarts and executes the new firmware.

IMPORTANT If the firmware update fails because of a power loss or the firmware 
update card is inadvertently removed, you can restore the terminal to 
the factory default firmware. See Maintenance Mode Operations — 
Series A Terminals on page 196 for details on how to restore the factory 
default settings.
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Update System Firmware 
(Series B Terminals Only)(1)

You can update the firmware on your terminal by using one of the following methods:
• USB storage device
• ControlFLASH client, which is available in the following formats:

- ControlFLASH Plus™
- ControlFLASH

USB Storage Device
1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at 

rok.auto/pcdc.
2. On the home page, select Available Versions.

3. Click the Select a Product link, and in the Select a Product dialog box, enter PanelView 
Plus 7 Performance in the search field, and then select the Search button.

4. Select PanelView Plus 7 Performance, and then select B for the Series B firmware (C for 
Series C for Stainless Steel terminals).

5. Select the Show Downloads icon for the desired firmware revision for PanelView Plus 7 
Performance (Series B (Series C for Stainless Steel terminals)). 

6. Select and download the CAB Files for the desired firmware revision.

7. After the .ZIP file has downloaded, extract the contents to the root of the USB Storage 
Device. 

8. Insert the removable storage device into one of the USB ports located at the bottom of 
the PanelView terminal. 

9. On the PanelView terminal, in the Control Panel, select Settings > Firmware Updates > 
Switch to Firmware Update mode. 

(1) Series C for Stainless Steel terminals.

Firmware for Series B terminals (Series C for Stainless Steel terminals) 
starts at version 12.XXX.

IMPORTANT Do not download the DMK file. It does not work to update 
firmware via a USB Storage Device.

Use a USB Storage Device with at least 8 GB of storage available. Any 
Windows file system (including FAT32 or NTFS) is acceptable.
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10. Select Update from USB Storage and wait for the firmware update to complete. 

Before the update starts, the terminal displays the warning message that is shown in 
the following graphic. As the message states, do not remove the USB storage device 
while the file is being copied. Wait until you are prompted to remove the USB storage 
device. 

11. Select OK when you are ready to continue.
While the firmware is updating, the terminal displays the update status. When the 
update is complete, the terminal displays the message that is shown in the following 
graphic.

It is recommended that you remove the USB Storage device when prompted with the 
message shown in the image. 

12. Select OK to continue.
When the update is complete, the terminal reboots again and then displays the 
Password Entry screen. 

13. Continue with Enter a Password on page 58.
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ControlFLASH Client

The following ControlFLASH clients are available to update the firmware:
• ControlFLASH Plus
• ControlFLASH

Before you can use ControlFLASH Plus or ControlFLASH, you must download the DMK file from 
the Product Compatibility and Download Center (PCDC).

Downloading the ControlFLASH Plus or ControlFLASH File
1. Access the Rockwell Automation Product Compatibility and Download Center (PCDC) at 

rok.auto/pcdc.
2. On the home page, select Available Versions.

3. Click the Select a Product link, and in the Select a Product dialog box, enter PanelView 
Plus 7 Performance in the search field, and then select the Search button.

4. Select PanelView Plus 7 Performance, and then select B for the Series B firmware (C for 
Series C for Stainless Steel terminals).

5. Select the Show Downloads icon for the desired firmware revision for PanelView Plus 7 
Performance (Series B (Series C for Stainless Steel terminals)). 

6. Select and download the DMK file for the desired firmware revision.

7. Save the DMK file in the desired Firmware Kits location.
The default location is C:\Users\Public\Documents\RockwellAutomation\Firmware Kits

8. On the PanelView terminal, in the Control Panel, select Settings > Firmware Updates > 
Switch to Firmware Update mode. 

Firmware for Series B terminals (Series C for Stainless Steel terminals) 
starts at version 12.XXX. 
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9. Under System Firmware, select the Start Update Utility button.

Using ControlFLASH Plus

For details about how to install ControlFLASH Plus software, see the ControlFLASH Plus Quick 
Start Guide, publication CFP-QS001.

1. After you save the DMK file in the desired Firmware Kits location, launch ControlFLASH 
Plus.

2. Browse to and select the PanelView Plus 7 Performance Series B terminal (series C for 
Stainless Steel terminals).

3. Select Next.

IMPORTANT Use ControlFLASH Plus, version 4, or higher. The following procedure 
uses ControlFLASH Plus, version 4. 
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4. Confirm that the information is correct, and then select Flash.

A series of status changes occur on the ControlFLASH Plus screen and on the PanelView 
terminal.
On the ControlFLASH Plus screen, the Status field displays the Transmitting update 
status.

On the PanelView terminal, the status changes to CONNECTED: transferring updates… 
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Once the firmware file transmission is complete, on the ControlFLASH Plus screen, the 
Status field displays the Polling for power-up status.

On the PanelView terminal, the status changes to PLEASE WAIT: verifying and preparing 
updates… 

The PanelView terminal reboots, and on the ControlFLASH Plus screen, the Flash Results 
dialog box displays a Succeeded message.

5. Select Close, and then select Done.
When the firmware update is complete, the terminal reboots and displays moving gears 
while the update installs. 

6. Continue with Enter a Password on page 58.
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Using ControlFLASH

For information on how to install ControlFLASH, see the ControlFLASH User Manual, publication 
1756-UM105.

To use the ControlFLASH software to update the firmware in a PanelView Plus 7 Performance 
Series B terminal (Series C for Stainless Steel terminals), follow these steps.

1. Select Start > Programs > FLASH Programming Tools > ControlFLASH.
2. Make sure that you know the required information in the Welcome dialog box, then 

select Next.

3. Select the catalog number of the PanelView Plus 7 Performance Series B (Series C for 
Stainless Steel terminals) terminal that you want to update and select Next.

4. Browse to and select the device to update on the EtherNet/IP™ network and select OK. 

5. Select the firmware revision to install and select Next.
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6. Read the Danger information in the Summary dialog, then select Finish.

7. Select Yes to confirm that you want to update the target device.

The update starts and can take several minutes to complete.

When the firmware is sent to the terminal, the terminal resets and performs 
diagnostics.
The Update Status dialog box opens when the update is complete. If the update was 
successful, the Status area is green.

8. Select OK.
If the update fails, the status area is red and reads Update failure. For troubleshooting 
information, see the ControlFLASH User Manual, publication 1756-UM105.

9. Close the ControlFLASH software.
10. Continue with Enter a Password on page 58.

IMPORTANT Do not cycle power to the terminal during this process or the 
firmware update does not complete successfully.
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Update DLR Network Switch 
Firmware (Series B 
Terminals Only)(1)

The DLR Network Switch Firmware Update is new for Series B terminals (Series C for Stainless 
Steel terminals). This firmware is for the DLR functionality of the terminal and is separate from 
the System Firmware update. If the DLR functionality changes in the future, the update must 
be done using this process. If there is an update available, the .dmk file would be posted on the 
Product Compatibility and Download Center (PCDC) at rok.auto/pcdc.

This update must be done using Control Flash. It is not possible to do this update via USB flash 
drive as can be done with the System Firmware update

To update the DLR Network Switch firmware, follow these steps.
1. On the PanelView terminal, in the Control Panel, select Settings > Firmware Updates > 

Switch to Firmware Update mode. 
2. In the DLR Network Switch Firmware section, select Start Update Utility.

3. In the Warning dialog box, select the OK button to proceed with the firmware update.

The first progress message appears briefly and indicates that the terminal is 
connecting to the DLR network switch.

(1) Series C for Stainless Steel terminals.
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The second progress message appears when the terminal is connected to ControlFLASH 
and the new firmware is being downloaded to the DLR Network Switch.

The third progress message appears when the download is complete. The terminal then 
automatically reboots.

4. On your PC, browse to and select the PanelView Plus 7 Performance Series B terminal(1).

5. Select Next.

(1) Series C if it is a Stainless Steel terminal

The Device description states PanelView Plus 7 Performance, PVP7P DLR 
Network Switch.
188 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Chapter 7          Update Firmware
6. Confirm that the information is correct, and then select Flash.

On the ControlFLASH Plus screen, the Status field displays the Transmitting update 
status.

Once the firmware file transmission is complete, on the ControlFLASH Plus screen, the 
Flash Results dialog box displays a Succeeded message.

7. Select Close.
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Notes:
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Troubleshooting
View System Information

View system information for the terminal from FactoryTalk® View ME Station runtime or from 
the Hardware Monitor (Series A only) in the control panel.

To view system information for the installed components, follow these steps.
1. Access FactoryTalk View ME Station runtime.
2. Select Terminal Settings > System Information > About FactoryTalk View ME Station.

Status Indicators The back of the terminal has two indicators to identify system status:
• STS indicator (green) indicates that the terminal is on and running
• ERR indicator (red) indicates hardware and firmware faults

At startup, the STS and ERR indicators flash on and off, then the STS indicator flashes to signal 
progress during startup. If the indicators remain off, check the power cable.

After a successful startup, the STS indicator remains on. Under normal operation, for Series A 
terminals, the STS indicator stays on. For Series B terminals (Series C for Stainless Steel 
terminals), the STS indicator blinks. 

IMPORTANT This document describes troubleshooting procedures for the 
PanelView™ Plus 7 Performance terminal only. 
If your terminal is part of the ArmorView™ Plus 7 product, see the 
ArmorView Plus 7 Installation Instructions, publication 2711P-IN013, for 
instructions on how to gain physical access to the PanelView Plus 7 
Performance terminal. After you gain access, follow the PanelView Plus 
7 Performance terminal troubleshooting instructions in this chapter.

Fault Indicator States During Terminal Startup

ERR (red) STS (green) Description Recommended Action

Blinking Off
Recoverable firmware error. Reload the firmware.

Recoverable configuration failure. Restore the terminal to its factory default image. 
See Restore a Backup Image on page 109.

On
On Fatal hardware error. Replace the terminal.

Blinking Fatal display hardware error. Replace the terminal.

STS

ERR

The aluminum terminal is shown. 
The status indicators are the same on the stainless-steel terminal.
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View Network Status 
Information

Note: The system tray and Network Status Information dialog box that is described in the 
following procedure are available only to PanelView Plus 7 Performance Series A terminals.

Series A Terminals Only

To access network status information from the system tray, follow these steps. 
1. Double-click the network icon in the system tray.

2. To view the network status, select the Network Status Information tab.

Series A and Series B Terminals (Series C for Stainless Steel 
terminals)

To access network status information from ME Station, see View the Network Diagnostic Data 
on page 77.

Status Indicator Description
Port 1 status and Port 2 status

Gray Disabled or unknown.
Green Enabled and operating normally.
Yellow A non-fatal error condition exists.
Red An error condition exists that requires some manual intervention.

Network Status
Normal (green color) If the network topology is Linear/Star, the network status is always normal.
Ring Fault (yellow color) A non-fatal error condition exists.

Loop Detected (red color) 
This value can only occur in a Linear/Star topology. It occurs when an unexpected 
loop occurs in the network. It may not be possible for the terminal to report this 
condition (the terminal may not be capable of detecting the frames that it has sent).

Partial Fault (yellow color) A non-fatal error condition exists.
Rapid Fault (red color) An error condition exists that requires some manual intervention.

General Information

Network Topology Linear/Star
Ring

Supervisor IP Addr xxx.xxx.xxx.xxx format
(not applicable if in Linear/Star topology)

Supervisor MAC Addr xx:xx:xx:xx:xx:xx format
(not applicable if in Linear/Star topology)

Supervisor VLAN ID 8 bit numeric
(not applicable if in Linear/Star topology)
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Terminal Does Not Start Up If the terminal does not start up normally, check the table for possible causes.

Terminal Restarts 
Intermittently

If the terminal restarts intermittently, check the table for possible causes.

Touch Screen Issues If the touch screen is not responding correctly to touches with a finger or stylus, check the 
table.

Terminal Does Not Start Up Properly

Check For What to Do See This Page

Insufficient power
Make sure that the device is receiving adequate power.
• Check the DC power requirements.
• Check the AC power requirements

 
page 37
page 38

Improper power 
wiring

Verify that the power wiring is correct.
• Check the wiring specifications.
• Check the DC power wiring.
• Check the AC power wiring.

page 36
page 37
page 38

Status indicators Check the status indicators during startup. page 191
Stalled progress 
indicator

If a terminal stalls at the progress indicator and does not load an application 
or configuration screens, reload the firmware or restore factory defaults. page 109

Object touching 
the display

Verify that nothing is pressing against the display or that you are not 
touching the display during startup. Not applicable

Terminal Restarts Intermittently

Check For What to Do See This Page

Improper power 
wiring

Verify that the power wiring is correct.
• Check the wiring specifications.
• Check the DC power wiring.
• Check the AC power wiring.

page 36
page 37
page 38

Over-temperature 
conditions

Make sure that the processor is not exceeding temperatures for normal 
terminal operations.
• Check the processor temperature.
• Check the System Event log for over-temperature conditions.
• Check for adequate clearances around the terminal in the panel.
• Check for proper operating temperature.

page 92 or page 114
page 91 or page 113

page 24
page 114

Touch Screen Not Responding

Check For What to Do See This Page

Improper calibration Check for activation points that are offset from touch points.
Calibrate the touch screen.

page 83 or 
page 134

Non-functioning 
touch screen

Check the touch screen for damage, such as cuts or excessive wear. If 
there is damage, replace the terminal. Not applicable

Touching multiple 
input elements

Application screens contain graphic input elements that are configured in 
the Machine Edition application. When touched, these elements perform 
operations in a predictable manner. For example, an input element is 
configured to navigate to a specific screen in the application or start a 
motor when touched.
Multiple operations cannot be conducted simultaneously. Doing so results in 
an unintended operation.
• Do not touch multiple input elements simultaneously. 
• Do not rest a hand or multiple fingers on the display.

Not applicable
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Display Issues The display is unreadable or dims unexpectedly.

Ethernet Issues This table provides tips for isolating Ethernet anomalies. 

Performance Is Slow If the response time of the application is slow, for example screen changes or text display 
changes, check for the following issues:

• Application screens contain too many elements.
• If the controller is programmed for feedback, it can cause delays.
• Slow network performance or noise can result in retries.

ATTENTION: If the display darkens, or if the backlight is not functioning 
properly, the screen can be difficult to read and use of this touch screen could 
result in a potentially hazardous outcome. Do not use the touch screen 
under these circumstances. The design of the system must take into 
account the possibility of the touch screen losing functionality and unable to 
be used to maintain or change control of the system. The touch screen shall 
not be the single point of control of critical functions and is not intended to 
replace an E-stop.
Design of the system should follow all applicable code and good engineering 
practice. Factors to consider include:
• The possibility of an unreadable touch screen
• The possibility of an inoperable touch screen
• Unexpected communication errors or delays
• Operator error in the control of the system
• Proper use of E-stops and other safety practices
Provide means to achieve a safe state during anomalies and make sure that 
the system has adequate redundancy for critical functions.
Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Dim Display

Check For See These Pages
Low display brightness setting page 81 or page 111
Low brightness level of screen saver page 82 or page 112
Temperatures outside the operating range page 92 or page 114

Extend the life of the backlight by reducing the display brightness, by using the 
screen saver with reduced brightness, or operating at lower temperatures.

Ethernet Connection Issues

Check for These Issues What to Do

Status of invalid Ethernet connection
• Green indicator is on when a link is established.
• Yellow indicator blinks when activity is detected.
• Verify network connections.

Poor cable connections

Check the Ethernet cabling for the following:
• Make sure that cables are fully connected.
• Check for cable crimping.
• Check the Ethernet switch connections.
• Check the Uplink ports.

Invalid IP address of terminal

Go to Set the MAC Address of the Terminal on page 74.
If DHCP is enabled, the terminal automatically acquires a valid IP address 
from the network after startup. The TCP/IP protocol automatically assigns 
169.254.xxx.xxx when it fails to acquire an IP address from the network. In 
general, an IP address that begins with 169 does not support a network 
connection.

Conflicting IP addresses
If DHCP is not enabled and a static IP address is specified, make sure that 
the IP address does not conflict with the address of another device on the 
network.
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Resistance to Chemicals The outer surfaces of the terminal including the bezel, touch screen overlay, and panel gasket 
seal are tested for chemical resistance. Some of the chemicals can cause discoloration, but 
they do not interfere with the operation of the terminal.

Clean the Terminal Display A protective overlay can help extend the life of the terminal and make it easier to clean the 
display. Table 6 on page 18 provides catalog numbers for overlays.
 

To clean the display, follow these steps.
1. Remove power from the terminal.
2. To clean the display and to help prevent scratches, use a clean sponge or soft cloth with 

mild soap or detergent.
3. To avoid water spots, dry the display with a chamois or moist cellulose sponge.

Remove Paint and Grease

To remove paint or grease from the bezel that is properly mounted in a NEMA, UL Type, or IP 
rated enclosure, follow these steps.

1. Rub lightly with isopropyl alcohol (70% concentration).
2. Use a mild soap or detergent solution to remove residue.
3. Rinse with clean water.

Equipment Wash Downs

Ship the Terminal If you ship the enclosure with the terminal installed, make sure that the terminal is properly 
secured and protected against damage from impact, sharp objects, or abrasive materials.

For more information on the chemical resistance of the product, go to
https://rockwellautomation.custhelp.com and search the Knowledgebase for the 
keywords, ‘Chemical Resistance PanelView Plus’.

IMPORTANT Do not operate the terminal in direct sunlight. Direct exposure to 
ultraviolet light can discolor the touch screen.

ATTENTION: 
• Do not use abrasive cleaners or solvents, they can damage the display. 
• Do not scrub or use brushes.
• Do not apply cleaning solution directly on the terminal screen. The solution 

can drip or seep onto the gasket. Apply cleaning solution to a clean sponge or 
soft cloth, and gently wipe the screen to remove the dirt and grime.

ATTENTION: 
• Do not use a high-pressure washer for cleaning the front bezel of the terminal. 

A high-pressure washer can damage the terminal.
• Do not use a high-pressure washer for cleaning vented enclosures. Water can 

enter the enclosure and damage the terminal and other equipment.
• Remove power from the terminal before performing any wash downs. It is 

possible for screen objects to activate during equipment wash downs if the 
terminal is powered on. 

• See Resistance to Chemicals on page 195 for information about exposure to 
chemicals.

ATTENTION: Rockwell Automation is not responsible for damage to a product 
that is shipped or transported while installed in a panel or enclosure.
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Maintenance Mode 
Operations — Series A 
Terminals

To start the system in Maintenance Mode for diagnostics and repairs, select and hold the white 
box that shows in the lower left corner of the display during startup.

If an ME application is set to run at terminal startup, select and hold the white box during 
startup to put the terminal into Safe Mode.

Perform maintenance operation in this order to diagnose and repair problems:
• Safe mode – stops an application from starting automatically.
• Clear all data – removes user-installed applications, user-configuration changes, and 

user accessible data.
• Factory default – returns the terminal to its out-of-box state.

You can also access the Maintenance Mode menu if you attach a USB keyboard 
and hold down the F1 key.

Maintenance Mode Operations

Operation Description 

None Exits Maintenance mode and continues with a normal restart.

Safe mode

Starts the system in Safe Operating mode. This mode is a diagnostic mode with reduced 
functionality that lets you recovery from a software anomaly. In Safe mode, you can repair 
applications or changes that caused the anomaly.
Important: FactoryTalk View ME Station software does not run the HMI .mer application on 
startup if one is loaded, but instead enters Configuration mode. The HMI application runs the 
next time that the system is reset.

Clear all data 

Restores all user-accessible storage and configuration data on the terminal to its default 
state. The current firmware revision is retained.
Important: All storage media is returned to its original state when purchased except for the 
firmware. The latest FactoryTalk View ME image is retained. All user data changes or additions 
are lost.

Factory default

Restores all storage media on the terminal to its initial factory default state, including 
firmware, registry, file system, and configuration data. Typically, this option is used to recover 
from a failed firmware update.
Important: All storage media is returned to its original state when purchased. All user-
installed, firmware updates are removed.
See Restore a Backup Image on page 109 for details on how to perform a restore.
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Maintenance Mode 
Operations — Series B 
Terminals(1)

To enter maintenance mode on your Series B terminal (Series C for Stainless Steel terminals), 
press the Maintenance button that is located on the back of your terminal anytime while the 
terminal is powered up (see Hardware Features on page 12). This button is only available on 
Series B terminals (Series C for Stainless Steel terminals). It brings up the Maintenance Menu, 
which you use to restore factory defaults, back up and restore terminal settings, change the 
display orientation, and calibrate the touch screen, and so on.

Alternatively, the Maintenance Menu can be accessed in the Windows® Control Panel, under 
Settings > System > Go To Maintenance Menu.

(1) Series C for Stainless Steel terminals.

Maintenance Menu

Menu Item Description 

Exit Maintenance 
Menu Exits Maintenance mode and continues with a normal restart.

Restore Terminal
Restores a snapshot of a terminal’s state from a USB storage device. The USB storage 
device must contain a file that is named PVP7P_Snapshot.wim on the root directory. 
This operation overwrites existing settings in the OS, FactoryTalk View ME Station, and 
user accounts.

Export Audit Logs Exports logs of terminal information to a USB storage device. Creates a compressed file 
that is named PVP7P_AuditLogs.zip on the root of the USB storage device.

Factory Default Restores the terminal to the original out-of-box condition.

Reinitialize Terminal Resets all data and settings on the terminal.

Calibrate Touch 
Screen Restarts the terminal and boots into the Calibration Menu.

Backup Terminal

Saves a snapshot of the current state of the terminal to a USB storage device. The USB 
storage device must be formatted to NTFS and have at least 16 GB of free space. The 
snapshot includes the OS, FactoryTalk View ME Station, all files, user accounts, 
programs, settings, and data. It creates a file that is named PVP7P_ Snapshot.wim on 
the root directory of the USB storage device. If this file exists, it is overwritten.

Safe Mode
Reboots the terminal to the FactoryTalk View ME Station Configuration Mode. Rebooting 
the terminal again takes the terminal out of safe mode, and any ME app that was set to 
run at startup resumes running at startup.

Change Display 
Orientation

Changes the display orientation to either landscape (default), portrait, or portrait-
flipped. Requires a terminal restart to take effect.
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Fonts Resident on Terminal
True Type Fonts The table lists TrueType fonts that are pre-installed on the terminals. The default system font 

is Tahoma. 

On Series A terminals, you can load additional fonts on the system by copying the font files to 
the \Windows\Fonts folder on the terminal desktop. To access this folder, open the My Device 
icon on the terminal desktop or choose Start > Programs > Windows Explorer. 

The Arial Unicode MS font contains almost 50,000 characters and provides default 
language support for many non-Latin languages and scripts including Arabic, 
Hebrew, Vietnamese, Thai, Hindi (Devanagari), and other Indic languages. The font 
also includes Chinese, Japanese, and Korean (CJK) support.

IMPORTANT OpenType fonts (.otf) can contain many extra symbols and characters 
and can have large files sizes. If you install OpenType fonts, it can result 
in a reduction in available memory for applications. We recommend 
that you install only TrueType fonts. If you need an OpenType font, 
install only the font family that you want to use.

Table 52 - TrueType Fonts (.ttf and .ttc)

Font Type Font Name File Name

Latin Fonts

Arial Unicode MS version 1.01 arialuni.ttf

Arial

Arial (Subset 1_30) arial_1_30.ttf

Arial Black arialk.ttf

Arial Bold arialbd.ttf

Arial Bold Italic arialbi.ttf

Arial Italic ariali.ttf

Comic Sans MS

Comic Sans MS comic.ttf

Comic Sans MS Bold comicbd.ttf

Courier New

Courier New (Subset 1_30) cour_1_30.ttf

Courier New Bold courbd.ttf

Courier New Bold Italic courbi.ttf

Courier New Italic couri.ttf
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Latin Fonts

Georgia

Georgia georgia.ttf

Georgia Bold georgiab.ttf

Georgia Bold Italic georgiaz.ttf

Georgia Italic georgiai.ttf

Impact impact.ttf

Kino kino.ttf

Microsoft Logo mslogo.ttf

Symbol symbol.ttf

Tahoma

Tahoma (Subset 1_07) tahoma_1_07.ttf

Tahoma Bold tahomabd.ttf

Times New Roman

Times New Roman (Subset 1_30) times_1_30.ttf

Times New Roman Bold timesbd.ttf

Times New Roman Bold Italic timesbi.ttf

Times New Roman Italic timesi.ttf

Trebuchet MS

Trebuchet MS trebuc.ttf

Trebuchet MS Bold trebucbd.ttf

Trebuchet MS Bold Italic trebucbi.ttf

Trebuchet MS Italic trebucit.ttf

Verdana

Verdana verdana.ttf

Verdana Bold verdanab.ttf

Verdana Bold Italic verdanaz.ttf

Verdana Italic verdanai.ttf

Symbols
Webdings webdings.ttf

Wingding wingding.ttf

Table 52 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
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PanelView™ Fonts

PV 12 x 24, PV 12 x 8 PV12x24.tff, PV12x8.ttf

PV 16 x 24 PV16x24.ttf

PV 18 x 16, PV 18 x 8 PV18x16.ttf, PV18x8.ttf

PV 24 x 32 PV24x32.ttf

PV 32 x 40, PV 32 x 64 PV32x40.ttf, PV32x64.ttf

PV 4 x 6 PV4x6.ttf

PV 6 x 16, PV 6 x 24, PV 6 x 8, PV 6 x 9 PV6x16.ttf, PV6x24.ttf, 
PV6x8.ttf, PV6x9.ttf

PV 8 x 16, PV 8 x 20, PV 8 x 24 PV8x16.ttf, PV8x20.ttf, 
PV8x24.ttf

PV Double High PVdouble_high.ttf

PV Double Wide PVdouble_wide.ttf

PV Extra Large PVextra_large.ttf

PV Large PVlarge.ttf

PV Small PVsmall.ttf

PV Tiny PVtiny.ttf

PV Very Tiny PVvery_tiny.ttf

East Asian Fonts
Gulim version 2.21 - Korean gulim.ttc

MS Gothic version 2.30 - Japanese gulim.ttc

Table 52 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
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Appendix B

Languages Supported
Available Languages On Series B terminals (Series C for Stainless Steel terminals), the Maintenance Menu and 

Windows® 10 Control Panel are only available in English. The Windows 10 Control Panel will be 
updated in the future to support additional languages. 

The following languages are supported in Machine Edition (ME) Station:

Table 53 - Available Languages

Language Series A Series B(1)

Afrikaans (South Africa) √ √
Albanian (Albania) √ √
Arabic (Algeria) √ √
Arabic (Bahrain) √ √
Arabic (Egypt) √ √
Arabic (Iraq) √ √
Arabic (Jordan) √ √
Arabic (Kuwait) √ √
Arabic (Lebanon) √ √
Arabic (Libya) √ √
Arabic (Morocco) √ √
Arabic (Oman) √ √
Arabic (Qatar) √ √
Arabic (Saudi Arabia) √ √
Arabic (Syria) √ √
Arabic (Tunisia) √ √
Arabic (U.A.E.) √ √
Arabic (Yemen) √ √
Armenian (Armenia) √ √
Azeri (Cyrillic) (Azerbaijan) √ √
Azeri (Latin) (Azerbaijan) √ √
Basque (Spain) √ √
Belorussian (Belarus) √ √
Bulgarian (Bulgaria) √ √
Catalan (Spain) √ √
Chinese (Hong Kong S.A.R.) √ √
Chinese (Macau S.A.R.) √ √
Chinese (People's Republic of China) √ √
Chinese (Singapore) √ √
Chinese (Taiwan) √ √
Croatian (Croatia) √ √
Czech (Czech Republic) √ √
Danish (Denmark) √ √
Dutch (Belgium) √ √
Dutch (Netherlands) √ √
English (Australia) √ √
English (Belize) √ √
English (Canada) √ √
English (Caribbean) √ √
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English (Ireland) √ √
English (Jamaica) √ √
English (New Zealand) √ √
English (Republic of the Philippines) √ √
English (South Africa) √ √
English (Trinidad and Tobago) √ √
English (United Kingdom) √ √
English (United States) √ √
English (Zimbabwe) √ √
Estonian (Estonia) √ √
Faroese (Faroe Islands) √ √
Farsi (Iran) (also known as Persian) √
Finnish (Finland) √ √
French (Belgium) √ √
French (Canada) √ √
French (France) √ √
French (Luxembourg) √ √
French (Principality of Monaco) √ √
French (Switzerland) √ √
FYRO Macedonian (Former Yugoslav Republic of Macedonia) √ √
Georgian (Georgia) √ √
German (Austria) √ √
German (Germany) √ √
German (Liechtenstein) √ √
German (Luxembourg) √ √
German (Switzerland) √ √
Greek (Greece) √ √
Gujarati (India) √ √
Hebrew (Israel) √ √
Hindi (India) √ √
Hungarian (Hungary) √ √
Icelandic (Iceland) √ √
Indonesian (Indonesia) √ √
Italian (Italy) √ √
Italian (Switzerland) √ √
Japanese (Japan) √ √
Kannada (India) √ √
Kazakh (Kazakhstan) √ √
Konkani (India) √ √
Korean (Korea) √ √
Kyrgyz (Kyrgyzstan) √ √
Latvian (Latvia) √ √
Lithuanian (Lithuania) √ √
Malay (Brunei Darussalam) √ √
Malay (Malaysia) √ √
Marathi (India) √ √
Mongolian (Mongolia) √ √
Norwegian (Bokmål) (Norway) √ √
Norwegian (Nynorsk) (Norway) √ √
Polish (Poland) √ √
Portuguese (Brazil) √ √

Table 53 - Available Languages (Continued)

Language Series A Series B(1)
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Portuguese (Portugal) √ √
Punjabi (India) √ √
Romanian (Romania) √ √
Russian (Russia) √ √
Sanskrit (India) √ √
Serbian (Cyrillic) (Serbia and Montenegro) √ √
Serbian (Latin) (Serbia and Montenegro) √ √
Slovak (Slovakia) √ √
Slovenian (Slovenia) √ √
Spanish (Argentina) √ √
Spanish (Bolivia) √ √
Spanish (Chile) √ √
Spanish (Colombia) √ √
Spanish (Costa Rica) √ √
Spanish (Dominican Republic) √ √
Spanish (Ecuador) √ √
Spanish (El Salvador) √ √
Spanish (Guatemala) √ √
Spanish (Honduras) √ √
Spanish (Mexico) √ √
Spanish (Nicaragua) √ √
Spanish (Panama) √ √
Spanish (Paraguay) √ √
Spanish (Peru) √ √
Spanish (Puerto Rico) √ √
Spanish (Spain) √ √
Spanish (Uruguay) √ √
Spanish (Venezuela) √ √
Swahili (Kenya) (also known as Kiswahili) √ √
Swedish (Finland) √ √
Swedish (Sweden) √ √
Tamil (India) √ √
Tatar (Russia) √ √
Telugu (India) √ √
Thai (Thailand) √ √
Turkish (Turkey) √ √
Ukrainian (Ukraine) √ √
Urdu (Islamic Republic of Pakistan) √ √
Uzbek (Cyrillic) (Uzbekistan) √ √
Uzbek (Latin) (Uzbekistan) √ √
Vietnamese (Viet Nam) √ √

(1) Series C for Stainless Steel terminals.

Table 53 - Available Languages (Continued)

Language Series A Series B(1)
Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024 205



Appendix B          Languages Supported
Notes:
206 Rockwell Automation Publication 2711P-UM008K-EN-P - April 2024



Index

Symbols
.mer application 61, 62, 65

A
access configuration mode

from an HMI application 61
from the Windows desktop 61
Goto Configuration Mode button 61

accessories 18
ActiveX controls 14, 104
alarms 91
application

backup 107
checking integrity 90
restore 107

atmospheric gases ignition temperature 22
authenticating client connections 116

B
back-up image 109
back-up power 163
battery

back-up power 163
conditions 114
lithium 163
replacement 163
view voltage 114
voltage 92
warnings 131

boot options 132
branch circuit 22
button styles 132

C
cable

capacitance 23
inductance 23
length between the Ethernet ports 39

calibration
touch screen 83, 134

catalog numbers
accessories 18
battery replacement 18
mounting hardware 18
PanelView Plus 7 performance terminals 17
power supplies 18
power terminal blocks 18
protective overlays 18
SD cards 18

circuit breaker rating 22
clear all data 196
closed system 15, 132
command prompt

Foxitreader 136
parameters 136
syntax 136

configuration mode 15
control panel

touch screen calibration 134
cutout dimensions 25

D
date

settings
date 96

DC power bus 37
desktop

rotate 112
desktop access

disable 67
enable 66
factory default state 15
open versus closed 15
reset password 69
restrict 67, 68
set password 68

device name
terminal 78

DHCP 74
diagnostics

advanced 133
configure 89

display settings
control panel 111

E
earth ground

AC 38
DC 37

electrostatic discharge 155
error indicator 191
Ethernet

connector pinout 40
driver 74
duplex setting 75
link speed 74
status indicators 40

Ethernet cables 19
event log

errors 113
events 113
warnings 113

explosion hazard 163

F
FactoryTalk View ME

check file integrity 90
diagnostics 90

fault indicators
firmware 191
hardware 191

file server
configuration 129
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firmware upgrades
fail 178
firmware upgrade wizard 171
over network 175
using storage device 172

fonts 199
Foxitreader 136
FTP security options 127
FTP server

configuration 126
parameters 127
security 127

FUP 170
fuse rating 22
FUW 170

G
galvanic isolation 156

H
hardware specifications

audio out 12
Ethernet ports 12
mounting slot 12
SD card slot 12
status indicators 12
USB device port 12
USB host ports 12

I
indicator

ERR 191
STS 191

input panels 105
IP address

assign 74

K
KEPServer drivers 130, 173, 177

L
language 97

setting 97
lithium batteries

handling 131
logs

application files 90
runtime files 90

M
maintenance mode 196
mount the terminal

ambient temperature 22
in a panel 25
minimum clearances 24
preparation 25

N
network

file servers 129
FTP servers 126
topologies 16
VNC servers 118

network topology
device-level ring 40
linear 41
star 42

O
open system 15
open versus closed system 15

P
PDF reader 135
power

AC
connection 38
ratings 12, 38
terminal block 36

DC
connection 37
ratings 12, 37
terminal block 36

PELV 37
SELV 37
supplies 18

print setup 87
printers 157
protective overlay

catalog numbers 18
cleaning 165
installing 165
removing 165

R
remote client access 152
RJ45 connector 39

S
safe mode 132, 196
safety notices

earth ground 37
electrical arc 36, 39
electrical shock 36, 38, 155
explosion hazard 39

screen
rotate 112

screen saver 82
SD card

installing 160
server

addresses 76
enable/disable 118
file 129
ftp 126
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settings
appearance 111
background image 111
backlight intensity 111
cursor 112
language 97
screen saver 112
time 96
time zone 95

shell options 132
soft keyboard controls 64
software versions

FactoryTalk View Machine Edition (ME) 
Station 14

FactoryTalk View Studio for Machine Edition 
14

FactoryTalk ViewPoint 14
startup

configure 15
options 15
sequence 43

startup options 15
static-safe workstation 155
status indicators 191
system

information 191
status 191

system event log 91

T
technical support 94
temperature

code T4 22
over-temperature messages 92
view 92
view current temperature 114

time 96
time zone 95
touch screen

calibrate 134
calibration 83
gestures

double-tap 13
drag 13
long press 13
tap 13

set sensitivity 84, 134
touch screen calibration 134
troubleshooting 191

U
USB

cables 156
host ports 23, 156
hubs 156
printer 157

USB ports
installation 23

USB to serial port adapters 19
user accounts 116

V
virtual keyboard 13
VNC

configure 118
connection password 120
connection passwords 120
control passwords 121
server parameters 119
view-only password 121

W
watchdog errors 133
Web server parameters 126
wiring and safety guidelines 22
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